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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
+ To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-5250.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.

© Copyright IBM Corp. 2011 ix
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Changes to serve you more quickly

Print sections directly from the information center navigation

PDF books are provided as a convenience format for easy printing, reading, and offline use. The
information center is the official delivery format for IBM WebSphere Application Server documentation. If
you use the PDF books primarily for convenient printing, it is now easier to print various parts of the
information center as needed, quickly and directly from the information center navigation tree.

To print a section of the information center navigation:

1. Hover your cursor over an entry in the information center navigation until the Open Quick Menu icon
is displayed beside the entry.

2. Right-click the icon to display a menu for printing or searching your selected section of the navigation
tree.

3. If you select Print this topic and subtopics from the menu, the selected section is launched in a
separate browser window as one HTML file. The HTML file includes each of the topics in the section,
with a table of contents at the top.

4. Print the HTML file.

For performance reasons, the number of topics you can print at one time is limited. You are notified if your
selection contains too many topics. If the current limit is too restrictive, use the feedback link to suggest a
preferable limit. The feedback link is available at the end of most information center pages.

Under construction!

The Information Development Team for IBM WebSphere Application Server is changing its PDF book
delivery strategy to respond better to user needs. The intention is to deliver the content to you in PDF
format more frequently. During a temporary transition phase, you might experience broken links. During
the transition phase, expect the following link behavior:

» Links to Web addresses beginning with http:// work
» Links that refer to specific page numbers within the same PDF book work
* The remaining links will not work. You receive an error message when you click them

Thanks for your patience, in the short term, to facilitate the transition to more frequent PDF book updates.

© Copyright IBM Corp. 2011 Xi
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Chapter 1. How do | troubleshoot?

Follow these shortcuts to get started quickly with popular tasks.

When you visit a task in the information center, look for the IBM® Suggests feature at the bottom of the
page. Use it to find available tutorials, demonstrations, presentations, developerWorks® articles,
Redbooks®, support documents, and more.

IAdd tracing and logging to your applications|

* For more detailed information on enabling traces by using scripting, see the Troubleshooting with
scripting chapter in the Administering applications and their environment PDF book.

[Collect details for IBM Support]

[Creating Common Base Events|

[Debug WebSphere® applications during development|

[Detect hung threads|

[Detect product configuration file problems|

[Set traces and logs with the console|

[Set traces and logs with scripting?|

[Work with message logs|

[Using Common Base Events for logging

[Using IBM Support Assistant|

[Using HPEL to troubleshoot applications|

[Using JSR47 for logging|

[Using JSR47 for logging: Configuring access logs|

© IBM Corporation 2003
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Chapter 2. Debugging applications

To debug your application, you must use a development environment like the IBM Rational® Application
Developer for WebSphere to create a Java project. You must then import the program that you want to
debug into the project.

About this task

By following the steps below, you can import the WebSphere Application Server examples into a Java

project. Two debugging styles are available:

» Step-by-step debugging mode prompts you whenever the server calls a method on a web object. A
dialog lets you step into the method or skip it. In the dialog, you can turn off step-by-step mode when
you are finished using it.

» Breakpoints debugging mode lets you debug specific parts of programs. Add breakpoints to the part of
the code that you must debug and run the program until one of the breakpoints is encountered.

Breakpoints actually work with both styles of debugging. Step-by-step mode just lets you see which web
objects are being called without having to set up breakpoints ahead of time.

You do not need to import an entire program into your project. However, if you do not import all of your
program into the project, some of the source might not compile. You can still debug the project. Most
features of the debugger work, including breakpoints, stepping, and viewing and modifying variables. You
must import any source that you want to set breakpoints in.

The inspect and display features in the source view do not work if the source has build errors. These
features let you select an expression in the source view and evaluate it.

Procedure

Create a Java Project by opening the New Project dialog.

Select Java from the left side of the dialog and Java Project in the right side of the dialog.
Click Next and specify a name for the project, for example, WASExamples.

Click Finish to create the project.

Select the new project, choose File > Import > File System, then Next to open the import file
system dialog.

6. Browse the directory for files.

Go to the following directory: [profile_rool/ installedApps/node_name/DefaultApplication.ear/
DefaultWebApplication.war.

7. Select DefaultWebApplication.war in the left side of the Import dialog and then click Finish. This
imports the JavaServer Pages files and Java source for the examples into your project.

8. Add any JAR files needed to build to the Java Build Path.

Select Properties from the right-click menu. Choose the Java Build Path node and then select the
Libraries tab. Click Add External JARs to add the following JAR files:

. 1' nstalledApps/node_name/DefaultApplication.ear/Increment.jar.

When you have added this JAR file, select it and use the Attach Source function to attach the
Increment. jar file because it contains both the source and class files.

* |app_server_root/dev/JavakE/j2ee. jar

* |app_server_root/plugins/com.ibm.ws.runtime.jar

* lapp_server_root/plugins/com.ibm.ws.webcontainer.jar

Click OK when you have added all of the JARs.

9. You can set some breakpoints in the source at this time if you like, however, it is not necessary as
step-by-step mode will prompt you whenever the server calls a method on a web object. Step-by-step
mode is explained in more detail below.

ok w2
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10. To start debugging, you need to start the WebSphere Application Server in debug mode and make
note of the JVM debug port. The default value of the JVM debug port is 7777.

11. When the server is started, switch to the debug perspective by selecting Window > Open
Perspective > Debug. You can also enable the debug launch in the Java Perspective by choosing
Window > Customize Perspective and selecting the Debug and Launch checkboxes in the Other
category.

12. Select the workbench toolbar Debug pushbutton and then select WebSphere Application Server
Debug from the list of launch configurations. Click the New pushbutton to create a new configuration.

13. Give your configuration a name and select the project to debug (your new WASExamples project).
Change the port number if you did not start the server on the default port (7777).

14. Click Debug to start debugging.
15. Load one of the examples in your browser. For example: http://your.server.name:9080/hitcount

Attaching a Rational tool to a remote debug session

The steps below describe how to attach an IBM Rational Application Developer for WebSphere Software
product to a remote debug session on WebSphere Application Server for z/OS°®.

About this task

Remote debugging can prove useful when the program you are debugging behaves differently on a z/OS
system than on your local system.

Procedure

1. Enable the debug engine on WebSphere Application Server for z/OS using the administrative console.
See debugging service details.

2. Import the Java source code that you want to debug into a Rational Application Developer product and
set breakpoints. See topics on setting breakpoints in the Rational Application Developer
documentation.

3. In the Rational Application Developer product, open a debug perspective and create a debug session
configuration.

4. Attach the Rational Application Developer product to the WebSphere Application Server for z/OS
debug runtime. See topics on remote debugging in the Rational Application Developer documentation.

5. Run the Java code in WebSphere Application Server for z/OS to hit the breakpoints set in the Rational
Application Developer product.

6. Use the debugger controls and features to debug the application.

Unit testing with DB2

These steps describe how to setup a unit test environment that would allow you to develop and unit test
code with DB2® z/OS to support Container Managed Persistence (CMP) development and access DB2
test data that resides on z/OS.

About this task

When using DB2 z/OS to support Container Managed Persistence (CMP) development and access DB2
test data that resides on z/OS, you should establish a testing environment to develop and unit test the
code. Perform the steps below to setup a test environment:

Procedure

1. Configure DB2 Distributed Data Facility (DDF) on z/OS to allow remote TCP/IP connections from your
WebSphere Studio Application Developer workstation. See the [DB2 Information Center for information
on DDF.

4 Troubleshooting and support
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2. Install the DB2 Client Configuration Assistant on the workstation where WebSphere Studio Application
Developer is installed. The DB2 Client Configuration Assistant is shipped with DB2.

3. Use the DB2 Client Configuration Assistant to define a DB2 alias.

4. Use the DB2 alias you defined to access the DB2 subsystem on z/OS using the DB2 Distributed Data
Facility (DDF).

Debugging Service details

Use this page to view and modify the settings used by the Debugging Service.

To view this administrative console page, click Servers > Servers Types>WebSphere application
servers > server name > Debugging Service.

The steps below describe how to enable a debug session on WebSphere Application Server. Debugging
can prove useful when your program behaves differently on the application server than on your local
system.

Enable service at server startup
Specifies whether the server will attempt to start the Debug service when the server starts.

JVM debug port

Specifies the port that the Java virtual machine will listen on for debug connections.

JVM debug arguments
Specifies the debugging argument string used to start the JVM in debug mode.

Debug class filters

Specifies an array of classes to ignore during debugging. When running in step-by-step mode, the
debugger will not stop in classes that match a filter entry.

Chapter 2. Debugging applications 5
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Chapter 3. Adding logging and tracing to your application

You can add logging and tracing to applications to help analyze performance and diagnose problems in
WebSphere Application Server.

About this task

Deprecation: The JRas framework that is described in this information center is deprecated. However, you
can achieve the same results using Java logging.

Designers and developers of applications that run with or under WebSphere Application Server, such as
servlets, JavaServer Pages (JSP) files, enterprise beans, client applications, and their supporting classes,
might find it useful to use Java logging for generating their application logging.

This approach has advantages over adding System.out.printIn statements to your code:

* Your messages are displayed in the WebSphere Application Server standard log files, using a standard
message format with additional data, such as a date and time stamp that are added automatically.

* You can more easily correlate problems and events in your own application to problems and events that
are associated with WebSphere Application Server components.

* You can take advantage of the WebSphere Application Server log file management features.

3 User Handler1 Cutput
Handler ) i davice
Application com.xyz.abc. def (
code » [ Logger )
com_xyz.abc
(Logger) [ |
Uszer Handler2 Output
Application com.XyZ.abec.ghi T::-Ilan::ar: = d i3 p
code » [ Logger )
A
Application Anonymous
code (Logger) [ |
Applications root Applications
__________________________________________________________________________ > { Logger } WobSohere
WebSphere Application Server 49 WebSphere
v Application Server
. WebSphere
i i O t
I i ::-nm_:bm.ws.wz com.ibm.ws Soolicaton. | [ d"“f]”
broker ( Logger { Logger) Server handlers e
Procedure
1. Enable and configure any of the supported types of logging as needed. Use one of the following
methods:

« Configuring Java logging using the administrative console
« |[Configuring applications to use Jakarta Commons Logging|

2. Customize the properties to meet your logging needs. For example, enable or disable a particular log,
specify the number of logs to be kept, and specify a format for log output.

« Configuring Java logging using the administrative console

© Copyright IBM Corp. 2011 7



3. If you do not want log and trace from Jakarta Commons Logging to use the WebSphere log and trace
infrastructure, reconfigure the Jakarta Commons Logging.

« [“‘Configuring applications to use Jakarta Commons Logging” on page 23]

Note: Use the WebSphere log and trace infrastructure for all of your log content to make problem
source identification simpler.

4. Restart the application server after making static configuration changes.
Example

The sample security policy that follows grants access to the file system and runtime classes. Include this
security policy, with the entry permission java.util.logging.LoggingPermission "control", in the
META-INF directory of your application if you want your applications to programmatically alter controlled
properties of loggers and handlers. The META-INF file is located in the following locations for the different
module types:

EJB projects ejbModule/META-INF/MANIFEST.MF
Application client projects appClientModule/META-INF/MANIFEST.MF
Dynamic web projects WebContent/META-INF/MANIFEST.MF
Connector projects connectorModule/META-INF/MANIFEST.MF

Below is a sample security policy that grants permission to modify logging properties:
I 010010 1111111111111
/]

// WebSphere Application Server Security Policy
//
[T i rrreeriieliieelieilliieiii

[ITTTTIIEEIEEIT LTI i i iiriiiriieriieliieiiiellieilieiiiiieil
// Allow all access to the file system and runtime classes
HITTTTIIEEIEE LTI i iiriiiiieriiilrieilieiiieilieiiiiieil
grant codeBase "file:${application}" {

permission java.util.logging.LoggingPermission "control";
1

Using Java logging in an application

This topic describes how to use Java logging within an application.
About this task
To create an application using Java logging, perform the following steps:

Procedure
1. Optional: Create the necessary handler, formatter, and filter classes if you need your own log files.

Note: Use the WebSphere log and trace infrastructure to make problem source identification simpler,
rather than creating separate log files.

2. Optional: If localized messages are used by the application, create a resource bundle, as described in
r‘Creating log resource bundles and message files” on page 20.|

3. In the application code, get a reference to a logger instance, as described in |“Using a logger” on page|

4. |Insert the appropriate message and trace logging statements in the application, as described in
la logger” on page 9.|
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Using a logger

You can use Java logging to log messages and add tracing.
About this task

Java provides a log and trace package, java.util.logging, that you can use to instrument your applications.
This topic provides recommendations about how to use the log and trace package.

Procedure

1. Use WsLevel.DETAIL level and above for messages, and lower levels for trace. The WebSphere
Application Server Extension API (the com.ibm.websphere.logging package) contains the WsLevel
class.

For messages use:

WslLevel.FATAL
Level.SEVERE
Level.WARNING
WsLevel .AUDIT
Level.INFO
Level.CONFIG
WsLevel .DETAIL

For trace use:

Level.FINE
Level .FINER
Level .FINEST

2. Use the logp method instead of the log or the logrb method. The logp method accepts parameters for
class name and method name. The log and logrb methods will generally try to infer this information,
but the performance penalty is prohibitive. In general, the logp method has less performance impact
than the log or the logrb method.

3. Avoid using the logrb method. This method leads to inefficient caching of resource bundles and poor
performance.

4. Use the isLoggable method to avoid creating data for a logging call that does not get logged. For
example:

if (logger.isLoggable(Level.FINEST)) {
String s = dumpComponentState(); // some expensive to compute method
logger.logp(Level .FINEST, className, methodName, "componentX state
dump:\n{0}", s);
}

Example

The following sample applies to localized messages:

// note - generally avoid use of FINE, FINER, FINEST levels for messages to be consistent with
// WebSphere Application Server

String componentName = "com.ibm.websphere.componentX";
String resourceBundleName = "com.ibm.websphere.componentX.Messages";
Logger logger = Logger.getLogger(componentName, resourceBundleName);

// "Convenience" methods - not generally recommended due to lack of class
/ method names
// - cannot specify message substitution parameters
// - cannot specify class and method names
if (logger.isLoggable(Level.SEVERE))
Togger.severe("MSG_KEY_01");

if (Togger.isLoggable(Level.WARNING))
Togger.warning("MSG_KEY_01");

if (logger.isLoggable(Level.INFO))
Togger.info("MSG_KEY_01");

if (logger.isLoggable(Level.CONFIG))
Togger.config("MSG_KEY_01");
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// 1og methods are not generally used due to lTack of class and method
names

// - enable use of WebSphere Application Server-specific Tevels
// - enable use of message substitution parameters
// - cannot specify class and method names

if (logger.isLoggable(WsLevel.FATAL))
Togger.log(WsLevel .FATAL, "MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.SEVERE))
Togger.log(Level .SEVERE, "MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.WARNING))
Togger.log(Level .WARNING, "MSG_KEY_01", "parameter 1");

if (logger.isLoggable(WsLevel .AUDIT))
Togger.log(WsLevel .AUDIT, "MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.INFO))
Togger.log(Level .INFO, "MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.CONFIG))
Togger.log(Level .CONFIG, "MSG_KEY_01", "parameter 1");

if (logger.isLoggable(WsLevel .DETAIL))
logger.log(WsLevel .DETAIL, "MSG_KEY_01", "parameter 1");

// Togp methods are the way to log

// - enable use of WebSphere Application Server-specific Tevels
// - enable use of message substitution parameters
// - enable use of class and method names

if (logger.isLoggable(WsLevel.FATAL))
Togger.logp(WsLevel.FATAL, className, methodName, "MSG_KEY_01",
"parameter 1");

if (logger.isLoggable(Level.SEVERE))
Togger.logp(Level .SEVERE, className, methodName, "MSG_KEY_01",
"parameter 1");

if (logger.isLoggable(Level.WARNING))
Togger.logp(Level .WARNING, className, methodName, "MSG_KEY_01",
"parameter 1");

if (logger.isLoggable(WsLevel.AUDIT))
Togger.logp(WsLevel.AUDIT, className, methodName, "MSG_KEY_01",
"parameter 1");

if (logger.isLoggable(Level.INFO))
Togger.logp(Level.INFO, className, methodName, "MSG_KEY_01",
"parameter 1");

if (logger.isLoggable(Level.CONFIG))
Togger.logp(Level.CONFIG, className, methodName, "MSG_KEY_01",
"parameter 1");

if (logger.isLoggable(WsLevel .DETAIL))
Togger.logp(WsLevel .DETAIL, className, methodName, "MSG_KEY_01",
"parameter 1");

// logrb methods are not generally used due to diminished performance
of switching resource bundles dynamically

// - enable use of WebSphere Application Server-specific levels
// - enable use of message substitution parameters
// - enable use of class and method names

String resourceBundleNameSpecial =
"com.ibm.websphere.componentX.MessagesSpecial";

if (logger.isLoggable(WsLevel.FATAL))
Togger.logrb(WsLevel.FATAL, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.SEVERE))
logger.logrb(Level.SEVERE, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.WARNING))
Togger.logrb(Level .WARNING, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(WsLevel .AUDIT))
Togger.logrb(WsLevel.AUDIT, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.INFO))

logger.logrb(Level.INFO, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");
if (logger.isLoggable(Level.CONFIG))

Togger.logrb(Level.CONFIG, className, methodName, resourceBundleNameSpecial,
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"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(WsLevel.DETAIL))
logger.logrb(WsLevel .DETAIL, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

For trace, or content that is not localized, the following sample applies:

// note - generally avoid use of FATAL, SEVERE, WARNING, AUDIT,
// INFO, CONFIG, DETAIL levels for trace
// to be consistent with WebSphere Application Server

String componentName = "com.ibm.websphere.componentX";
Logger logger = Logger.getLogger(componentName);

// Entering / Exiting methods are used for non trivial methods
if (logger.isLoggable(Level.FINER))
logger.entering(className, methodName);

if (logger.isLoggable(Level.FINER))
logger.entering(className, methodName, "method paraml");

if (logger.isLoggable(Level.FINER))
logger.exiting(className, methodName);

if (logger.isLoggable(Level.FINER))
logger.exiting(className, methodName, "method result");

// Throwing method is not generally used due to lack of message - use
logp with a throwable parameter instead

if (logger.isLoggable(Level.FINER))

logger.throwing(className, methodName, throwable);

// Convenience methods are not generally used due to lack of class
/ method names
// - cannot specify message substitution parameters
// - cannot specify class and method names
if (logger.isLoggable(Level.FINE))
logger.fine("This is my trace");

if (logger.isLoggable(Level.FINER))
logger.finer("This is my trace");

if (logger.isLoggable(Level.FINEST))

logger.finest("This is my trace");

// 1og methods are not generally used due to Tack of class and
method names

// - enable use of WebSphere Application Server-specific Tevels
// - enable use of message substitution parameters
// - cannot specify class and method names

if (logger.isLoggable(Level.FINE))
logger.log(Level .FINE, "This is my trace", "parameter 1");

if (logger.isLoggable(Level.FINER))
logger.log(Level .FINER, "This is my trace", "parameter 1");

if (logger.isLoggable(Level.FINEST))
logger.log(Level .FINEST, "This is my trace", "parameter 1");

// Togp methods are the recommended way to log

// - enable use of WebSphere Application Server-specific Tevels
// - enable use of message substitution parameters
// - enable use of class and method names

if (logger.isLoggable(Level.FINE))
logger.logp(Level .FINE, className, methodName, "This is my trace",
"parameter 1");

if (logger.isLoggable(Level.FINER))
logger.logp(Level .FINER, className, methodName, "This is my trace",
"parameter 1");

if (logger.isLoggable(Level.FINEST))
logger.logp(Level .FINEST, className, methodName, "This is my trace",
"parameter 1");

// Togrb methods are not applicable for trace logging because no localization
is involved

Example: Creating custom log handlers with java.util.logging. There may be occasions when you
want to propagate log records to your own log handlers rather than participate in integrated logging. To
use a stand-alone log handler, set the useParentHandlers flag to false in your application.The mechanism
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for creating a customer handler is the Handler class support that is provided by the IBM Developer Kit,
Java Technology Edition. If you are not familiar with handlers, as implemented by the Developer Kit, you
can get more information from various texts, or by reading the APl documentation for the java.util.logging
API. The following sample shows a custom handler:

import java.io.FileOutputStream;
import java.io.PrintWriter;

import java.util.logging.Handler;
import java.util.logging.LogRecord;

[ **

* MyCustomHandler outputs contents to a specified file
*/

public class MyCustomHandler extends Handler {

FiTleOutputStream fileOutputStream;
PrintWriter printWriter;

public MyCustomHandler(String filename) {
super();

// check input parameter
if (filename == null || filename == "")
filename = "mylogfile.txt";

try {
// initialize the file
fileOutputStream = new FileOutputStream(filename);
printWriter = new PrintWriter(fileOutputStream);
setFormatter(new SimpleFormatter());
}
catch (Exception e) {
// implement exception handling...
}
1

/* (non-API documentation)
* @see java.util.logging.Handler#publish(java.util.logging.LogRecord)
*
/
public void publish(LogRecord record) {
// ensure that this Tog record should be logged by this Handler
if (!isLoggable(record))
return;

// Output the formatted data to the file
printWriter.printin(getFormatter().format(record));

}

/* (non-API documentation)

* @see java.util.logging.Handler#flush()
*/

public void flush() {
printWriter.flush();

1

/* (non-API documentation)
* @see java.util.logging.Handler#close()
*
/
public void close() throws SecurityException {
printWriter.close();
1
}

Example: Creating a custom filter. A custom filter provides optional, secondary control over what is
logged, beyond the control that is provided by the level. The mechanism for creating a custom filter is the
Filter interface support that is provided by the IBM Developer Kit, Java Technology Edition. If you are not
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familiar with filters, as implemented by the Developer Kit, you can get more information from various texts,
or by reading the API documentation the for the java.util.logging API.

The following example shows a custom filter:

[*x

* This class filters out all log messages starting with SECJ022E, SECJ0373E, or SECJO350E.
*/

import java.util.logging.Filter;

import java.util.logging.Handler;

import java.util.logging.Logger;

import java.util.logging.LogRecord;

public class MyFilter implements Filter {
public boolean isLoggable(LogRecord 1r) {
String msg = Tr.getMessage();
if (msg.startsWith("SECJ0222E") || msg.startsWith("SECJO373E") || msg.startsWith("SECJO350E")) {
return false;

}

return true;

}
//This code will register the above log filter with the root Logger's handlers (including the WAS system Tlogs):

Logger rootlLogger = Logger.getLogger("");
rootLogger.setFilter(new MyFilter());

Example: Creating a custom formatter. A formatter formats events. Handlers are associated with one or
more formatters. The mechanism for creating a custom formatter is the Formatter class support that is
provided by the IBM Developer Kit, Java Technology Edition. If you are not familiar with formatters, as
implemented by the Developer Kit, you can get more information from various texts, or by reading the API
documentation for the java.util.logging API.

The following example shows a custom formatter:

import java.util.Date;
import java.util.logging.Formatter;
import java.util.logging.LogRecord;

[x%

* MyCustomFormatter formats the LogRecord as follows:
* date  Tevel Tlocalized message with parameters
*/

public class MyCustomFormatter extends Formatter {

public MyCustomFormatter() f{
super();

public String format(LogRecord record) {

// Create a StringBuffer to contain the formatted record
// start with the date.
StringBuffer sb = new StringBuffer();

// Get the date from the LogRecord and add it to the buffer
Date date = new Date(record.getMillis());
sh.append(date.toString());

sbh.append(" ");

// Get the level name and add it to the buffer
sbh.append(record.getLevel().getName());
sh.append(" ");

// Get the formatted message (includes localization

// and substitution of paramters) and add it to the buffer
sbh.append(formatMessage(record));

sbh.append("\n");
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return sb.toString();
}
}

Example: Creating custom log files. Adding custom handlers, filters, and formatters enables you to
customize your logging environment beyond what can be achieved by the configuration of the default
WebSphere Application Server logging infrastructure. The following example demonstrates how to add a
new handler to process requests to the com.myCompany subtree of loggers (see[‘Configuring the logger]
|hierarchy” on page 19b. The main method in this sample gives an example of how to use the newly

configured logger.

import java.util.Vector;

import java.util.logging.Filter;
import java.util.logging.Formatter;
import java.util.logging.Handler;
import java.util.logging.Level;
import java.util.logging.Logger;

public class MyCustomLogging {
public MyCustomLogging() {
super();
1
public static void initializelLogging() {

// Get the logger that you want to attach a custom Handler to
String defaultResourceBundleName = "com.myCompany.Messages";

Logger logger = Logger.getLogger("com.myCompany", defaultResourceBundleName);

// Set up a custom Handler (see MyCustomHandler example)
Handler handler = new MyCustomHandler("MyOutputFile.log");

// Set up a custom Filter (see MyCustomFilter example)
Vector acceptablelLevels = new Vector();
acceptablelevels.add(Level.INFO);
acceptablelevels.add(Level.SEVERE);

Filter filter = new MyCustomFilter(acceptablelLevels);

// Set up a custom Formatter (see MyCustomFormatter example)
Formatter formatter = new MyCustomFormatter();

// Connect the filter and formatter to the handler
handler.setFilter(filter);
handler.setFormatter(formatter);

// Connect the handler to the logger
logger.addHandler(handler);

// avoid sending events logged to com.myCompany showing up in WebSphere
// Application Server logs
logger.setUseParentHandlers(false);

}

public static void main(String[] args) {
initializelogging();

Logger logger = Logger.getLogger("com.myCompany");

logger.info("This is a test INFO message");
logger.warning("This is a test WARNING message");

logger.logp(Level.SEVERE, "MyCustomLogging", "main", "This is a test SEVERE message");
}
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When the above program is run, the output of the program is written to the MyOutputFile.log file. The
content of the log is in the expected log file, as controlled by the custom handler, and is formatted as
defined by the custom formatter. The warning message is filtered out, as specified by the configuration of
the custom filter. The output is as follows:

C:\>type MyOutputFile.log

Sat Sep 04 11:21:19 EDT 2004 INFO This is a test INFO message

Sat Sep 04 11:21:19 EDT 2004 SEVERE This is a test SEVERE message

Loggers
Loggers are used by applications and runtime components to capture message and trace events.

When situations occur that are significant either due to a change in state, for example when a server
completes startup or because a potential problem is detected, such as a timeout waiting for a resource, a
message is written to the logs. Trace events are logged in debugging scenarios, where a developer needs
a clear view of what is occurring in each component to understand what might be going wrong. Logged
events are often the only events available when a problem is first detected, and are used during both
problem recovery and problem resolution.

Loggers are organized hierarchically. Each logger can have zero or more child loggers.

Loggers can be associated with a resource bundle. If specified, the resource bundle is used by the logger
to localize messages that are logged to the logger. If the resource bundle is not specified, a logger uses
the same resource bundle as its parent.

You can configure loggers with a . If specified, the level is compared by the logger to incoming
events. The events that are less severe than the level set for the logger are ignored by the logger. If the
level is not specified, a logger takes on the level that is used by its parent. The default level for loggers is
Level.INFO.

Loggers can have zero or more attached . If supplied, all events that are logged to the logger are
passed to the attached handlers. Handlers write events to output destinations such as log files or network
sockets. When a logger finishes passing a logged event to all of the handlers that are attached to that
logger, the logger passes the event to the handlers that are attached to the parents of the logger. This
process stops if a parent logger is configured not to use its parent handlers. Handlers in WebSphere
Application Server are attached to the root logger. Set the useParentHandlers logger property to false to
prevent the logger from writing events to handlers that are higher in the hierarchy.

Loggers can have a If supplied, the filter is invoked for each incoming event to tell the logger whether
or not to ignore it.

Applications interact directly with loggers to log events. To obtain or create a logger, a call is made to the
Logger.getLogger method with a name for the logger. Typically, the logger name is either the package
qualified class name or the name of the package that the logger is used by. The hierarchical logger
namespace is automatically created by using the dots in the logger name. For example, the
com.ibm.websphere.ras logger has a com.ibm.websphere parent logger, which has a com.ibm parent. The
parent at the top of the hierarchy is referred to as the root logger. This root logger is created during
initialization. The root logger is the parent of the com logger.

Loggers are structured in a hierarchy. Every logger, except the root logger, has one parent. Each logger
can also have 0 or more children. A logger inherits log handlers, resource bundle names, and event
filtering settings from its parent in the hierarchy. The logger hierarchy is managed by the LogManager
function.

Loggers create log records. A log record is the container object for the data of an event. This object is
used by filters, handlers, and formatters in the logging infrastructure.
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The logger provides several sets of methods for generating log messages. Some log methods take only a
level and enough information to construct a message. Other, more complex logp (log precise) methods
support the caller in passing class name and method name attributes, in addition to the level and message
information. The logrb (log with resource bundle) methods add the capability of specifying a resource
bundle as well as the level, message information, class name, and method name. Using methods such as
severe, warning, fine, finer, and finest you can log a message at a particular level. For more information on
logging and how to use it in your applications read |“Using Java logging in an application” on page 8] For a
complete list of methods, see the java.util.logging documentation at |http://java.sun.com/javase/.

Log handlers
Log handlers write log record objects to output devices like log files, sockets, and notification mechanisms.

Loggers can have zero or more attached handlers. All objects that are logged to the logger are passed to
the attached handlers, if handlers are supplied.

You can configure handlers with a The handler compares the level that is specified in the logged
object to the level that is specified for the handler. If the level of the logged object is less severe than the
level set in the handler, the object is ignored by the handler. The default level for handlers is ALL.

Handlers can have a If a filter is supplied, the filter is invoked for each incoming object to tell the
handler whether or not to ignore it.

Handlers can have a If a formatter is supplied, the formatter controls how the logged objects are
formatted. For example, the formatter can decide to first include the time stamp, followed by a string
representation of the level, followed by the message that is included in the logged object. The handler
writes this formatted representation to the output device.

Both loggers and handlers can have levels and filters, and a logged object must pass all of these elements
to be output. For example, you can set the logger level to FINE, but if the handler level is set at
WARNING, only WARNING level messages are displayed in the output for that handler. Conversely, if your
log handler is set to output all messages (level=All), but the logger level is set to WARNING, the logger
never sends messages lower than WARNING to the log handler.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Log levels
Levels control which events are processed by Java logging. WebSphere Application Server controls the
levels of all loggers in the system.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

The level value is set from configuration data when the logger is created and can be changed at run time

from the administrative console. If a level is not set in the configuration data, a level is obtained by
proceeding up the hierarchy until a parent with a level value is found. You can also set a level for each
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handler to indicate which events are published to an output device. When you change the level for a
logger in the administrative console, the change is propagated to the children of the logger.

Levels are cumulative; a logger can process logged objects at the level that is set for the logger, and at all
levels above the set level.

Table 1. Valid log levels. This table lists valid logging levels.

Level Content / Significance

Off No events are logged.

Fatal Task cannot continue and component cannot function.

Severe Task cannot continue, but component can still function

Warning Potential error or impending error

Audit Significant event affecting server state or resources

Info General information outlining overall task progress

Config Configuration change or status

Detail General information detailing subtask progress

Fine Trace information - General trace

Finer Trace information - Detailed trace + method entry / exit / return values

Finest Trace information - A more detailed trace - Includes all the detail that is needed to debug
problems

All All events are logged. If you create custom levels, All includes your custom levels, and can
provide a more detailed trace than Finest.

For instructions on how to set logging levels, read the topic about configuring Java logging using the
administrative console.

Note: Trace information, which includes events at the Fine, Finer and Finest levels, can be written only to
the trace log. Therefore, if you do not enable diagnostic trace, setting the log detail level to Fine,
Finer, or Finest does not effect the logged data.

Log filters
Log filters help control more detailed logging settings that are not handled by usual log level settings.

A filter provides an optional, secondary control over what is logged, beyond the control that is provided by
setting the Applications can apply a filter mechanism to control logging output through the logging
APls. An example of filter usage is to suppress all the events with a particular message key.

A filter is attached to a logger or log handler using the appropriate setFilter method. For a complete list of
filter methods, see the java.util.logging documentation at |http:/java.sun.com/javase/

Log formatters
Log formatters format log messages so they can be used by various log handlers.

Handlers can be configured with a log formatter that knows how to format log records. The event, which is
represented by the log record object, is passed to the appropriate formatter by the handler. The formatter
returns formatted output to the handler, which writes the output to the output device.

The formatter is responsible for rendering the event for output. This formatter uses the resource bundle
that is specified in the event to look up the message in the appropriate language.

Formatters are attached to handlers using the setFormatter method.
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You can find the java.util.logging documentation at |http://java.sun.com/javase/}

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Java logging

Java logging is the logging toolkit that is provided by the java.util.logging package. Java logging provides a
standard logging API for your applications.

Message logging (messages) and diagnostic trace (trace) are conceptually similar, but do have important
differences. These differences are important for application developers to understand to use these tools
properly. The following operational definitions of messages and trace are provided.

Message
A message entry is an informational record that is intended for end users, systems administrators,
and support personnel to view. The text of the message must be clear, concise, and interpretable
by an end user. Messages are typically localized and displayed in the national language of the end
user. Although the destination and lifetime of messages might be configurable, enable some level
of message logging in normal system operation. Use message logging judiciously because of
performance considerations and the size of the message repository.

Trace A trace entry is an information record that is intended for service engineers or developers to use.
As such, a trace record might be considerably more complex, verbose, and detailed than a
message entry. Localization support is typically not used for trace entries. Trace entries can be
fairly inscrutable, understandable only by the appropriate developer or service personnel. It is
assumed that trace entries are not written during normal runtime operation, but can be enabled as
needed to gather diagnostic information.

The application server redirects the system streams at the server startup. There is no way to allow the
application to output logging to the console because the system streams can not be obtained by the
application. If you would like to use console to monitor the application without using the console handler,
you can either monitor theSystemOut.1og file, or monitor a file created by another file handler.

Note: The application server uses Java logging internally and therefore certain restrictions apply for using
system streams with this logging API by applications. During server startup, the standard output and
error streams are replaced with special streams that write to the logging infrastructure, in order to
include the output of the system streams in the log files. Because of this, applications can not use
java.util.Togging.ConsoleHandler, or any handler writing to System.err or System.out streams,
attached to the root logger. If the user does attach the handler to the root logger, an infinite loop is
created within the logging infrastructure, leading to stack overflow and server crash.

If the use of a handler that writes to system streams is necessary, attach it to a non-root logger so
that it does not publish log records to parent handlers. The data written to the system streams is
then formatted and written to the corresponding system stream log file. To monitor what is being
written system streams, the configured log files (SystemQut.log and SystemErr.Tog by default) can
be monitored.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
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HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Note: The SystemOut.log and STDOUT streams are redirected to the SYSPRINT ddname under z/OS. The
System.err and STDERR streams are redirected to the SYSOUT ddname under z/OS. By default, the
WebSphere Application Server for z/OS cataloged procedures associate these ddnames with print
(SYSOUT=") data sets, causing message logs to go into WebSphere Application Server job output.
Job output can be viewed with the Spool Display and Search Facility (SDSF) or equivalent
software.

Configuring the logger hierarchy

WebSphere Application Server handlers are attached to the Java root logger, which is at the top of the
logger hierarchy. As a result, any request from anywhere in the logger tree can be processed by
WebSphere Application Server handlers.

About this task

You can configure your application server to handle logs in many different ways. Configure your log
settings based upon your configuration and the logging structure that best suits your needs.

Procedure

» Forward all application logging requests to the WebSphere Application Server handlers. This behavior is
the default.

« Forward all application logging requests to your own custom handlers. Set the useParentHandlers
option to false on one of your custom loggers, and then attach your handlers to that logger.

» Forward all application logging requests to both WebSphere Application Server handlers, and your
custom handlers, but do not forward WebSphere Application Server logging requests to your custom
handlers. Set the useParentHandlers option to true on one of your non-root custom loggers, and then
attach your handlers to that logger.True is the default setting.

» Forward all WebSphere Application Server logging requests to both WebSphere Application Server
handlers, and your custom handlers. Logging requests are always forwarded to WebSphere Application
Server handlers. To forward WebSphere Application Server requests to your custom handlers, attach
your custom handlers to the Java root logger, so that they are at the same level in the hierarchy as the
WebSphere Application Server handlers.
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Example

The following example shows how these requirements can be met using the Java logging infrastructure:

3 User Handler1 e Qutput
Handler ) device
Application com.xyz.abc.def (
code — ™ ( Logger)
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Application Anonymous
code {Logger) | |
Applications root Applications
-------------------------------------------------------------------------- > [ Logger ) WobSuhore
WebSphere Application Server WebSphere
¥ Application Server
5 WebSphere
i i O t
Sarvice mm.:bm.ws. XYZ com.ibm.ws Application - o "“F""
broker { Logger ) {Logger) Server handlers SE

Creating log resource bundles and message files

You can forward messages that are written to the internal WebSphere Application Server logs to other
processes for display. Messages that are displayed on the administrative console, which can be running in
a different location than the server process, can be localized using the late binding process. Late binding
means that WebSphere Application Server does not localize messages when they are logged, but defers
localization to the process that displays the message.

About this task

Every method that accepts messages localizes those messages. The mechanism for providing localized
messages is the resource bundle support provided by the IBM Developer Kit, Java Technology Edition. If
you are not familiar with resource bundles as implemented by the Developer Kit, you can get more
information from various texts, or by reading the APl documentation for the java.util. ResourceBundle,
java.util.ListResourceBundle and java.util.PropertyResourceBundle classes, as well as the
java.text.MessageFormat class.

The PropertyResourceBundle class is the preferred mechanism to use.

To properly localize the message, the displaying process must have access to the resource bundle where
the message text is stored. You must package the resource bundle separately from the application, and
install it in a location where the viewing process can access it.

By default, the WebSphere Application Server runtime localizes all the messages when they are logged.
This localization eliminates the need to pass a .jar file to the application, unless you need to localize in a
different location. However, you can use the early binding technique to localize messages as they log. An
application that uses early binding must localize the message before logging it. The application looks up
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the localized text in the resource bundle and formats the message. Use the early binding technique to
package the application resource bundles with the application.

To create a resource bundle, perform the following steps.

Procedure

1. Create a text properties file that lists message keys and the corresponding messages. The properties
file must have the following characteristics:

» Each property in the file is terminated with a line-termination character.

» If a line contains white space only, or if the first non-white space character of the line is the pound
sign symbol (#) or exclamation mark (!), the line is ignored. The # and ! characters can therefore be
used to put comments into the file.

» Each line in the file, unless it is a comment or consists of white space only, denotes a single
property. A backslash (\) is treated as the line-continuation character.

« The syntax for a property file consists of a key, a separator, and an element. Valid separators
include the equal sign (=), colon (:), and white space ().

» The key consists of all characters on the line from the first non-white space character to the first
separator. Separator characters can be included in the key by escaping them with a backslash (\),
but doing this process is not recommended, because escaping characters is error prone and
confusing. Instead, use a valid separator character that does not display in any keys in the
properties file.

* White space after the key and separator is ignored until the first non-white space character is
encountered. All characters remaining before the line-termination character define the element.

See the Java documentation for the java.util.Properties class for a full description of the syntax and the
construction of properties files.

2. Translate the file into localized versions of the file with language-specific file names. For example, a
file named DefaultMessages.properties can be translated into DefaultMessages_de.properties for
German and DefaultMessages ja.properties for Japanese.

3. When the translated resource bundles are available, put the bundle in a directory that is part of the
application class path.

4. When a message logger is obtained from the log manager, configure it to use a particular resource
bundle. Messages logged with the Logger API use this resource bundle when message localization is
performed. At run time, the user locale setting determines the properties file from which to extract the
message that is specified by a message key, ensuring that the message is delivered in the correct
language.

5. If the message loggers msg method is called, a resource bundle name must be explicitly provided.
Example

You can create resource bundles in several ways. The best and easiest way is to create a properties file
that supports a properties resource bundle. This example shows how to create such a properties file.

For this sample, four localizable messages are provided. The properties file is created and the key-value
pairs are inserted. All the normal properties file conventions and rules apply to this file. In addition, the
creator must be aware of other restrictions that are imposed on the values by the Java MessageFormat
class. For example, apostrophes must be escaped or they cause a problem. Avoid the use of non-portable
characters. WebSphere Application Server does not support the use of extended formatting conventions
that the MessageFormat class supports, such as {1, date} or {0,number, integer}.

Assume that the base directory for the application that uses this resource bundle is baseDir and that this
directory is in the class path. Assume that the properties file is stored in the subdirectory baseDir that is
not in the class path (for example, baseDir/subDirl/subDir2/resources). To allow the messages file to
resolve, the subDirl.subDir2.resources.DefaultMessage name is used to identify the property resource
bundle and is passed to the message logger.
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For this sample, the properties file is named DefaultMessages.properties.

# Contents of the DefaultMessages.properties file
MSG_KEY_00=A message with no substitution parameters.
MSG_KEY_01=A message with one substitution parameter: parml={0
MSG_KEY_02=A message with two substitution parameters: parml={

}
0}, parm2 = {1}
MSG_KEY_03=A message with three parameter: parml={0}, parm2 = {

1}, parm3={2}

When the DefaultMessages.properties file is created, the file can be sent to a translation center where
the localized versions are generated.

What to do next

The application locates the resource bundle based on the file location relative to any directory in the class
path. For instance, if the DefaultMessages.properties property resource bundle is located in the
baseDir/subDirl/subDir2/resources directory and baseDir is in the class path, the name
subdirl.subdir2.resources.DefaultMessage is passed to the message logger to identify the resource
bundle.

Logger.properties file for configuring logger settings
Use the Logger.properties file to set logger attributes for specific loggers.

The properties file is loaded the first time that the Logger.getLogger(logger_name) method is called within
an application.

Important: The name of the Logger.properties file is case sensitive. Use a capital "L" in the file name.

When an application calls the Logger.getLogger method for the first time, all the available logger properties
files are loaded. Applications can provide Logger.properties files in:

» the META-INF directory of the Java archive (JAR) file for the application
 directories included in the class path of an application module
» directories included in the application class path

The properties file contains two categories of parameters, logger control and logger data:

» Logger control information
— Minimum localization level: The minimum LogRecord level for which localization is attempted
— Group: The logical group that this component belongs to

— Event factory: The Common Base Event template file to use with the event factory. The naming
convention for this template is the fully qualified component name, with a file extension of
.event.xml. For example, a template that applies to the com.ibm.compXYZ package is called
com.ibm.compXYZ.event.xml.

* Logger data information
— Product name
— Organization name
— Component name
— Extensions and additional properties

Syntax of the Logger.properties file
Use the following syntax to set logger properties:
<logger base name>.<property>=value

where:
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logger base name is the starting part of the logger name to which the property applies. All loggers with
names starting with this string have the property applied.

property is one of the following properties:
* organization

* product

e component

* minimum_localization_level

s group

» eventfactory

» handler_preference=operator (This property writes anything that is logged to the console WTO,
write-to-operator. Without this property the AUDIT level is written only to hardcopy WTO.)

Sample Logger.properties file

In the following sample, the com.ibm.xyz.MyEventFactory event factory is used by any loggers in the
com.ibm.websphere.abc package or any sub packages that do not override this value in their configuration
file.

com.ibm.websphere.abc.eventfactory=com.ibm.xyz.MyEventFactory
Group Logger.properties file

In the following example, the group is MyTraceGroup and the components are com.ibm.stuff and
com.ibm.morestuff:

com.ibm.stuff.group=MyTraceGroup
com.ibm.morestuff.group=MyTraceGroup

Configuring applications to use Jakarta Commons Logging

Jakarta Commons Logging provides a simple logging interface and thin wrappers for several logging
systems. WebSphere Application Server supports Jakarta Commons Logging by providing a logger. The
support does not change interfaces defined by Jakarta Commons Logging.

Before you begin

The WebSphere Application Server logger is a thin wrapper for the WebSphere Application Server logging
facility. The logger name is com.ibm.websphere.commons.logging. WsJDK14Logger. The logger can handle
logging objects defined by either of the following:

« Java Logging found in [Java Specification Request 47: Logging API Specification|
+ [Common Base Event]

A logging object is an object that holds logging entry information.

To better understand Jakarta Commons Logging, read |Jakarta Commons| and the specifications for Java
Logging and for Common Base Event. To better understand use of the WebSphere Application Server
logger, read [*Jakarta Commons Logging” on page 24|

About this task

WebSphere Application Server provides the Jakarta Commons Logging binary distribution in its T1ibraries
directory. By default, the product uses the Jakarta Commons Logging LogFactory implementation and
JDK14Logger.
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best-practices: The default configuration of Jakarta Commons Logging is stored in the
commons-Togging.properties file. To specify the factory class to use with Jakarta
Commons Logging in an application, provide a file named
org.apache.commons.logging.LogFactory, located in META-INF/services directory, that
contains the name of the factory class on the first line. This is the configuration
mechanism for the JAR file service provider, as defined in JDK 1.3 and above.

For an application to use the WebSphere Application Server logger, the application must provide its own
configuration for the logger. To configure an application to use the WebSphere Application Server logger,
complete the steps that follow.

Procedure

1. Examine [‘Configurations for the WebSphere Application Server logger” on page 27 and determine
which configuration best suits your application.

2. Change your application configuration as needed to enable use of the WebSphere Application Server
logger.

Results

After the application starts, Jakarta Commons Logging routes the application's logging output to the
WebSphere Application Server logger.

Jakarta Commons Logging

Jakarta Commons Logging provides a simple logging interface and thin wrappers for several logging
systems. The logging interface enables application logging to be simple and independent of the logging
system that the application uses. You can change the logging implementation for a deployed application
without having to change the application logging code. However, the simplicity of the logging interface
prevents the application from leveraging all the functionality of the logging systems.

This topic provides the following information about Jakarta Commons Logging in WebSphere Application
Server:

« [‘Support for Jakarta Commons Logging’|

« [‘Benefits of support for Jakarta Commons Logging’]

« [‘Overview of the process for using Jakarta Commons Logging” on page 25|

« [“Classes used to obtain a logger factory and logger” on page 25

* [“Logger level configuration and mapping” on page 26|

Support for Jakarta Commons Logging

The product supports Jakarta Commons Logging| by providing a logger, a thin wrapper for the WebSphere

Application Server logging facility. The logger can handle both [Java Logging| (JSR-47) and
logging objects. A logging object is an object that holds logging entry information.

The product support for Jakarta Commons Logging does not change interfaces defined by Jakarta
Commons Logging.

Benefits of support for Jakarta Commons Logging

The WebSphere Application Server support for Jakarta Commons Logging provides the following benefits:
* WebSphere Application Server is pre-configured to use Jakarta Commons Logging.

All of the functionality of Jakarta Commons Logging is provided for any application or WebSphere
Application Server component. Logging calls are routed by default to the underlying WebSphere
Application Server logging facility.

* Alogger that uses the WebSphere Application Server logging facility.
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Applications and components can pass both Java Logging and Common Base Event logging objects to
the WebSphere Application Server logger without conversion to strings, providing applications with
enhanced logging. Further, Jakarta Commons Logging Logger levels are integrated into WebSphere
Application Server administrative facilities.

Overview of the process for using Jakarta Commons Logging

Logging with Jakarta Commons Logging consists of the steps that follow. |“Configurations for the|

|WebSphere Application Server logger” on page 27| provides details on configuring your application to use

the WebSphere Application Server logger.

1.

Obtain an instance of a logger factory.

To obtain a logger factory, use Jakarta Commons Logging code. You can configure the code to meet
your needs. In WebSphere Application Server, Jakarta Commons Logging is configured by default to
instantiate the Jakarta Commons Logging default logger factory. Applications or WebSphere Application
Server components can provide their own configuration if they use a different logger factory
implementation. Applications can use more than one factory.

Obtain an instance of a logger.

To obtain a logger, use code implemented by a logger factory. Configuration of the code is
implementation specific.

The WebSphere Application Server logger implements the methods defined in the logging interface.
The logging methods take at least one argument, which can be any Java object. The WebSphere
Application Server logger, the WsJDK14Logger logger described in [‘Classes used to obtain a logger
[factory and logger,] handles the following objects passed into the following logging methods:
CommonBaseEvent

Wrapped into CommonBaseEventLogRecord
CommonBaseEventLogRecord

Passed without change
LogRecord

Passed without change
Other objects

Converted to String
Applications or WebSphere Application Server components can provide their own configuration if they

use an implementation of a logger that is not specific to WebSphere Application Server. An application
must know what factory is being used in order to configure it.

Start your application. Jakarta Commons Logging routes the application's logging output to the
designated logger

Classes used to obtain a logger factory and logger

Table 2. Jakarta Commons Logging class descriptions. Use the classes for a logger factory instance and logger.

Class name Description

LogFactory LogFactory is a Jakarta Commons Logging class that implements initialization logic. LogFactory

is an abstract class that every logger factory implementation has to extend. It provides static
methods for obtaining:

* An instance of a factory class

» Instances of a logger, using an instance of the factory class

LogFactory provides methods for obtaining instances of loggers, although these methods
delegate the logger instantiation and configuration to an instance of a logger factory class.

Logger factories, once instantiated, are cached on a per context class loader basis. The
instances in a cache can be released. This functionality is designed for platform container
implementations rather than for applications.
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Table 2. Jakarta Commons Logging class descriptions (continued). Use the classes for a logger factory instance
and logger.

Class name Description

LogFactorylmpl LogFactorylmpl is a Jakarta Commons Logging concrete class that implements the default
logger factory using methods in LogFactory. To use Java Logging, there must always be at least
one instance of a logger factory class, even if the application has not explicitly obtained one. If
the configuration does not name a logger factory class, LogFactorylmpl is used as the default.

Log Log is a Jakarta Commons Logging interface for loggers. Commons logging loggers have to
implement the Log interface. Because the goal of Jakarta Commons Logging is to wrapper any
logging system, the Log interface defines a small set of common logging methods. In
WebSphere Application Server, WsJDK14Logger implements the Log interface.

Logger instantiation and configuration is specific to every logger factory. Logging in WebSphere
Application Server uses the default logger factory provided in Jakarta Commons Logging, which
keeps instantiated loggers in cache, on a per context class loader basis.

WsJDK14Logger | WsJDK14Logger is a WebSphere Application Server class that provides a Jakarta Commons
Logging logger by implementing the Log interface. The WsJDK14Logger logger differs from the
Java Logging logger in that the WsJDK14Logger logger enables Java Logging or Common Base
Event objects to be passed over without converting them into String objects. This prevents any
information loss the conversion to String might cause as well as allows the logging output to be
more descriptive and precise. In contrast, the Java Logginglogger that is provided in Jakarta
Commons Logging converts objects passed into the logging calls to String objects before
passing them over to the underlying Java Logging.

Logger level configuration and mapping

Because Jakarta Commons Logging loggers are thin wrappers for specific logging systems, the loggers do
not have their own level, but use the level of the logger from the underlying logging system. Although the
underlying system can provide methods for changing level, there are no methods for changing level
defined on the Log interface, which all Jakarta Commons Logging loggers must implement.
WsJDK14Logger uses the level of its underlying Java Logging logger.

Following table shows, on the left, the mapping of Jakarta Commons Logging levels within
WsJDK14Logger to levels in the WebSphere Application Server implementation of Java Logging. On the
right, it shows the levels defined in Java Logging and the level mapping in the Jakarta Commons Logging
JDK14Logger to the Java Logging levels.

Table 3. Mapping of WsJDK14Logger levels to Java Logging levels. Compare the logging levels.

Java Logging in WebSphere
WsJDK14Logger Application Server Java Logging JDK14Logger
Fatal Fatal
Error Severe Severe Fatal, Error
Warning Warning Warning Warning
Audit
Info Info Info Info
Config Config
Detail
Debug Fine Fine Debug
Finer Finer
Trace Finest Finest Trace
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The WsJDK14Logger level is synchronized with the underlying Java Logging logger level. WebSphere
Application Server administration controls the WsJDK14Logger level.

Configurations for the WebSphere Application Server logger
This topic describes several ways to configure an application to use the WebSphere Application Server

logger.

The type of configuration that best suits an application depends upon the following:

* Whether the class loader order setting for the application is Classes loaded with parent class Toader
first (Parent First) or Classes Toaded with application class loader first (Parent Last), you can
set the class loader delegation mode on a console page. For more details about class load order and
delegation, consult the class loading chapter in the Developing and deploying applications PDF book

* Whether Jakarta Commons Logging is bundled with the application configuration

* Whether Jakarta Commons Logging is provided within the application

The following tables describe the conditions required to enable an application to use the WebSphere

Application Server logger.

Class loader mode is Parent First and Jakarta Commons Logging is bundled with the application

Table 4. Conditions required to use logger.

application.

When Parent First and Jakarta Commons Logging is bundled with an

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

* The properties file
commons-1logging.properties in
the application classpath is not
read by the LogFactory
because the parent class
loader finds the WebSphere
properties file first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.Togging.LogFactory

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration,
unless the
configuration is
provided in a
META-INF file of
the application or
module.

The log used is either
of the following:

* The Log
implementation
specified in the
WebSphere
Application Server
default configuration

* An application-
specific

Log implementation if
an application-specific
LogFactory that
instantiates a different
Log implementation is
used.

The application parent class loader
is the first class loader to load the
Jakarta Commons Logging code. The
WebSphere bundle that supports
Jakarta Commons Logging provides
the LogFactory static code that looks
up the LogFactory configuration
attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the parent
class loader.

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere default
configuration.

The log used is the
Log implementation
specified in the
WebSphere default
configuration.

The Jakarta Commons Logging
bundled with the application is not
used.

Class loader mode is Parent First and Jakarta Commons Logging is not bundled with the

application
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Table 5. Conditions required to use logger.

application.

When Parent First and Jakarta Commons Logging is not bundled with an

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

» The properties file
commons-1logging.properties in
the application classpath is not
read by the LogFactory
because the parent class
loader finds the WebSphere
Application Server properties
file first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.Togging.LogFactory

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration,
unless the
configuration is
provided in a
META-INF file of
the application or
module.

The log used is either
of the following:

* The Log
implementation
specified in the
WebSphere
Application Server
default configuration

* An
application-specific
Log implementation if
an application-specific
LogFactory that
instantiates a different
Log implementation is
used.

The application parent class loader
is the first class loader to load the
Jakarta Commons Logging code. The
WebSphere bundle that supports
Jakarta Commons Logging provides
the LogFactory static code that looks
up the LogFactory configuration
attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the parent
class loader.

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration.

The log used is the
Log implementation
specified in the
WebSphere
Application Server
default configuration.

Same as in the previous row

Class loader mode is Parent Last and Jakarta Commons Logging is bundled with the application

Table 6. Conditions required to use logger.

application.

When Parent Last and Jakarta Commons Logging is bundled with an

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

» The properties file
commons-1logging.properties in
the application classpath is
read by the LogFactory
because the class loader finds
the application properties file
first.

* The class name is read from
the file
META-INF/services/

org.apache.commons
.logging.LogFactory

The log factory
used is either of
the following:

* The default
Jakarta Commons
Logging
LogFactory

* The LogFactory
specified in the
application
configuration

The log used is the
Log implementation
specified in the
application
configuration.

If the log factory used
is the default Jakarta
Commons Logging
LogFactory, the Log
implementation must
be on the classpath
of the application
class loader.

The application class loader is the
first class loader to load the Jakarta
Commons Logging code. The
application bundle that supports
Jakarta Commons Logging provides
the LogFactory static code that looks
up the LogFactory configuration
attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the
application class loader.
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Table 6. Conditions required to use logger (continued). When Parent Last and Jakarta Commons Logging is

bundled with an application.

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration.

The log used is the
Log implementation
specified in the
WebSphere
Application Server
default configuration.

Class loader mode is Parent Last and Jakarta Commons Logging is not bundled with the

application

Table 7. Conditions required to use logger.

application.

When Parent Last and Jakarta Commons Logging is not bundled with an

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

» The properties file
commons-logging.properties in
the application classpath is
read by the LogFactory
because the class loader finds
the application properties file
first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.Togging.LogFactory

The log factory
used is either of
the following:

* The default
Jakarta Commons
Logging
LogFactory

* The LogFactory
specified in the
application
configuration

The log used is the
Log implementation
specified in the
application
configuration.

If the log factory used
is the default Jakarta
Commons Logging
LogFactory, the Log
implementation must
be on the classpath
of the application
class loader.

There is no Jakarta Commons Logging
code at the application class loader.
Thus, the WebSphere bundle that
supports Jakarta Commons Logging
provides the LogFactory static code
that looks up the LogFactory
configuration attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the parent
class loader.

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration.

The log used is the
Log implementation
specified in the
WebSphere
Application Server
default configuration.

Programming with the JRas framework

Use the JRas extensions to incorporate message logging and diagnostic trace into WebSphere Application

Server applications.
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Before you begin

The JRas framework that is described in this task and its sub-tasks is deprecated. However, you can
achieve similar results using Java logging.

About this task

The JRas extensions allow message logging and diagnostic trace to work with WebSphere Application
Server applications. They are based on the stand-alone JRas logging toolkit.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.Tog ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Procedure
1. Retrieve a reference to the JRas manager.
2. Retrieve message and trace loggers by using methods on the returned manager.

3. Call the appropriate methods on the returned message and trace loggers to create message and trace
entries, as appropriate.

JRas logging toolkit

The JRas logging toolkit provides diagnostic information to help the administrator diagnose problems or
tune application performance.

Note: The JRas framework that is described in this task and its sub-tasks is deprecated. However, you
can achieve similar results using Java logging.

Developing, deploying, and maintaining applications are complex tasks. For example, when a running
application encounters an unexpected condition, it might not be able to complete a requested operation. In
such a case, you might want the application to inform the administrator that the operation failed and
provide information. This action enables the administrator to take the proper corrective action. Those who
develop or maintain applications might need to gather detailed information relating to the path of a running
application to determine the root cause of a failure that is due to a code bug. The facilities that are used
for these purposes are typically referred to as message logging and diagnostic trace.

Message logging (messages) and diagnostic trace (trace) are conceptually quite similar, but do have
important differences. It is important for application developers to understand these differences to use
these tools properly. To start with, the following operational definitions of messages and trace are provided.
Message
A message entry is an informational record that is intended for end users, systems administrators
and support personnel to view. The text of the message must be clear, concise, and interpretable.
Messages are typically localized, meaning that they display in the national language of the end
user. Although the destination and lifetime of messages might be configurable, some level of
message logging is always enabled in normal system operation. Message logging must be used
judiciously due to both performance considerations and the size of the message repository.

Trace A trace entry is an information record that is intended for service engineers or developers to use.
This trace record might be considerably more complex, verbose, and detailed than a message
entry. Localization support is typically not used for trace entries. Trace entries can be fairly
inscrutable, understandable only by the appropriate developer or service personnel. It is assumed
that trace entries are not written during normal runtime operation, but might be enabled as needed
to gather diagnostic information.
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WebSphere Application Server provides a message logging and diagnostic trace API that applications can
use. This API is based on the stand-alone JRas logging toolkit, which was developed by IBM. The
stand-alone JRas logging toolkit is a collection of interfaces and classes that provide message logging and
diagnostic trace primitives. These primitives are not tied to any particular product or platform. The
stand-alone JRas logging toolkit provides a limited amount of support, which is typically referred to as
systems management support, including log file configuration support based on property files.

As designed, the stand-alone JRas logging toolkit does not contain the support that is required for
integration into the WebSphere Application Server run time or for use in a Java 2 Platform, Enterprise
Edition (J2EE) environment. To overcome these limitations, WebSphere Application Server provides a set
of extension classes to address these shortcomings. This collection of extension classes is referred to as
the JRas extensions. The JRas extensions do not modify the interfaces that are introduced by the
stand-alone JRas logging toolkit, but provide the appropriate implementation classes. The conceptual
structure that is introduced by the stand-alone JRas logging toolkit is described in the following section. It
is equally applicable to the JRas extensions.

JRas concepts

The section contains a basic overview of important concepts and constructs that are introduced by the
stand-alone JRas logging toolkit. This information is not an exhaustive overview of the capabilities of this
logging toolkit, nor is it intended as a detailed discussion of usage or programming paradigms. More
detailed information, including code examples, is available in|JRas extensions|and its subtopics, including
in the API documentation for the various interfaces and classes that make up the logging toolkit.
Event types
The stand-alone JRas logging toolkit defines a set of event types for messages and a set of event
types for trace. Examples of message types include informational, warning, and error. Examples of
trace types include entry, exit, and trace.
Event classes
The stand-alone JRas logging toolkit defines both message and trace event classes.
Loggers
A logger is the primary object with which the user code interacts. Two types of loggers are defined:
message loggers and trace loggers. The set of methods on message loggers and trace loggers
are different because they provide different functionality. Message loggers create message records
only and trace loggers create trace records only. Both types of loggers contain masks that indicate
which categories of events the logger processes and which to ignore. Although every JRas logger
is defined to contain both a message and trace mask, the message logger uses only the message
mask and the trace logger uses the trace mask only. For example, by setting a message logger
message mask to the appropriate state, it can be configured to process only error messages and
ignore informational and warning messages. Changing the trace mask state of a message logger
has no effect.

A logger contains one or more handlers to which it forwards events for further processing. When
the user calls a method on the logger, the logger compares the event type that is specified by the
caller to its current mask value. If the specified type passes the mask check, the logger creates an
event object to capture the information relating to the event that passed to the logger method. This
information can include information, such as the names of the class and method which logs the
event, a message, and parameters to log, among others. When the logger creates the event
object, it forwards the event to all handlers currently registered with the logger.

Methods that are used within the logging infrastructure do not make calls to the logger method.
When an application uses an object that extends a thread class, implements the hashCode
method, and makes a call to the logging infrastructure from that method, the result is a recursive
loop.

Handlers
A handler provides an abstraction over an output device or event consumer. An example is a file
handler, which knows how to write an event to a file. The handler also contains a mask that is
used to further restrict the categories of events the handler processes. For example, a message
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logger might be configured to pass both warning and error events, but a handler attached to the
message logger might be configured to pass error events only. Handlers also include formatters,
which the handler invokes to format the data in the passed event before it is written to the output
device.

Formatters
Handlers are configured with formatters, which know how to format events of certain types. A
handler can contain multiple formatters, each of which knows how to format a specific class of
event. The event object is passed to the appropriate formatter by the handler. The formatter
returns formatted output to the handler, which then writes it to the output device.

JRas Extensions

JRas extensions are the collection of implementation classes that support JRas integration into the
WebSphere Application Server environment.

JRas extensions

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

The stand-alone JRas logging toolkit defines interfaces and provides a variety of concrete classes that
implement these interfaces. Because the stand-alone JRas logging toolkit is developed as a general
purpose toolkit, the implementation classes do not contain the configuration interfaces and methods that
are necessary for use in the WebSphere Application Server product. In addition, many of the
implementation classes are not written appropriately for use in a Java 2 Platform, Enterprise Edition
(J2EE) environment. To overcome these shortcomings, WebSphere Application Server provides the
appropriate implementation classes that support integration into the WebSphere Application Server
environment. The collection of these implementation classes is referred to as the JRas extensions.

Usage model

You can use the JRas extensions in three distinct operational modes:

Integrated
In this mode, message and trace records are written only to logs that are defined and maintained
by the WebSphere Application Server run time. This mode is the default mode of operation and is
equivalent to the WebSphere Application Server V4.0 mode of operation.

Stand-alone
In this mode, message and trace records are written solely to stand-alone logs that are defined
and maintained by the user. You control which categories of events are written to which logs, and
the format in which entries are written. You are responsible for configuration and maintenance of
the logs. Message and trace entries are not written to WebSphere Application Server runtime logs.

Combined
In this mode, message and trace records are written to both WebSphere Application Server
runtime logs and to stand-alone logs that you must define, control, and maintain. You can use
filtering controls to determine which categories of messages and trace are written to which logs.

The JRas extensions are specifically targeted to an integrated mode of operation. The integrated mode of
operation can be appropriate for some usage scenarios, but many scenarios are not adequately addressed
by these extensions. Many usage scenarios require a stand-alone or combined mode of operation instead.
A set of user extension points are defined that support JRas extensions in either a stand-alone or
combined mode of operations.

JRas extension classes

WebSphere Application Server provides a base set of implementation classes that are collectively referred
to as the JRas extensions. Many of these classes provide the appropriate implementations of loggers,
handlers, and formatters for use in a WebSphere Application Server environment.

32 Troubleshooting and support



The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

The collection of JRas classes is targeted at an integrated mode of operation. If you choose to use the
JRas extensions in either stand-alone or combined mode, you can reuse the logger and manager class
that are provided by the extensions, but you must provide your own implementations of handlers and
formatters.

WebSphere Application Server message and trace loggers

The message and trace loggers that are provided by the stand-alone JRas logging toolkit cannot be
directly used in the WebSphere Application Server environment. The JRas extensions provide the
appropriate logger implementation classes. Instances of these message and trace logger classes are
obtained directly and exclusively from the WebSphere Application Server Manager class. You cannot
directly instantiate message and trace loggers. Obtaining loggers in any manner other than directly from
the Manager class is not allowed and directly violates the programming model.

The message and trace logger instances that are obtained from the WebSphere Application Server
Manager class are subclasses of the RASMessagelLogger and RASTracelLogger classes that are provided
by the stand-alone JRas logging toolkit. The RASMessagelLogger and RASTracelLogger classes define the
set of methods that are directly available. Public methods that are introduced by the JRas extensions
logger subclasses cannot be called directly by user code because it is a violation of the programming
model.

Loggers are named objects and are identified by name. When the Manager class is called to obtain a
logger, the caller is required to specify a name for the logger. The Manager class maintains a
name-to-logger instance mapping. Only one instance of a named logger is ever created within the lifetime
of a process. The first call to the Manager class with a particular name results in the logger, which is
configured by the Manager class. The Manager class caches a reference to the instance, then returns it to
the caller. Subsequent calls to the Manager class that specify the same name result in a returned
reference to the cached logger. Separate namespaces are maintained for message and trace loggers. You
can use a single name obtain both a message logger and a trace logger from the Manager, without
ambiguity, and without causing a namespace collision.

In general, loggers have no predefined granularity or scope. A single logger can be used to instrument an

entire application. You might determine that having a logger per class is more effective, or the appropriate

granularity might be somewhere in between. Partitioning an application into logging domains is determined
by the application writer.

The WebSphere Application Server logger classes that are obtained from the Manager class are
thread-safe. Although the loggers provided as part of the stand-alone JRas logging toolkit implement the
serializable interface, loggers are not serializable. Loggers are stateful objects, tied to a Java virtual
machine instance and are not serializable. Attempting to serialize a logger is a violation of the
programming model.

Personal or individual logger subclasses are not supported in a WebSphere Application Server
environment.

WebSphere Application Server handlers

WebSphere Application Server provides the appropriate handler class that is used to write message and
trace events to the WebSphere Application Server run time logs. You cannot configure the WebSphere
Application Server handler to write to any other destination. The creation of a WebSphere Application
Server handler is a restricted operation and is not available to user code. Every logger that is obtained
from the Manager comes preconfigured with an instance of this handler already installed. You can remove
the WebSphere Application Server handler from a logger when you want to run in stand-alone mode.
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When you remove it, you cannot add the WebSphere Application Server handler again to the logger from
which it is removed or any other logger. Also, you cannot directly call any method on the WebSphere
Application Server handler. Attempting to create an instance of the WebSphere Application Server handler,
to call methods on the WebSphere Application Server handler or to add a WebSphere Application Server
handler to a logger by user code is a violation of the programming model.

WebSphere Application Server formatters

The WebSphere Application Server handler comes preconfigured with the appropriate formatter for data
that is written to WebSphere Application Server logs. The creation of a WebSphere Application Server
formatter is a restricted operation and not available to user code. No mechanism exists that allows the
user to obtain a reference to a formatter installed in a WebSphere Application Server handler, or to change
the formatter a WebSphere Application Server handler is configured to use.

WebSphere Application Server manager

WebSphere Application Server provides a Manager class in the com.ibm.websphere.ras package. All
message and trace loggers must be obtained from this Manager class. A reference to the Manager class is
obtained by calling the static Manager.getManager method. Message loggers are obtained by calling the
createRASMessagelLogger method on the Manager class. Trace loggers are obtained by calling the
createRASTraceLogger method on the Manager class.

The manager also supports a group abstraction that is useful when dealing with trace loggers. The group
abstraction supports multiple, unrelated trace loggers to register as part of a named entity called a group.
WebSphere Application Server provides the appropriate systems management facilities to manipulate the
trace setting of a group, similar to the way the trace settings of an individual trace logger work.

For example, suppose component A consists of 10 classes. Suppose each class is configured to use a
separate trace logger. All 10 trace loggers in the component are registered as members of the same
group, for example, Component_A_Group. You can turn on trace for a single class, or you can turn on
trace for all 10 classes in a single operation using the group name, if you want a component trace. Group
names are maintained within the namespace for trace loggers.

JRas framework (deprecated)

Because the JRas extensions classes do not provide the flexibility and behavior that are required for many
scenarios, a variety of extension points are defined. You can write your own implementation classes to
obtain the required behavior.

Deprecated: The JRas framework described in this topic is deprecated. However, you can achieve similar
results using Java logging.

In general, the JRas extensions require you to call the Manager class to obtain a message logger or trace
logger. No provision is made for you to provide your own message or trace logger subclasses. In general,
user-provided extensions cannot be used to affect the integrated mode of operation. The behavior of the
integrated mode of operation is solely determined by the WebSphere Application Server run time and the
JRas extensions classes.

Handlers

The stand-alone JRas logging toolkit defines the RASIHandler interface. All handlers must implement this
interface. You can write your own handler classes that implement the RASIHandler interface. Directly
create instances of user-defined handlers and add them to the loggers that are obtained from the Manager
class.

The stand-alone JRas logging toolkit provides several handler implementation classes. These handler
classes are inappropriate for use in the Java 2 Platform, Enterprise Edition (J2EE) environment. You
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cannot directly use or subclass any of the Handler classes that are provided by the stand-alone JRas
logging toolkit. Doing so is a violation of the programming model.

Formatters

The stand-alone JRas logging toolkit defines the RASIFormatter interface. All formatters must implement
this interface. You can write your own formatter classes that implement the RASIFormatter interface. You
can add these classes to a user-defined handler only. WebSphere Application Server handlers cannot be
configured to use user-defined formatters. Instead, directly create instances of your formatters and add
them to the your handlers appropriately.

As with handlers, the stand-alone JRas logging toolkit provides several formatter implementation classes.
Direct use of these formatter classes is not supported.

Message event types

The stand-alone JRas toolkit defines message event types in the RASIMessageEvent interface. In
addition, the WebSphere Application Server reserves a range of message event types for future use. The
RASIMessageEvent interface defines three types, with values of 0x01, 0x02, and 0x04. The values 0x08
through 0x8000 are reserved for future use. You can provide your own message event types by extending
this interface appropriately. User-defined message types must have a value of 0x1000 or greater.

Message loggers that are retrieved from the Manager class have their message masks set to pass or
process all message event types defined in the RASIMessageEvent interface. To process user-defined
message types, you must manually set the message logger mask to the appropriate state by user code
after the message logger is obtained from the Manager class. WebSphere Application Server does not
provide any built-in systems management support for managing message types.

Message event objects

The stand-alone JRas toolkit provides a RASMessageEvent implementation class. When a message
logging method is called on the message logger, and the message type is currently enabled, the logger
creates and distributes an event of this class to all handlers that are currently registered with that logger.

You can provide your own message event classes, but they must implement the RASIEvent interface. You
must directly create instances of such user-defined message event classes. When it is created, pass your
message event to the message logger by calling the message logger's fireRASEvent method directly.
WebSphere Application Server message loggers cannot directly create instances of user-defined types in
response to calling a logging method (msg.message) on the logger. In addition, instances of user-defined
message types are never processed by the WebSphere Application Server handler. You cannot create
instances of the RASMessageEvent class directly.

Trace event types

The stand-alone JRas toolkit defines trace event types in the RASITraceEvent interface. You can provide
your own trace event types by extending this interface appropriately. In such a case, you must ensure that
the values for the user-defined trace event types do not collide with the values of the types that are
defined in the RASITraceEvent interface.

Trace loggers that are retrieved from the Manager class typically have their trace masks set to reject all
types. A different starting state can be specified by using WebSphere Application Server systems
management facilities. In addition, you can change the state of the trace mask for a logger at run-time,
using WebSphere Application Server systems management facilities.

To process user-defined trace types, the trace logger mask must be manually set to the appropriate state
by user code. WebSphere Application Server systems management facilities cannot be used to manage
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user-defined trace types, either at start time or run time.
Trace event objects

The stand-alone JRas toolkit provides a RASTraceEvent implementation class. When a trace logging
method is called on the WebSphere Application Server trace logger and the type is currently enabled, the
logger creates and distributes an event of this class to all the handlers that are currently registered with
that logger.

You can provide your own trace event classes. Such trace event classes must implement the RASIEvent
interface. You must create instances of such user-defined event classes directly. When it is created, pass
the trace event to the trace logger by calling the trace logger's fireRASEvent method directly. WebSphere
Application Server trace loggers cannot directly create instances of user-defined types in response to
calling a trace method (entry, exit, trace) on the trace logger. In addition, instances of user-defined trace
types are never processed by the WebSphere Application Server handler. You cannot create instances of
the RASTraceEvent class directly.

User defined types, user defined events and WebSphere Application Server

By definition, the WebSphere Application Server handler processed user-defined message or trace types,
or user-defined message or trace event classes. Message and trace entries of either a user-defined type
or user-defined event class cannot be written to the WebSphere Application Server run-time logs.

JRas programming interfaces for logging (deprecated):

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

General considerations

You can configure the WebSphere Application Server to use Java 2 security to restrict access to protected
resources such as the file system and sockets. Because user-written extensions typically access such
protected resources, user-written extensions must contain the appropriate security checking calls, using
AccessController doPrivileged calls. In addition, the user-written extensions must contain the appropriate
policy file. In general, locating user-written extensions in a separate package is a good practice. It is your
responsibility to restrict access to the user-written extensions appropriately.

Writing a handler

User-written handlers must implement the RASIHandler interface. The RASIHandler interface extends the
RASIMaskChangeGenerator interface, which extends the RASIObject interface. A short discussion of the
methods that are introduced by each of these interfaces follows, along with implementation pointers. For
more in-depth information on any of the particular interfaces or methods, see the corresponding product
API documentation.

RASIODbject interface

The RASIObject interface is the base interface for stand-alone JRas logging toolkit classes that are

stateful or configurable, such as loggers, handlers, and formatters.

* The stand-alone JRas logging tookit supports rudimentary properties-file based configuration. To
implement this configuration support, the configuration state is stored as a set of key-value pairs in a
properties file. The public Hashtable getConfig and public void setConfig(Hashtable ht) methods are
used to get and set the configuration state. The JRas extensions do not support properties-based
configuration. Implement these methods as no-operations. You can implement your own
properties-based configuration using these methods.
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» Loggers, handlers, and formatters can be named objects. For example, the JRas extensions require the
user to provide a name for the loggers that are retrieved from the manager. You can name your
handlers. The public String getName and public void setName(String name) methods are provided to
get or set the name field. The JRas extensions currently do not call these methods on user handlers.
You can implement these methods as you want, including as no operations.

» Loggers, handlers, and formatters can also contain a description field. The public String getDescription
and public void setDescription(String desc) methods can be used to get or set the description field. The
JRas extensions currently do not use the description field. You can implement these methods as you
want, including as no operations.

» The public String getGroup method is provided for use by the RASManager interface. Since the JRas
extensions provide their own Manager class, this method is never called. Implement this as a
no-operation.

RASIMaskChangeGenerator interface

The RASIMaskChangeGenerator interface is the interface that defines the implementation methods for
filtering of events based on a mask state. It is currently implemented by both loggers and handlers. By
definition, an object that implements this interface contains both a message mask and a trace mask,
although both need not be used. For example, message loggers contain a trace mask, but the trace mask
is never used because the message logger never generates trace events. Handlers, however, can actively
use both mask values. For example, a single handler can handle both message and trace events.
* The public long getMessageMask and public void setMessageMask(long mask) methods are used to
get or set the value of the message mask. The public long getTraceMask and public void
setTraceMask(long mask) methods are used to get or set the value of the trace mask.

In addition, this interface introduces the concept of calling back to interested parties when a mask changes

state. The callback object must implement the RASIMaskChangeListener interface.

* The public void addMaskChangeListener(RASIMaskChangelListener listener) and public void
removeMaskChangeListener(RASIMaskChangeListener listener) methods are used to add or remove
listeners to the handler. The public Enumeration getMaskChangeListeners method returns an
enumeration over the list of currently registered listeners. The public void
fireMaskChangedEvent(RASMaskChangeEvent mc) method is used to call back all the registered
listeners to inform them of a mask change event.

For efficiency reasons, the JRas extensions message and trace loggers implement the
RASIMaskChangeListener interface. The logger implementations maintain a composite mask in addition to
the logger mask. The logger composite mask is formed by logically oriing the appropriate masks of all
handlers that are registered to that logger, then and'ing the result with the logger mask. For example, the
message logger composite mask is formed by or'ing the message masks of all handlers that are registered
with that logger, then and'ing the result with the logger message mask.

All handlers are required to properly implement these methods. In addition, when a user handler is
instantiated, the logger that is added must be registered with the handler; use the addMaskChangeListener
method. When either the message mask or trace mask of the handler is changed, the logger must be
called back to inform it of the mask change. With this process, the logger can dynamically maintain the
composite mask.

The RASMaskChangedEvent class is defined by the stand-alone JRas logging toolkit. Direct use of that
class by user code is supported in this context.

In addition, the RASIMaskChangeGenerator interface introduces the concept of caching the names of all
message and trace event classes that the implementing object process. The intent of these methods is to
support a management program such as a graphical user interface to retrieve the list of names, introspect
the classes to determine the event types that they might possibly process and display the results. The
JRas extensions do not ever call these methods, so they can be implemented as no operations.
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* The public void addMessageEventClass(String name) and public void
removeMessageEventClass(String name) methodscan be called to add or remove a message event
class name from the list. The method public Enumeration getMessageEventClasses returns an
enumeration over the list of message event class names. Similarly, the public void
addTraceEventClass(String name) and public void removeTraceEventClass(String name) methods can
be called to add or remove a trace event class name from the list. The public Enumeration
getTraceEventClasses method returns an enumeration over the list of trace event class names.

RASIHandler interface
The RASIHandler interface introduces the methods that are specific to the behavior of a handler.

The RASIHandler interface, as provided by the stand-alone JRas logging toolkit, supports handlers that
run in either a synchronous or asynchronous mode. In asynchronous mode, events are typically queued by
the calling thread and then written by a worker thread. Because spawning of threads is not supported in
the WebSphere Application Server environment, it is expected that handlers do not queue or batch events,
although this activity is not expressly prohibited.

* The public int getMaximumQueueSize() and public void setMaximumQueueSize(int size) methods
create I11egalStateException exceptions to manage the maximum queue size. The public int
getQueueSize method is provided to query the actual queue size.

* The public int getRetrylnterval and public void setRetrylnterval(int interval) methods support the notion
of error retry, which implies some type of queueing.

» The public void addFormatter(RASIFormatter formatter), public void removeFormatter(RASIFormatter
formatter) and public Enumeration getFormatters methods are provided to manage the list of formatters
that the handler can be configured with. Different formatters can be provided for different event classes,
if appropriate.

* The public void openDevice, public void closeDevice and public void stop methods are provided to
manage the underlying device that the handler abstracts.

* The public void logEvent(RASIEvent event) and public void writeEvent(RASIEvent event) methods are
provided to pass events to the handler for processing.

Writing a formatter

User-written formatters must implement the RASIFormatter interface. The RASIFormatter interface extends
the RASIObject interface. The implementation of the RASIObject interface is the same for both handlers
and formatters. A short discussion of the methods that are introduced by the RASIFormatter interface
follows. For more in-depth information on the methods introduced by this interface, see the corresponding
product APl documentation.

RASIFormatter interface

» The public void setDefault(boolean flag) and public boolean isDefault methods are used by the concrete
RASHandler classes that are provided by the stand-alone JRas logging toolkit to determine if a
particular formatter is the default formatter. Because these RASHandler classes must never be used in
a WebSphere Application Server environment, the semantic significance of these methods can be
determined by the user.

* The public void addEventClass(String name), public void removeEventClass(String name) and public
Enumeration getEventClasses methods are provided to determine which event classes a formatter can
use to format. You can provide the appropriate implementations.

» The public String format(RASIEvent event) method is called by handler objects and returns a formatted
String representation of the event.

Programming model summary

The programming model that is described in this section builds upon and summarizes some of the
concepts already introduced. This section also formalizes usage requirements and restrictions. Use of the
WebSphere Application Server JRas extensions in a manner that does not conform to the following
programming guidelines is prohibited.
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Deprecated: The JRas framework described in this task and its sub-tasks is deprecated. However, you
can achieve similar results using Java logging.

You can use the WebSphere Application Server JRas extensions in three distinct operational modes. The

programming models concepts and restrictions apply equally across all modes of operation.

* You must not use implementation classes that are provided by the stand-alone JRas logging toolkit
directly, unless specifically noted otherwise. Direct usage of those classes is not supported. IBM
Support provides no diagnostic aid or bug fixes relating to the direct use of classes that are provided by
the stand-alone JRas logging toolkit.

* You must obtain message and trace loggers directly from the Manager class. You cannot directly
instantiate loggers.

* You cannot replace the WebSphere Application Server message and trace logger classes.

* You must guarantee that the logger names that are passed to the Manager class are unique, and follow
the documented naming constraints. When a logger is obtained from the Manager class, you must not
attempt to change the name of the logger by calling the setName method.

* Named loggers can be used more than once. For any given name, the first call to the Manager class
results in the Manager class creating a logger that is associated with that name. Subsequent calls to the
Manager class that specify the same name result in a returned reference to the existing logger.

* The Manager class maintains a hierarchical namespace for loggers. Use a dot-separated, fully qualified
class name to identify any logger. Other than dots or periods, logger names cannot contain any
punctuation characters, such as an asterisk (*), a comma (.), an equals sign (=), a colon (:), or quotes.

» Group names must comply with the same naming restrictions as logger names.

* The loggers returned from the Manager class are subclasses of the RASMessagelogger and the
RASTraceLogger classes that are provided by the stand-alone JRas logging toolkit. You can call any
public method that is defined by the RASMessagelLogger and RASTraceLogger classes. You cannot call
any public method that is introduced by the provided subclasses.

» If you want to operate in either stand-alone or combined mode, you must provide your own Handler
and Formatter subclasses. You cannot use the Handler and Formatter classes that are provided by the
stand-alone JRas logging toolkit. User written handlers and formatters must conform to the documented
guidelines.

» Loggers that are obtained from the Manager class come with a WebSphere Application Server handler
installed. This handler writes message and trace records to logs that are defined by the WebSphere
Application Server run time. Manage these logs using the provided systems management interfaces.

*  You can programmatically add and remove user-defined handlers from a logger at any time. Multiple
additions and removals of user defined handlers are supported. You are responsible for creating an
instance of the handler to add, configuring the handler by setting the handler mask value and formatter
appropriately, then adding the handler to the logger using the addHandler method. You are responsible
for programmatically updating the masks of user-defined handlers, as appropriate.

*  You might get a reference to the handler that is installed within a logger by calling the getHandlers
method on the logger and processing the results. You must not call any methods on the handler that are
obtained in this way. You can remove the WebSphere Application Server handler from the logger by
calling the logger removeHandler method, passing in the reference to the WebSphere Application
Server handler. When removed, the WebSphere Application Server handler cannot be added again to
the logger.

* You can define your own message type. The behavior of user-defined message types and restrictions
on their definitions is discussed in|[Extending the JRas framework!

* You can define your own message event classes. The use of user-defined message event classes is
discussed in [Extending the JRas framework}

* You can define your own trace types. The behavior of user-defined trace types and restrictions on your
definitions is discussed in [Extending the JRas framework.

* You can define your own trace event classes. The use of user-defined trace event classes is discussed
in [Extending the JRas framework}

*  You must programmatically maintain the bits in the message and trace logger masks that correspond to
any user-defined types. If WebSphere Application Server facilities are used to manage the predefined
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types, these updates must not modify the state of any of the bits that correspond to those types. If you
are assuming ownership responsibility for the predefined types, then you can change all bits of the
masks.

JRas messages and trace event types

The basic JRas message and event types are not the same as those natively recognized by WebSphere
Application Server, so the JRas types are mapped onto the types that are native to the runtime
environment. You can control the way JRas message and trace events are processed using custom filters
and message controls.

Event types

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

The base message and trace event types that are defined by the stand-alone JRas logging toolkit are not
the same as the native types that are recognized by the WebSphere Application Server run-time. Instead,
the basic JRas types are mapped onto the native types. This mapping can vary by platform or edition. The
mapping is discussed in the following section.

Platform message event types

The message event types that are recognized and processed by the WebSphere Application Server
runtime are defined in the RASIMessageEvent interface that is provided by the stand-alone JRas logging
toolkit.

Table 8. Platform message event types. These message types are mapped onto the native message types, as
follows.

WebSphere Application Server native type JRas RASIMessageEvent type
Audit TYPE_INFO, TYPE_INFORMATION
Warning TYPE_WARN, TYPE_WARNING
Error TYPE_ERR, TYPE_ERROR

Application developers can use JRas to issue an MVS™ WTO (write to operator) message by using a
JRas RASIMessageEvent type of TYPE_INFO or TYPE_INFORMATION to issue a WebSphere Application
Server for z/OS Audit trace. A WebSphere Application Server for z/OS Audit trace maps to an MVS route
code 11 WTO (hardcopy WTO).

Platform trace event types

The trace event types that are recognized and processed by the WebSphere Application Server run time
are defined in the RASITraceEvent interface that is provided by the stand-alone JRas logging toolkit. The
RASITraceEvent interface provides a rich and complex set of types. This interface defines both a simple
set of levels, as well as a set of enumerated types.

» For a user who prefers a simple set of levels, the RASITraceEvent interface provides TYPE LEVELI,
TYPE_LEVEL2, and TYPE_LEVEL3. The implementations provide support for this set of levels. The levels
are hierarchical, enabling level 2 also enables level 1, enabling level 3 also enables levels 1 and 2.

» For users who prefer a more complex set of values that can be OR'd together, the RASITraceEvent
interface provides TYPE_API, TYPE_CALLBACK, TYPE_ENTRY_EXIT, TYPE_ERROR_EXC, TYPE_MISC_DATA,
TYPE_OBJ_CREATE, TYPE 0BJ DELETE, TYPE PRIVATE, TYPE PUBLIC, TYPE STATIC, and TYPE_SVC.

The trace event types are mapped onto the native trace types as follows:
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Table 9. WebSphere Application Server native types and JRas RASITraceEvent level types. Mapping WebSphere
Application Server trace types to the JRas RASITraceEvent level types.

WebSphere Application Server native type JRas RASITraceEvent level type
Event TYPE_LEVELA
EntryExit TYPE_LEVEL2
Debug TYPE_LEVEL3

Table 10. WebSphere Application Server native types and JRas RASITraceEvent enumerated types. Mapping
WebSphere Application Server trace types to the JRas RASITraceEvent enumerated types.

WebSphere Application Server native type JRas RASITraceEvent enumerated types

Event TYPE_ERROR_EXC, TYPE_SVC, TYPE_OBJ_CREATE,
TYPE_OBJ_DELETE

EntryExit TYPE_ENTRY_EXIT, TYPE_API, TYPE_CALLBACK,
TYPE_PRIVATE, TYPE_PUBLIC, TYPE_STATIC

Debug TYPE_MISC_DATA

For simplicity, it is recommended that one or the other of the tracing type methodologies is used
consistently throughout the application. If you decide to use the non-level types, choose one type from
each category and use those types consistently throughout the application, to avoid confusion.

Message and trace parameters

The various message logging and trace method signatures accept the Object, Object[] and Throwable
parameter types. WebSphere Application Server processes and formats the various parameter types as
follows:

Primitives

Primitives, such as int and long are not recognized as subclasses of Object type and cannot be

directly passed to one of these methods. A primitive value must be transformed to a proper Object

type (Integer, Long) before passing as a parameter.
Object

The toString method is called on the object and the resulting String is displayed. Implement the

toString method appropriately for any object that is passed to a message logging or trace method.

It is the responsibility of the caller to guarantee that the toString method does not display

confidential data such as passwords in clear text, and does not cause infinite recursion.

Object[]

The Object[] type is provided for the case when more than one parameter is passed to a message

logging or trace method. The toString method is called on each Object in the array. Nested arrays

are not handled, that is none of the elements in the Object array belong in an array.
Throwable

The stack trace of the Throwable type is retrieved and displayed.
Array of primitives

An array of primitive, for example, byte[], int[], is recognized as an Object, but is loosely

associated by Java code. In general, avoid arrays of primitives, if possible. If arrays of primitives

are passed, the results are indeterminate and can change, depending on the type of array passed,
the API used to pass the array, and the release of the product. For consistent results, user code
needs to preprocess and format the primitive array into some type of String form before passing it
to the method. If such preprocessing is not performed, the following problems can result:

+ [B@924586a0b - This message is deciphered as a byte array at location X. This message is
typically returned when an array is passed as a member of an Object|[] type and results from
calling the toString method on the byte[] type.

 lllegal trace argument : array of long. This response is typically returned when an array of
primitives is passed to a method taking an Object.
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* 01040703: The hex representation of an array of bytes. Typically this problem can occur when a
byte array is passed to a method taking a single Object. This behavior is subject to change and
cannot be relied on.

+ "1" "2": The String representation of the members of an int[] type formed by converting each
element to an integer and calling the toString method on the integers. This behavior is subject
to change and cannot be relied on.

* [Ljava.lang.Object; @9136fa0b : An array of objects. Typically this response is seen when an
array containing nested arrays is passed.

Controlling message logging

Writing a message to a WebSphere Application Server log requires that the message type passes three

levels of filtering or screening:

1. The message event type must be one of the message event types that is defined in the
RASIMessageEvent interface.

2. Logging of that message event type must be enabled by the state of the message logger mask.

3. The message event type must pass any filtering criteria that is established by the WebSphere
Application Server run-time.

When a WebSphere Application Server logger is obtained from the Manager class, the initial setting of the
mask forwards all native message event types to the WebSphere Application Server handler. It is possible
to control what messages get logged by programmatically setting the state of the message logger mask.

Some editions of the product support user specified message filter levels for a server process. When such
a filter level is set, only messages at the specified severity levels are written to WebSphere Application
Server. Message types that pass the mask check of the message logger can be filtered out by WebSphere
Application Server.

Control tracing

Each edition of the product provides a mechanism for enabling or disabling trace. The various editions can
support static trace enablement (trace settings are specified before the server is started), dynamic trace
enablement (trace settings for a running server process can be dynamically modified), or both.

Writing a trace record to a WebSphere Application Server requires that the trace type passes three levels

of filtering or screening:

1. The trace event type must be one of the trace event types that is defined in the RASITraceEvent
interface.

2. Logging of that trace event type must be enabled by the state of the trace logger mask.

3. The trace event type must pass any filtering criteria that is established by the WebSphere Application
Server run-time.

When a logger is obtained from the Manager class, the initial setting of the mask is to suppress all trace
types. The exception to this rule is the case where the WebSphere Application Server run time supports
static trace enablement and a non-default startup trace state for that trace logger is specified. Unlike
message loggers, the WebSphere Application Server can dynamically modify the trace mask state of a
trace logger. WebSphere Application Server only modifies the portion of the trace logger mask that
corresponds to the values that are defined in the RASITraceEvent interface. WebSphere Application
Server does not modify undefined bits of the mask that might be in use for user-defined types.

When the dynamic trace enablement feature that is available on some platforms is used, the trace state
change is reflected both in the application server run time and the trace mask of the trace logger. If user
code programmatically changes the bits in the trace mask corresponding to the values that are defined by
in the RASITraceEvent interface, the mask state of the trace logger and the run time state become
unsynchronized and unexpected results occur. Therefore, programmatically changing the bits of the mask
corresponding to the values that are defined in the RASITraceEvent interface is not supported.
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Instrumenting an application with JRas extensions
You can create an application using JRas extensions.

Before you begin

The JRas framework that is described in this task and its sub-tasks is deprecated. However, you can
achieve similar results using Java logging.

About this task

To create an application using the WebSphere Application Server JRas extensions, perform the following
steps:

Procedure
1. Determine the mode for the extensions: integrated, stand-alone, or combined.

2. If the extensions are used in either stand-alone or combined mode, create the necessary handler and
formatter classes.

3. If localized messages are used by the application, create a resource bundle.

4. In the application code, get a reference to the Manager class and create the manager and logger
instances.

5. Insert the appropriate message and trace logging statements in the application.

Creating JRas resource bundles and message files

The WebSphere Application Server message logger provides the message and msg methods so the user
can log localized messages. In addition, the message logger provides the textMessage method to log
messages that are not localized. Applications can use either or both, as appropriate.

Before you begin

The JRas framework that is described in this task and its sub-tasks is deprecated. However, you can
achieve similar results using Java logging.

About this task

The mechanism for providing localized messages is the resource bundle support that is provided by the
IBM Developer Kit, Java Technology Edition. If you are not familiar with resource bundles as implemented
by the Developer Kit, you can get more information from various texts, or by reading the API
documentation for the java.util. ResourceBundle, java.util.ListResourceBundle and
java.util.PropertyResourceBundle classes, as well as the java.text.MessageFormat class.

The PropertyResourceBundle class is the preferred mechanism to use. In addition, note that the JRas
extensions do not support the extended formatting options such as {1, date} or {0, number, integer} that
are provided by the MessageFormat class.

You can forward messages that are written to the internal WebSphere Application Server logs to other
processes for display. For example, messages that are displayed on the administrative console, which can
be running in a different location than the server process, can be localized using the /ate binding process.
Late binding means that WebSphere Application Server does not localize messages when they are logged,
but defers localization to the process that displays the message.

To properly localize the message, the displaying process must have access to the resource bundle where
the message text is stored. You must package the resource bundle separately from the application, and
install it in a location where the viewing process can access it. If you do not want to take these steps, you
can use the early binding technique to localize messages as they are logged.
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The two techniques are described as follows:
Early binding

The application must localize the message before logging it. The application looks up the localized
text in the resource bundle and formats the message. When formatting is complete, the application
logs the message using the textMessage method. Use this technique to package the application
resource bundles with the application.

Late binding

The application can choose to have the WebSphere Application Server run time localize the
message in the process where it displays. Using this technique, the resource bundles are
packaged in a stand-alone . jar file, separately from the application. You must then install the
resource bundle . jar file on every machine in the installation from which an administrative console
or log viewing program might be run. You must install the .jar file in a directory that is part of the
extensions class path. In addition, if you forward logs to IBM service, you must also forward the
.Jjar file that contains the resource bundles.

To create a resource bundle, perform the following steps.

Procedure

1.

5.

Create a text properties file that lists message keys and the corresponding messages. The properties

file must have the following characteristics:

» Each property in the file is terminated with a line-termination character.

 If a line contains only white space, or if the first non-white space character of the line is the number
sign symbol (#) or exclamation mark (!), the line is ignored. The # and ! characters can therefore be
used to put comments into the file.

* Each line in the file, unless it is a comment or consists only of white space, denotes a single
property. A backslash (\) is treated as the line-continuation character.

* The syntax for a property file consists of a key, a separator, and an element. Valid separators
include the equal sign (=), colon (:), and white space ().

* The key consists of all characters on the line from the first non-white space character to the first
separator. Separator characters can be included in the key by escaping them with a backslash (\),
but using this approach is not recommended because escaping characters is error prone and
confusing. Instead, use a valid separator character that does not display in any keys in the
properties file.

* White space after the key and separator is ignored until the first non-white space character is
encountered. All characters that remain before the line-termination character define the element.

See the Java documentation for the java.util.Properties class for a full description of the syntax and
construction of properties files.

Translate the file into localized versions of the file with language-specific file names for example, the
DefaultMessages.properties file can be translated into DefaultMessages_de.properties for German
and DefaultMessages ja.properties for Japanese.

When the translated resource bundles are available, write them to a system-managed persistent
storage medium. Resource bundles are used to convert the messages into the requested national
language and locale.

When a message logger is obtained from the JRas manager, configure the logger to use a particular
resource bundle. Messages logged through the message API use this resource bundle when message
localization is performed. At run time, the user's locale setting is used to determine the properties file
from which to extract the message that is specified by a message key, ensuring that the message is

delivered in the correct language.

If the message loggers msg method is called, explicitly identify a resource bundle name.

What to do next

The application locates the resource bundle based on the file location relative to any directory in the class
path. For instance, if the DefaultMessages.properties property resource bundle is in the
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baseDir/subDirl/subDir2/resources directory and baseDir is in the class path, the name
subdiri.subdir2.resources.DefaultMessage is passed to the message logger to identify the resource
bundle.

JRas resource bundles:

You can create resource bundles in several ways. The best and easiest way is to create a properties file
that supports a PropertiesResourceBundle resource bundle. This sample shows how to create such a
properties file.

Resource bundle sample

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

For this sample, four localizable messages are provided. The properties file is created and the key-value
pairs are inserted into it. All the normal properties files conventions and rules apply to this file. In addition,
the creator must be aware of other restrictions that are imposed on the values by the Java
MessageFormat class. For example, apostrophes must be escaped or they cause a problem. Avoid the
use of non-portable characters. WebSphere Application Server does not support the use of extended
formatting conventions that the MessageFormat class supports, such as {1, date} or {0, number, integer}.

Assume that the base directory for the application that uses this resource bundle is baseDir and that this
directory is in the class path. Assume that the properties file is stored in the subdirectory baseDir that is
not in the class path (baseDir/subDir1/subDir2/resources). To allow the messages file to resolve, the
subDir1.subDir2.resources.DefaultMessage name is used to identify the PropertyResourceBundle resource
bundle and is passed to the message logger.

For this sample, the properties file is named DefaultMessages.properties:

# Contents of the DefaultMessages.properties file

MSG_KEY_00=A message with no substitution parameters.

MSG_KEY_01=A message with one substitution parameter: parml={0}

MSG_KEY_02=A message with two substitution parameters: parml={0}, parm2 = {1}
MSG_KEY_03=A message with three substitution parameters: parml={0}, parm2 = {1}, parm3={2}

When the DefaultMessages.properties file is created, the file can be sent to a translation center where
the localized versions are generated.

JRas manager and logger instances

You can use the JRas extensions in integrated, stand-alone, or combined mode. Configuration of the
application varies depending on the mode of operation, but use of the loggers to log message or trace
entries is identical in all modes of operation.

Deprecated: The JRas framework described in this task and its sub-tasks is deprecated. However, you
can achieve similar results using Java logging.

Integrated mode is the default mode of operation. In this mode, message and trace events are sent to the
WebSphere Application Server logs.

In the combined mode, message and trace events are logged to both WebSphere Application Server and
user-defined logs.

In the stand-alone mode, message and trace events are logged only to user-defined logs.
Using the message and trace loggers

Regardless of the mode of operation, the use of message and trace loggers is the same.
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Using a message logger

The message logger is configured to use the DefaultMessages resource bundle. Message keys must be
passed to the message loggers if the loggers are using the message API.
msgLogger.message (RASIMessageEvent.TYPE_WARNING, this,

methodName, "MSG_KEY 00");

. msglLogger.message (RASIMessageEvent.TYPE_WARN, this,
methodName, "MSG_KEY_ 01", "some string");

If message loggers use the msg API, you can specify a new resource bundle name.

msgLogger.msg (RASIMessageEvent.TYPE_ERR, this, methodName,
"ALT_MSG_KEY_00", "alternateMessageFile");

You can also log a text message. If you are using the textMessage API, no message formatting is done.

msgLogger.textMessage (RASIMessageEvent.TYPE_INFO, this, methodName,"String and Integer",
"A String", new Integer(5));

Using a trace logger

Because trace is normally disabled, guard trace methods for performance reasons.

private void methodX(int x, String y, Foo z)
{

// trace an entry point. Use the guard to make sure tracing is enabled.
Do this checking before you gather parameters to trace.
if (trcLogger.isLoggable(RASITraceEvent.TYPE_ENTRY_EXIT) {
// 1 want to trace three parameters, package them up in an Object[]
Object[] parms = {new Integer(x), y, z};
trcLogger.entry(RASITraceEvent.TYPE_ENTRY_EXIT, this, "methodX", parms);
}

. logic

// a debug or verbose trace point

if (trcLogger.isLoggable(RASITraceEvent.TYPE_MISC DATA) {
trcLogger.trace(RASITraceEvent.TYPE_MISC DATA, this, "methodX" "reached here");

}

// Another classification of trace event. An important state change is
detected, so a different trace type is used.
if (trcLogger.isLoggable(RASITraceEvent.TYPE_SVC) {
trcLogger.trace(RASITraceEvent.TYPE_SVC, this, "methodX", "an important event");

}

// ready to exit method, trace. No return value to trace
if (trcLogger.isLoggable(RASITraceEvent.TYPE_ENTRY_EXIT)) {
trcLogger.exit(RASITraceEvent.TYPE_ENTRY_EXIT, this, "methodX");
}
1

Setting up for integrated JRas operation

Use JRas operations in integrated mode to send trace events and logging messages to only WebSphere
Application Server logs.

Before you begin

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

About this task

In the integrated mode of operation, message and trace events are sent to WebSphere Application Server
logs. This approach is the default mode of operation.
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Procedure

1.

Import the requisite JRas extensions classes:

import com.ibm.ras.*;
import com.ibm.websphere.ras.x*;

Declare logger references:

private RASMessagelogger msgLogger = null;
private RASTracelLogger trcLogger = null;

Obtain a reference to the Manager class and create the loggers. Because loggers are named
singletons, you can do this activity in a variety of places. One logical candidate for enterprise beans is
the ejbCreate method. For example, for the myTestBean enterprise bean, place the following code in
the ejbCreate method:

com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();
msglLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());

// Configure the message logger to use the message file that is created

// for this application.

msgLogger.setMessageFile("acme.widgets.DefaultMessages");

trcLogger = mgr.createRASTraceLogger("Acme", "Widgets", "RasTest",
myTestBean.class.getName());

mgr.addLoggerToGroup (trcLogger, groupName);

Setting up for combined JRas operation
Use JRas operation in combined mode to output trace data and logging messages to both WebSphere
Application Server and user-defined logs.

Before you begin

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

About this task

In combined mode, messages and trace are logged to both WebSphere Application Server logs and
user-defined logs. The following sample assumes that:

* You wrote a user-defined handler named SimpleFileHandler and a user-defined formatter named

SimpleFormatter.

* You are not using user-defined types or events.

Procedure

1.

Import the requisite JRas extensions classes:

import com.ibm.ras.*;
import com.ibm.websphere.ras.*;

Import the user handler and formatter:
import com.ibm.ws.ras.test.user.*;
Declare the logger references:

private RASMessagelogger msglLogger = null;

private RASTracelLogger trclLogger = null;
Obtain a reference to the Manager class, create the loggers, and add the user handlers. Because
loggers are named singletons, you can obtain a reference to the loggers in a number of places. One
logical candidate for enterprise beans is the ejpCreate method. Make sure that multiple instances of
the same user handler are not accidentally inserted into the same logger. Your initialization code must
support this approach. The following sample is a message logger sample. The procedure for a trace
logger is similar.
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com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();
msglLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());
// Configure the message logger to use the message file defined
// in the ResourceBundle sample.
msgLogger.setMessageFile("acme.widgets.DefaultMessages");

// Create the user handler and formatter. Configure the formatter,

// then add it to the handler.

RASIHandler handler = new SimpleFileHandler("myHandler", "FileName");
RASIFormatter formatter = new SimpleFormatter("simple formatter");
formatter.addEventClass("com.ibm.ras.RASMessageEvent");
handler.addFormatter(formatter);

// Add the Handler to the logger. Add the Togger to the Tist of the
//handlers listeners, then set the handlers

// mask, which updates the loggers composite mask appropriately.

// WARNING - there is an order dependency here that must be followed.
msgLogger.addHandler (handler);
handler.addMaskChangeListener(msgLogger);

handler.setMessageMask (RASIMessageEvent.DEFAULT_MESSAGE_MASK) ;

Setting up for stand-alone JRas operation
You can configure JRas operations to output trace data and logging messages to only user-defined
locations.

Before you begin

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

About this task

In stand-alone mode, messages and traces are logged only to user-defined logs. The following sample
assumes that:

* You have a user-defined handler named SimpleFileHandler and a user-defined formatter named
SimpleFormatter.

* You are not using user-defined types of events.

Procedure
1. Import the requisite JRas extensions classes:

import com.ibm.ras.*;
import com.ibm.websphere.ras.x*;

2. Import the user handler and formatter:
import com.ibm.ws.ras.test.user.*;
3. Declare the logger references:

private RASMessagelLogger msgLogger = null;
private RASTracelLogger trcLogger = null;

4. Obtain a reference to the Manager class, create the loggers, and add the user handlers. Because
loggers are named singletons, you can obtain a reference to the loggers in a number of places. One
logical candidate for enterprise beans is the ejbCreate method. Make sure that multiple instances of
the same user handler are not accidentally inserted into the same logger. Your initialization code must
support this approach. The following sample is a message logger sample. The procedure for a trace
logger is similar.
com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();

msgLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",

myTestBean.class.getName());
// Configure the message logger to use the message file that is defined in
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//the ResourceBundle sample.
msglLogger.setMessageFile("acme.widgets.DefaultMessages");

// Get a reference to the Handler and remove it from the logger.
RASIHandler aHandler = null;
Enumeration enum = msglLogger.getHandlers();
while (enum.hasMoreElements()) {
aHandler = (RASIHandler)enum.nextElement();
if (aHandler instanceof WsHandler)
msgLogger.removeHandler(wsHandler) ;

}

// Create the user handler and formatter. Configure the formatter,

// then add it to the handler.

RASIHandler handler = new SimpleFileHandler("myHandler", "FileName");
RASIFormatter formatter = new SimpleFormatter("simple formatter");
formatter.addEventClass("com.ibm.ras.RASMessageEvent");
handler.addFormatter(formatter);

// Add the Handler to the logger. Add the Togger to the list of the
// handlers listeners, then set the handlers

// mask, which will update the Toggers composite mask appropriately.
// WARNING - there is an order dependency here that must be followed.
msgLogger.addHandler(handler);
handler.addMaskChangeListener(msglLogger);

handler.setMessageMask (RASIMessageEvent.DEFAULT MESSAGE_MASK) ;

Logging messages and trace data for Java server applications

By using the WebSphere Application Server for z/OS support for logging application messages and trace
data, you can improve the reliability, availability, and serviceability of any Java application that runs in a
WebSphere Application Server for z/OS server.

About this task

Through this support, your Java application's messages can appear on the MVS master console, in the
error log stream, or in the component trace (CTRACE) data set for WebSphere Application Server for
z/OS. Your application's trace entries can appear in the same CTRACE data set.

Procedure

1. Determine where to issue the log messages. Read ['Message location best practices’] for tips on which
tools to use.

2. Configure logging in the MVS master console, the error log stream, or the CTRACE data set.

Message location best practices
Use this information for configuring messaging locations.

You might want to issue messages to the MVS master console to report serious error conditions for
mission-critical applications. Through the master console, an operator can receive and, if necessary, take
action in response to a message that indicates the status of an application. In addition, by directing
messages to the master console, you can trigger automation packages to take action for specific
conditions or events related to your application's processing.

Any messages that your application issues to the console also appear in either the error log stream or the
CTRACE data set for WebSphere Application Server for z/OS, depending on the message type. Logging
the messages in these system resources can help you more easily diagnose errors related to your
application's processing. Similarly, issuing requests to log trace data in the CTRACE data set is another
method of recording error conditions or collecting application data for diagnostic purposes.
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Automation-geared messages

Table 11. Messages that can help with automation. The table lists the messages that can help with automation.

Message ID Message text

BBOOO0001I WEBSPHERE FOR Z/OS CONTROL PROCESS %5/%5/%s/%s 1S STARTING.

BBOO0002| WEBSPHERE FOR Z/OS CONTROL PROCESS %s ENDED NORMALLY. .

BBOOO003E WEBSPHERE FOR Z/OS CONTROL PROCESS %s ENDED ABNORMALLY,
REASON=%X.

BBOO0004| WEBSPHERE FOR Z/OS SERVANT PROCESS %5/%s/%s/%s IS STARTING.

BBOOO0005I WEBSPHERE FOR Z/OS SERVANT PROCESS %s ENDED NORMALLY.

BBOOO006E WEBSPHERE FOR Z/OS PROCESS %s ENDED ABNORMALLY, REASON=%X.

BBOOO0007I WEBSPHERE FOR Z/OS DAEMON %s/%S/%Ss/%s IS STARTING.

BBOOO0008I WEBSPHERE FOR Z/OS DAEMON %s ENDED NORMALLY.

BBOOO0009E WEBSPHERE FOR Z/OS DAEMON %s ENDED ABNORMALLY, REASON=%X.

BBOOO0015I INITIALIZATION COMPLETE FOR DAEMON %s.

BBOOO0019I INITIALIZATION COMPLETE FOR WEBSPHERE FOR Z/OS CONTROL PROCESS %s.

BBOO0020I INITIALIZATION COMPLETE FOR WEBSPHERE FOR Z/OS SERVANT PROCESS %s.

BBOO0035W TERMINATING THE CURRENT PROCESS, REASON=%08X.

BBOO0048W WEBSPHERE FOR Z/OS COMPONENT TRACE MAY HAVE LOST ENTRIES.

BBOO0057W AUTOMATIC RESTART MANAGER (IXCARM) SERVICE '%s' WARNING/FAILURE,
RC=%X REASON=%X.

BBOOO0093E WEBSPHERE FOR Z/OS DAEMON NOT FOUND BY SERVER %s.

BBOOO0095E WEBSPHERE FOR Z/OS DAEMON FAILED TO INITIALIZE BECAUSE ANOTHER
DAEMON WAS STARTING.

BBOOO0O100E WEBSPHERE FOR Z/OS CONTROL PROCESS %s FAILED TO INITIALIZE BECAUSE
ANOTHER CONTROL PROCESS OF THE SAME NAME WAS STARTING

BBOOO101E WEBSPHERE FOR Z/OS CONTROL PROCESS %s FAILED TO INITIALIZE BECAUSE
ANOTHER CONTROL PROCESS OF THE SAME NAME WAS ACTIVE.

BBOOO0102W WEBSPHERE FOR Z/OS UNEXPECTED DELAY WAITING FOR START OF SERVER %s.

BBOO0103W WEBSPHERE FOR Z/OS WAITING FOR START OF SERVER %s, SECOND WARNING.

BBOOO0O104E WEBSPHERE FOR Z/OS WAITING FOR START OF SERVER %s HAS TIMED OUT.

BBOO0128E WEBSPHERE FOR Z/OS UNABLE TO LOCATE RRS BBOO0131W ERROR
ENCOUNTERED DURING DAEMON ATTEMPT TO STOP SERVER %s.

BBOOO0136E UNABLE TO START SERVER %s BECAUSE WEBSPHERE FOR Z/OS DAEMON IS
STOPPING

BBOO0138W WEBSPHERE FOR Z/OS UNEXPECTED DELAY WAITING FOR STOP OF SERVER %s.

BBOO0139W WEBSPHERE FOR Z/OS WAITING FOR STOP OF SERVER %s, SECOND WARNING.

BBOOO0140E WEBSPHERE FOR Z/OS WAITING FOR STOP OF SERVER %s HAS TIMED OUT.

BBOOO0144| ARM DETECTED A FAILURE AND IS RESTARTING THIS SERVER

BBOOO0145E . ARM REGISTRATION FAILED - ARM COUPLE DATASET FULL

BBOOO0146| ARM REGISTRATION FAILED - ARM DETECTED A DUPLICATE NAME

BBOO01471 ARM READY FAILED - ARM TIMEOUT EXCEEDED

BBOOO0150E COMMAND IGNORED, STOP COMMAND ALREADY ISSUED FOR SERVER %s

BBOOO0O151E COMMAND IGNORED, MODIFY CANCEL COMMAND ALREADY ISSUED FOR SERVER

%S
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Table 11. Messages that can help with automation (continued). The table lists the messages that can help with

automation.

Message ID Message text

BBOOO0165E ARM REGISTRATION FAILED - TIMEOUT

BBOOO0172I WEBSPHERE FOR Z/OS SERVANT PROCESS %s NOT STARTING ON CONFIGURED
SYSTEM %s

BBOO0173lI SERVER %s/%s ACTIVE ON %s AT LEVEL %s%s

BBOO0228E WEBSPHERE FOR Z/OS SERVER FAILED BECAUSE DAEMON GROUP %s IS NOT
ACTIVE.

BBO00236I UNIX SYSTEM SERVICES SHUTDOWN INITIATED. ISSUING STOP TO DAEMON %s.

BBO0O0237I WEBSPHERE FOR Z/OS DAEMON %s/%s/%s IS STARTING.

BBO00238I WEBSPHERE FOR Z/OS CONTROL PROCESS %s/%s/%s IS STARTING

BBOO0239I WEBSPHERE FOR Z/OS SERVANT PROCESS %s/%s/%s IS STARTING.

BBOO0242E %s STARTUP IS DELAYED, WAITING FOR INFORMATION FROM GRS.

BBO0O0246l INITIALIZATION COMPLETE FOR DAEMON %S/%S/%S/%s.

BBO00247I INITIALIZATION COMPLETE FOR WEBSPHERE FOR Z/OS CONTROL PROCESS
%5/%S/%S/%s.

BBO00248I INITIALIZATION COMPLETE FOR WEBSPHERE FOR Z/OS SERVANT PROCESS
%S/%S/%S/%s.

BBOO02771 WEBSPHERE FOR Z/OS MULTI-PRODUCT PTF POST INSTALLER STARTING.

BBOO0278I WEBSPHERE FOR Z/OS MULTI-PRODUCT PTF POST INSTALLER ENDED NORMALLY.

BBOO0279W POST INSTALLER ENCOUNTERED WARNING(S) WHILE APPLYING SERVICE. REPLY
'‘CONTINUE' OR 'CANCEL"'

BBOOO0285A CONFIGURED ROOT SERVICE LEVEL CHECK FAILED REPLY 'CONTINUE' OR
'CANCEL'

BBOOO0286A BACKWARDS INCOMPATIBLE POST INSTALL ACTION(S) PENDING. NOTE FOR
UNINSTALL. REPLY 'CONTINUE' OR 'CANCEL

BBOO0287A SERVER IS STARTING OUT OF PLACE AT MIXED PTF LEVELS. REPLY 'CONTINUE' OR
'CANCEL'

BBOO0288I WEBSPHERE FOR Z/OS ADJUNCT PROCESS %s5/%s/%s/%s IS STARTING.

BBO0O0289I WEBSPHERE FOR Z/0OS ADJUNCT PROCESS %s ENDED NORMALLY.

BBOO0290E WEBSPHERE FOR Z/OS ADJUNCT PROCESS %s ENDED ABNORMALLY, REASON=%X.

BBOO0291I INITIALIZATION COMPLETE FOR WEBSPHERE FOR Z/OS ADJUNCT PROCESS %s.

BBO0O0292I INITIALIZATION COMPLETE FOR WEBSPHERE FOR Z/OS ADJUNCT PROCESS
%S/%S/%S/%sS.

BBOO0293I WEBSPHERE FOR Z/OS ADJUNCT PROCESS %s/%s/%s IS STARTING.

BBO0O0294I WEBSPHERE FOR Z/OS CONTROL PROCESS %s RESTART ISSUED, RC =%X.

BBOO0297A SERVER %s/%s/%s HAD NO SERVANTS AND IS REJECTING WORK. REPLY
'CONTINUE' TO ACCEPT WORK.

BBOO0298E SERVER %s/%s/%s IS CURRENTLY MODIFYING COMMUNICATION LISTENERS. THE
%s MODIFY OPTION IS NOT ALLOWED AT THIS TIME.

BBOO0299I SERVER %s/%s/%s HAS NO SERVANTS. WORK IS BEING REJECTED.

BBOOO0300I SERVER %s/%s/%s HAS DETECTED SERVANT(S). WORK IS NO LONGER BEING
REJECTED.

BBOOO0301E SERVER %s/%s/%s HAS NO SERVANTS. SERVER HAS FAILED A NUMBER OF

ATTEMPTS TO MODIFY ITSELF TO REJECT WORK.
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Table 11. Messages that can help with automation (continued). The table lists the messages that can help with
automation.

Message ID Message text

BBOO0323I MAXIMUM CONFIGURED NUMBER OF CONNECTIONS %d FOR HOSTNAME/IP: %s
PORT: %d REACHED. NEW CONNECTIONS MAY NOT BE ACCEPTED.

System performance when logging messages and trace data

Using message logging and trace data can affect system performance depending on your system
configuration.

You can select the amount and types of trace data to be collected, which provides you with the ability to
either run your application with minimal tracing when performance is a priority, or run your application with
detailed tracing when you need to recreate a problem and collect additional diagnostic information.

The error log stream, the CTRACE data set for WebSphere Application Server for z/OS, and the master
console are primarily intended for monitoring or recording diagnostic data for system components and
critical applications. Depending on your installation's configuration, directing application messages and
data to these resources might have an adverse affect on system performance. For example, if you send
application data to the CTRACE data set, trace entries in that data set might wrap more quickly, which
means you might lose some critical diagnostic data because the system writes new entries over existing
ones when wrapping occurs. Use this logging support judiciously.

Note: You can only use WebSphere Application Server for z/OS support for logging messages and trace
data for Java applications, not for Java applets.

Issuing application messages in the MVS master console

With the WebSphere Application Server for z/OS reliability, availability, and serviceability support for Java
(JRas) framework, you can issue messages from your Java application to the MVS master console. You
might want to issue messages to the master console to report serious error conditions for mission-critical
applications, or to trigger automation packages.

Before you begin

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

The messages your application issues also appear in either the error log stream or the component trace
(CTRACE) data set that WebSphere Application Server for z/OS uses.

Logging the messages is another method of recording error conditions or collecting application data for
diagnostic purposes.

About this task

WebSphere Application Server for z/OS provides code that creates and manages a message logger, which
processes your application's messages. WebSphere Application Server for z/OS creates only one
message logger for each unique organization, product, or component, so that you can more easily identify
the messages recorded in the error log stream or CTRACE data set for a specific application. The
message logger runs in the Java virtual machine (JVM) for the WebSphere Application Server for z/OS
server in which your Java application will run.

To use a message logger, in your Java application:
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Procedure

1. [Log messages and trace data for Java server applications]

2. Drive the method to instruct WebSphere Application Server for z/OS to create the message logger.
3. Code messages at appropriate points in your application.

Logging Common Base Events in WebSphere Application Server

WebSphere Application Server uses Common Base Events within its basic logging framework. Common
Base Events can be created explicitly and then logged through the Java logging API, or can be created
implicitly by using the Java logging API directly.

About this task

Attention: Logging Common Base Events is not supported with the High Performance Extensible
Logging (HPEL) log and trace mode.

An event is a notification from an application or the application server that reports information that is
related to a specific problem or situation. Common Base Events provide you with a standard structure for
these event notifications, which allow you to correlate events that are received from different applications.
Log Common Base Events to capture events from different sources to help you fix a problem within an
application environment or to tune system performance.

For Common Base Event creation, the application server environment provides a Common Base Event
factory with a content handler that provides both runtime data and template data for Common Base
Events.

Procedure

1. Optional: Read about the Common Base Event types and how they are implemented within an
application server. Refer to ['The Common Base Event in WebSphere Application Server.

2. Read ['Logging Common Base Events in WebSphere Application Server” on page 77.|

3. Configure the Common Base Event framework for your application server using one of the following
methods:

« [‘Logging with Common Base Event API and the Java logging API” on page 66|
« [‘Generate Common Base Event content with the default event factory” on page 68.|

Results

Common Base Events will now be logged according to your configuration. Use these event logs to
determine the source of application problems.

The Common Base Event in WebSphere Application Server

The Common Base Event is an XML document that defines a common representation of events that is
intended for use by enterprise management and business applications. The Common Base Event defines
common fields, the values they can take, and the exact meanings of these values.

An application creates an event object whenever something happens that either needs to be recorded for

later analysis or which might require the trigger of additional work. An event is a structured notification that

reports information that is related to a situation. An event reports three kinds of information:

» The situation: What happened

* The identity of the affected component: For example, the server that shut down

* The identity of the component that is reporting the situation, which might be the same as the affected
component
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The application that creates the event object is called the event source. Event sources can use a common
structure for the event. The accepted standard for such a structure is called the Common Base Event. The
Common Base Event is an XML document that is defined as part of the autonomic computing initiative.

The Common Base Event model is a standard that defines a common representation of events that is
intended for use by enterprise management and business applications. This standard, which is developed
by the IBM Autonomic Computing Architecture Board, supports encoding of logging, tracing, management,
and business events using a common XML-based format. This format makes it possible to correlate
different types of events that originate from different applications. For more information about the Common
Base Event model, see the Common Base Event specification (Canonical Situation Data Format: The
Common Base Event V1.0.1). The common event infrastructure currently supports Version 1.0.1 of the
specification.

Note:

For WebSphere Application Server Version 8.0, if you delete an application server that was
previously deployed with the Common Event Infrastructure (CEI) enabled and you did not uninstall
CEIl before deleting the server, you must use a different name when creating an application server
that you want to deploy with CEl. If you deploy CEIl on an application server that was created with
the exact same server name as the server that was previously deleted and CEIl was not uninstalled,
the following error occurs:

com.ibm.websphere.management.exception.AdminException: ADMA5026E: No valid target is specified in ObjectName
WebSphere:cell=targetCell,node=targetNode,server=targetServer for module EventServerMdb.jar+META-INF/ejb-jar.xml

If you did not uninstall CEl before deleting the application server, you must ensure that you use a
name for the new application server that is different from the name of the server that was
previously deployed with the common event infrastructure.

The basic concept behind the Common Base Event model is the situation. A situation can be anything that
happens anywhere in the computing infrastructure, such as a server shutdown, a disk-drive failure, or a
failed user login. The Common Base Event model defines a set of standard situation types that
accommodate most of the situations that might arise (for example, StartSituation and CreateSituation).

The Common Base Event contains all of the information that is needed by the consumers to understand
the event. This information includes data about the runtime environment, the business environment, and
the instance of the application object that created the event.

For complete details on the Common Base Event format, see the XML schema that is included in the
Common Base Event specification document, at |http://www.ibm.com/developerworks/autonomic/bookS/i
lfoyOmst.htm#HDRCBEDESC].

Types of problem determination events
Problem determination involves multiple types of data, including at least two different classes of event
data, log events, and diagnostic events.

Log events, which are also referred to as message events, are typically emitted by components of a
business application during normal deployment and operations. Log events might identify problems, but
these events are also normally available and emitted while an application and its components are in
production mode. The target audience for log and message events is users and administrators of the
application and the components that make up the application. Log events are normally the only events
available when a problem is first detected, and are typically used during both problem recovery and
problem resolution.

Diagnostic events, which are commonly referred to as trace events, are used to capture internal diagnostic

information about a component, and are usually not emitted or available during normal deployment and
operation. The target audience for diagnostic events is the developers of the components that make up the
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business application. Diagnostic events are typically used when trying to resolve problems within a
component, such as a software failure, but are sometimes used to diagnose other problems, especially
when the information provided by the log events is not sufficient to resolve the problem. Diagnostic events
are typically used when trying to resolve a problem.

A Common Base Event is a common structure for an event. It defines common fields, the values that
these fields can take, and the exact meanings of these values for an event. Common Base Events are
primarily used to represent log events.

Common Base Event structure
A Common Base Event is a common structure for an event. It defines common fields, the values that
these fields can take, and the exact meanings of these values for an event.

The Common Base Event contains several structural elements. These elements include:
*  Common header information

» Component identification, both source and reporter

 Situation information

* Message data

* Extended data

» Context data

» Associated events and association engine

Each of these structural elements has its own embedded elements and attributes.
The following table presents a summary of all the fields in the Common Base Event and their usage
requirements for problem determination events.

Table 12. Field name, log events, and base specification. This table shows whether a particular element or attribute
is required, recommended, optional, prohibited, or discouraged for log events, and the base specification.

Field name Log events Base specification
Version Required Required
creationTime Required Required
severity Required Optional
Msg Required Optional
sourceComponentld* Required Required
sourceComponentld.location Required Required
sourceComponentld.locationType Required Required
sourceComponentld.component Required Required
sourceComponentld.subComponent Required Required
sourceComponentld.componentldType Required Required
sourceComponentld.componentType Required Required
sourceComponentld.application Recommended Optional
sourceComponentld.instanceld Recommended Optional
sourceComponentld.processid Recommended Optional
sourceComponentld.threadld Recommended Optional
sourceComponentld.executionEnvironment Optional Optional
situation* Required Required
situation.categoryName Required Required
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Table 12. Field name, log events, and base specification (continued). This table shows whether a particular element
or attribute is required, recommended, optional, prohibited, or discouraged for log events, and the base specification.

situation.situationType* Required Required
situation.situationType.reasoningScope Required Required
situation.situationType.(specific Situation Type elements) Required Required
msgDataElement* Recommended Optional
msgDataElement .msgld Recommended Optional
msgDataElement .msgldType Recommended Optional
msgDataElement .msgCatalogld Recommended Optional
msgDataElement .msgCatalogTokens Recommended Optional
msgDataElement .msgCatalog Recommended Optional
msgDataElement .msgCatalogType Recommended Optional
msgDataElement .msgLocale Recommended Optional
extensionName Recommended Optional
locallnstanceld Optional Optional
globallnstanceld Optional Optional
priority Discouraged Optional
repeatCount Optional Optional
elapsedTime Optional Optional
sequenceNumber Optional Optional
reporterComponentld* Optional Optional
reporterComponentld.location Required (2) Required (2)
reporterComponentld.locationType Required (2) Required (2)
reporterComponentld.component Required (2) Required (2)
reporterComponentld.subComponent Required (2) Required (2)
reporterComponentld.componentldType Required (2) Required (2)
reporterComponentld.componentType Required (2) Required (2)
reporterComponentld.instanceld Optional Optional
reporterComponentld.processid Optional Optional
reporterComponentld.threadld Optional Optional
reporterComponentld.application Optional Optional
reporterComponentld.executionEnvironment Optional Optional
extendedDataElements™ Note 3 Optional
contextDataElements* Note 4 Optional
associatedEvents* Note 5 Optional
Notes:

» Items followed by an asterisk (*) are elements that consist of sub elements and attributes. The fields in
those elements are listed in the table directly following the parent element name.

» Some of the elements are optional, but when included, they include sub elements and attributes that are
required. For example, the reporterComponentld element has a Componentldentification type. The
component attribute in Componentldentification is required. Therefore, the
reporterComponentld.component attribute is required, but only when the reporterComponentld parent
element is included.
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The extendedDataElements element can be included multiple times to supply extended data
information. See the Extended data section for more information on required and recommended
extended data element values.

The contextDataElements element can be included multiple times to supply context data information.

The associatedEvents element can be included multiple times to supply correlation data. No
recommended uses of this element exist for the producers of problem determination data, and the use
of this element is discouraged.

Common header information:

This topic provides additional information about how to format and use these fields for problem
determination events, which can be used to clarify and extend the information provided in the other
documents.

The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer's Guide [CBEBASE] provides general usage guidelines.

The common header information in the Common Base Event includes the following information about an
event:

Version: The version of this Common Base Event

creationTime: The date and time when the event generated

Severity and priority: The severity of the condition (situation) that is identified by the event
extensionName: The type of event that was captured

locallnstanceld and globallnstanceld: Identifiers that can be used to quickly identify a specific event
within a set of events

repeatCount and elapsedTime: Information that supports a system to efficiently report multiple events of
the same type, by consolidating those events into a single event

sequenceNumber: Sequence information that supports a system to order a set of events in other ways
than time of capture

severity

All problem determination events must provide an indication as to the relative severity of the condition
(situation) being reported by providing appropriate values for the severity field in the Common Base
Event. The severity field is required for problem determination events. This field is more restrictive than
the base specification for the Common Base Event, which lists this field as optional because effective
and efficient problem determination requires the ability to quickly identify the information that is needed
to resolve a problem as well as prioritize the problems that need addressing.

Table 13. Severity values. The following values are used for problem determination events:

10 Information Log information events, normal

conditions, and events that are
supplied to clarify operations, for
example, state transitions, operational
changes. These events typically do
not require administrator action or
intervention.

20 Harmless Similar to information events, but are

used to capture audit items, such as
state transitions or operational
changes. These events typically do
not require administrator action or
intervention.
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Table 13. Severity values (continued). The following values are used for problem determination events:

30 Warning Warnings typically represent
recoverable errors, for example a
failure that the system can correct.
These events can require
administrator action or intervention.

40 Minor Minor errors describe events that
represent an unrecoverable error
within a component. The failure
affects the component ability to
service some requests. The business
application can continue to perform its
normal functions, but its overall
operation might be degraded. These
events require administrator action or
intervention to address the condition.

50 Critical Critical errors describe events that
represent an unrecoverable error
within a component. The failure
significantly affects the component
ability to service most requests. The
business application can continue
most, but not all of its normal
functions and its overall operation
might be degraded. These events
require administrator action or
intervention to address the condition.

60 Fatal Fatal errors describe events that
represent an unrecoverable error
within a component. The failure
usually results in the complete failure
of the component. The business
application can continue some normal
functions, but its overall operation
might be degraded. These events
require administrator action or
intervention to address the condition.

msg
Refer to [‘Message data” on page 62| for information on this attribute.

priority
The use of the priority field is discouraged for problem determination events. The severity field is
typically used to communicate and evaluate the importance of problem determination events. Use the
priority field to enhance the information that is provided in the severity field, that is. prioritize events of
the same severity.

extensionName
The extensionName field is used to communicate the type of event that is reported, for example, what
general class of events is being reported. In many cases this field provides an indication of what
additional data you can expect with the event, for example, optional data values.

repeatCount
The repeatCount field is valid for problem determination events, but is not typically used or supplied by
the event producers. This field is used for data reduction and consolidation by event management and
analysis systems.
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elapsedTime

The elapsedTime field is valid for problem determination events, but is not typically used or supplied
by the event producers. This field is used for data reduction and consolidation by event management

and analysis systems.

sequenceNumber

The sequenceNumber field is valid for problem determination events. It is typically used only by event
producers when the granularity of the event time stamp (the creationTime field) is not sufficient in
ordering events. The sequenceNumber field is typically used to sequence events that have the same

time stamp value.

Event management and analysis systems can use the sequenceNumber field for a number of reasons,
including providing alternative sequencing, not necessarily based on a time stamp. The

recommendations here are provided primarily for event producers.

Component identification for source and reporter:

The component identification fields in the Common Base Event are used to indicate which component in
the system is experiencing the condition that is described by the event (the sourceComponentID) and

which component emitted the event (the reporterComponentlD).

Typically, these components are the same, in which case only the sourceComponentID is supplied. Some
notes and scenarios on when to use these two elements in the Common Base Event:

* The sourceComponentID is always used to identify the component experiencing the condition that is

described by the event.

» The reporterComponentID is used to identify the component that actually produced and emitted the
event. This element is typically used only within events that are emitted by a component that is
monitoring another component and providing operational information regarding that component. The
monitoring component (for example, a Tivoli® agent or hardware device driver) is identified by the
reporterComponentID and the component being monitored (for example, a monitored server or
hardware device) is identified by the sourceComponentID.

A potential misuse of the reporterComponentID is to identify a component that provides event
conversion or management services for a component, for example, identifying an adapter that
transforms the events that are captured by a component into Common Base Event format. The event
conversion function is considered an extension of the component and not identified separately.

The information that is used to identify a component in the system is the same, regardless of whether it is
the source component or reporter component.

Table 14. Component identification for source and reporter. The information that is used to identify a component in
the system is the same, regardless of whether it is the source component or reporter component.

location locationType

Component location

Identifies the location of the
component.

component componentldType

Component name

Identifies the asset name of the
component, as well as the type of
component.

subcomponent

Subcomponent name

Identifies a specific part or
subcomponent of a component, for
example a software module or
hardware part.

application

Business application name

Identifies the business application or
process the component is a part of
and provides services for.

instanceld

Operational instance

Identifies the operational instance of a
component, that is the actual running
instance of the component.
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Table 14. Component identification for source and reporter (continued). The information that is used to identify a
component in the system is the same, regardless of whether it is the source component or reporter component.

processld threadld

Operational instance

Identifies the operational instance of a
component within the context of a
software operating system, that is he
operating system process and thread
running when the event was
produced.

executionEnvironment

Operational instance Component
location

Provides additional information about
the operational instance of a
component or its location by
identifying the name of the
environment hosting the operational
instance of the component, for
example the operating system name
for a software application, the
application server name for a Java 2
Platform, Enterprise Edition (J2EE)
application, or the hardware server
type for a hardware part.

The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer's Guide [CBEBASE] provides general usage guidelines.
This section provides additional information about how to format and use some of these fields for problem
determination events, which can be used to clarify and extend the information that is provided in the other

documents.

Component

The Component field in a problem determination event is used to identify the manageable asset that is
associated with the event. A manageable asset is open for interpretation, but a good working definition
is a manageable asset represents a hardware or software component that can be separately obtained
or developed, deployed, managed, and serviced. Examples of typical component names are:

+ IBM eServer™ xSeries® model x330
* IBM WebSphere Application Server version 5.1 (5.1 is the version number)
* The name of an internally developed software application for a component

subComponent

The Subcomponent field in a problem determination event identifies the specific part of a component
that is associated with the event. The subcomponent name is typically not a manageable asset, but
provides internal diagnostic information when diagnosing an internal defect within a component, that is
What part failed? Examples of typical subcomponents and their names are:

* Intel Pentium processor within a server system (Intel Pentium IV Processor)
» the enterprise bean container within a web application server (enterprise bean container)
+ the task manager within an operating system (Linux Kernel Task Manager)

» the name of a Java class and method (myclass.mycompany.com or
myclass.mycompany.com.methodname).

The format of a subcomponent name is determined by the component, but use the convention shown
previously for naming a Java class or the combination of a Java class and method is followed. The
subcomponent field is required in the Common Base Event.

componentIdType

The componentldType field is required by the Common Base Event specification, but provides minimal
value for problem determination events. For most problem determination events, it is encouraged to
use the value provided in the application field instead of the componentldType. The componentldType
field identifies the type of component; the application is identified by the application field.
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application
The application field is listed as an optional value within the Common Base Event specification, but
provide it within problem determination events whenever it this value is available. The only reason this
field is not required for problem determination events is that instances exist where the issuing
component might not be aware of the overall business application.

instanceld
The instanceld field is listed as an optional value within the Common Base Event specification, but
provide this value within problem determination events whenever it is available.

Always provide the instancelD when a software component is identified and identify the operational
instance of the component (for example, which operation instance of an installed software image is
actually associated with the event). Provide this value for hardware components when these
components support the concept of operational instances.

The format of the supplied value is defined by the component, but must be a value that an analysis
system can use (either human or programmatic) to identify the specific running instance of the
identified component. Examples include:

+ cell, node, server name for the IBM WebSphere Application Server
» deployed EAR file name for a Java enterprise bean
» serial number for a hardware processor

processId
The processild field is listed as an optional value within the Common Base Event specification, but
provide this value for problem determination events whenever it is available and applicable. Always
provide this value for software-generated events, and identify the operating system process that is
associated with the component that is identified in the event. Match the format of the thread ID with
the format of the operating system (or other running environment, such as a Java virtual machine).
This field is typically not applicable or used for events that are emitted by hardware (for example,
firmware).

threadId
The threadld field is listed as an optional value within the Common Base Event specification, but
provide this value for problem determination events whenever it is available and applicable. Always
provide for software-generated events, and identify the active operating system thread when the event
was detected or issued. A notable exception to this recommendation is some operating systems or
running environments do not support threads. Match the format of the thread ID with the format of the
operating system (or other running environment, such as a Java virtual machine). This field is typically
not applicable or used for events that are emitted by hardware (for example, firmware).

executionEnvironment

The executionEnvironment field, when used, identifies the immediate running environment that is used by
the component being identified. Some examples are:

» the operating system name when the component is a native software application.

 the operating system/Java virtual machine name when the component is a Java 2 Platform, Standard
Edition (J2SE) application.

» the web server name when the component is a servlet.
» the portal server name when the component is a portlet.
» the application server name when the component is an enterprise bean.

The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer's Guide [CBEBASE] provides general usage guidelines.

Situation information:

The situation information is used to classify the condition that is reported by an event into a common set of
situations.
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The Common Base Event specification [CBE101] provides information on the set of situations defined for
the Common Base Event, with the values and formats that are used to describe these situations. The
Common Base Event Developer’s Guide [CBEBASE] provides general usage guidelines.

Consider the following points regarding situation information for problem determination events:

* Whenever possible, use the situation categorizations and qualifiers that are described in the base
Common Base Event specification. Avoid using your own situation definitions as much as possible.

* Not all messages and logs can be classified using the situation definitions that are supplied in the base
Common Base Event specification. You can use the OtherSituation categorization to provide your own
situation information, but the recommended course of action for problem determination events is to use
the ReportSituation categorization, with reportCategory=Log.

» Warning events can be confusing. A warning event (that is an event with severity=warning) typically
indicates a recoverable failure, but the situation settings can be interpreted as unrecoverable failures
(for example ConnectSituation, successDisposition=UNSUCCESSFUL). Use the appropriate situation
categorization so the severity setting indicates the severity of the situation, that is whether the
component recovered from the failure.

* The recommended setting for the reasoningScope value is EXTERNAL for all message events.
Message data:

All problem determination Common Base Events must provide human readable text that describes the
specific reported event within the msg field of the Common Base Event.

The text that is associated with events representing actual messages or log entries is expected to be
translated and localized. Include the msgDataElement element in the Common Base Event whenever
internationalized text is provided in the event. This element provides information about how the message
text is created and how to interpret it. This information is particularly invaluable when trying to interpret the
event programmatically or when trying to interpret the message independent of the locale or language that
is used to format the message text.

Prerequisite: Understand the concepts that are associated with creating internationalized messages. A
good source of education on these concepts is provided by the documentation that is associated with
internationalization of Java information and the usage of resource bundles within the Java language.

The msgDataElement element in the Common Base Event includes the following information about the
value of the msg field that is provided with an event:

* The locale of the supplied message text, which identifies how the locale-independent fields within the
message are formatted, as well as the language of the message (msgLocale).

* A locale-independent identifier that is associated with the message that can be used to interpret the
message independent of the message language, message locale, and message format (msgld and
msgldType).

* Information on how a translated message is created, including:

— The identifier that is used to retrieve the message template (msgCatalogld).
— The name and type of message catalog that are used to retrieve the message template (msgCatalog
and msgCatalogType).

— Any locale-independent information that is inserted into the message template to create the final
message (msgCatalogTokens).

The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer’s Guide [CBEBASE] provides general usage guidelines.
This section provides additional information about how to format and use these fields for problem
determination events.

msg
All message, log, and trace events must provide a human-readable message in the msg field of the
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Common Base Event. The msg field is required for problem determination events, both log events and
diagnostic events. This field is more restrictive than the base specification for the Common Base
Event, which lists this field as optional; effective and efficient problem determination requires the ability
to quickly identify the reported condition. The format and usage of this message is component-specific,
but use the following general guidelines:

» Expect the message text that is supplied with messages and log events to be internationalized.

» Provide the locale of the supplied message text with the msglLocale field in the msgDataElement
element of the Common Base Event.

* Provide additional information regarding the format and construction of internationalized messages
whenever possible, using the msgDataElement element of the Common Base Event.

msglocale
Provide the message locale whenever message text is provided within the Common Base Event, as is
the case with all problem determination events. The msgLocale field is listed as an optional value
within the Common Base Event specification, but provide this information within problem determination
events whenever possible. The reason this field is not required for problem determination events is
that instances exist where the locale information is not provided or available when formatting the
Common Base Event.

msgId and msgIdType
Several companies include a locale-independent identifier within internationalized message text that
you can use to interpret the described condition by the message text, independent of the message.
For example, most messages issued by IBM software look like IEE890I WTO Buffers in console
backup storage = 1024, where a unique, locale-independent identifier IEE8901 precedes the translated
message text. This identifier provides a way to uniquely detect and identify a message independent of
location and language. This detection is invaluable for locale-independent and programmatic analysis.

The msgld field is listed as an optional value within the Common Base Event specification, but it must
be provided within problem determination events whenever this identifier is included in the message
text. Likewise, the msgldType field is listed as an optional value within the Common Base Event
specification, but it must be provided within problem determination events whenever a value is
supplied for msgld. Do not supply these fields when the message text is not translated or localized, for
example, for trace events.

msgCatalogld
The msgCatalogld field is listed as an optional value within the Common Base Event specification, but
provide this value whenever the Common Base Event includes localized or translated message text,
for example when providing problem determination events that represent issued messages or log
events. This field is not required for problem determination events because not all problem
determination events include translated message text Some cases exist where the value is not
provided or available when formatting the Common Base Event. Do not supply this field when the
message text is not translated or localized, for example, for trace events.

msgCatalogTokens
The msgCatalogTokens field is listed as an optional value within the Common Base Event
specification, but provide this value whenever the Common Base Event includes localized or translated
message text, for example when providing problem determination events that represent issued
messages or log events. This field is not required for problem determination events because not all
problem determination events include translated message text, and cases exist where the value is not
provided or available when formatting the Common Base Event. This value contains the list of
locale-independent values or message tokens that are inserted into the localized message text when
creating a translated message.

These values are difficult to extract from a translated message without knowing the translated
message template that is used to create the message. Do not supply this field when the message text
is not translated or localized

The Common Base Event provides several mechanisms for providing additional data about an event,
including this field, extended data elements, and extensions to the schema. Always use the
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msgCatalogTokens field to supply the list of message tokens that is included in the message text
associated with an event. These values can also be supplied in other parts of the Common Base
Event, but they must be included in this field.

msgCatalog and msgCatalogType
The msgCatalog and msgCatalogType fields are listed as optional values within the Common Base
Event specification, but provide this value whenever the Common Base Event includes localized or
translated message text, for example when providing problem determination events that represent
issued messages or log events. These fields are not required for problem determination events
because not all problem determination events include translated message text, and cases exist where
the values are not provided or available when formatting the Common Base Event. Do not complete
these fields when the message text has is not translated or localized, for example, for trace events.

Extended data:

The Common Base Event provides several methods for including this additional data, including extending
the Common Base Event schema or supplying one or more ExtendedDataElement elements within the
Common Base Event, which is the preferred approach.

The base information that is included in a Common Base Event might not be sufficient to represent all of
the information captured by a component when creating a problem determination event.

Use an ExtendedDataElement element to represent a single data item. A Common Base Event can
contain more than one of these elements, essentially one for each additional data item. A hint to the
number and type of ExtendedDataElement elements is supplied by the extensionName value, but this
information is only a hint. The usage of the attributes in the ExtendedDataElement element for problem
determination events is the same as those for any other Common Base Event.

Sample Common Base Event instance
This XML document is an example of a Common Base Event instance that is generated by a WebSphere
Application Server application.

Use the following example for reference:

<CommonBaseEvent creationTime="2004-09-18T04:03:28.484Z"
globalInstanceld="myhost:1095479647062:1899"
msg="WSVROO24I: Server serverl stopped"
severity="10"
version="1.0.1">

. several extendedDataElements for WebSphere Application Server internal use only ...

<sourceComponentId component="com.ibm.ws.runtime.component.ServerCollaborator"
componentIdType="Unknown"
executionEnvironment="Windows Vista[x86]#5.0"
instanceld="myhost\myhost\serverl"
location="myhost"
locationType="Hostname"
processId="1095479647062"
subComponent="Unknown"
threadId="Alarm : 0"
componentType="http://www.ibm.com/namespaces/autonomic/WebSphere Application Server"/>

<msgDataElement msgLocale="en_US">

<msgCatalogTokens value="serverl"/>
<msgId>WSVR00241< /msgld>

<msgCatalogId>WSVROO24I< /msgCatalogIld>
<msgCatalog>com.ibm.ws.runtime.runtime< /msgCatalog>
</msgDataElement>

<situation categoryName="ReportSituation">
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<situationType xsi:type="ReportSituation" reasoningScope="EXTERNAL" reportCategory="L0G"/>
</situation>

</CommonBaseEvent>

A number of extendedDataElement elements in the XML are used by WebSphere Application Server, but
are not for application use because these elements might change.

The CommonBaseEvent element defines the Common Base Event instance. This element has a set of
attributes that are common for all Common Base Events. This set includes the extensionName attribute,
which defines the type or class of the Common Base Event instance, the creation time, severity, and
priority.

Nested within the CommonBaseEvent element are elements giving more detail about the situation. The
first of these elements is the situation element. This classification is standardized.

The CommonBaseEvent element also includes the sourceComponentld and the (optional)
reporterComponentld elements. The sourceComponentld element describes where the situation occurred;
the reporterComponentld describes where the situation is detected. If the sourceComponentld and the
reporterComponentld elements are the same, the reporterComponentld element is omitted.

The attributes of both the sourceComponentld and the reporterComponentld elements are the same. They
identify the component type, name, operating system, and network location. The content of these attributes
provides vertical correlation of the stack of IT resources that are active when the Common Base Event is
created.

Also included in the CommonBaseEvent element are contextDataElements elements that describe the
context in which the situation occurred. This context correlates Common Base Event instances that are
part of the same work. This correlation is called horizontal correlation because an instance of a particular
context type correlates events at the same level of abstraction, for example at the business level, the
application level, or at the middleware level.

FExtended data elements contain additional data that is used to describe a situation. In this example, an
extended data element is added by WebSphere Application Server to describe the Java 2 Platform,
Enterprise Edition (J2EE) component that generated the Common Base Event instance and some
application data.

Sample Common Base Event template
The content handler uses template information to fill in blanks in the Common Base Event when the
Common Base Event complete method is called.

Components that use the WebSphere Application Server event factory home can include a Common Base
Event template XML file to provide data to populate Common Base Events. Information that is already
supplied in the event is not overridden if the same field is supplied in the template.

The following example illustrates a Common Base Event template:
<?xml version="1.0" encoding="UTF-8"?>

<TemplateEvent
version="1.0.1"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalocation="templateEvent.xsd">

<CommonBaseEvent

<sourceComponentId application="My Application" component="com.ibm.componentX"/>
<extendedDataElements name="Sample ExtendedDataElement name" type="string">
<values>Sample ExtendedDataElement value</values>
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</extendedDataElements>
</CommonBaseEvent>

</TemplateEvent>

Component identification for problem determination
This topic describes types of problem determination events.

A business application is made up of multiple components. A component can be made up of several
internal subcomponents. Consistent application of these concepts is critical for effective problem
determination of a business application; all of the parts of the application must use the same concepts and
assumptions when creating and formatting events. Use the following definitions and examples when
creating Common Base Events for problem determination.

Business application
A business application is the business logic and business data that is used to address a set of specific
business requirements. A business application consists of several components of multiple types,
combined in a unique manner by an enterprise, to provide the functions and resources that are
needed to address those requirements. The primary creator and manager of a business application is
the enterprise, and each enterprise or company creates unique business applications. Examples of
business applications are the Payroll Application for the ACME Corporation and the Inventory
Application for Spacely Sprockets.

Components
A business application is created and managed by the enterprise as a set of components.
Components are deployable assets, which are developed either by the enterprise or a vendor, and
managed by the enterprise. A component might be created by the enterprise, typically for use within a
specific business application. For example, the ACME Corporation might create a set of enterprise
beans to represent the business logic that is required by their Payroll Application. A component might
also be an asset that is produced by a vendor and acquired by an enterprise. Examples of these
components are hardware products, such as IBM eServers or Sun Solaris systems, or software
products, such as IBM WebSphere Application Server, Oracle Database Servers.

Subcomponents
A specific component, depending on its complexity, might consist of several subcomponents. For
example, the IBM WebSphere Application Server consists of many subcomponents, such as the
enterprise bean container and the servlet engine. Subcomponent information is typically used only by
the creator of the component to service the component, and as such are not separately deployable or
manageable resources in the enterprise. The enterprise might deploy a change or update to a
subcomponent, but only upon guidance from the component vendor and as part of the vendor’s
component. For example, a software fix for the enterprise bean container of the IBM WebSphere
Application Server is packaged and deployed as a software update to the IBM WebSphere Application
Server. Replacement of the processor in an IBM eServer is deployed as a physical part, but only as a
part of the original deployed component, the IBM eServer.

Logging with Common Base Event APl and the Java logging API

In cases where the events that are generated by the Java logging API are insufficient to describe the
event that needs capturing, you can create Common Base Events with the Common Base Event factory
APls.

Before you begin

When you create a Common Base Event, you can add data to the Common Base Event before it is
logged. The following diagram illustrates how application code can create and log Common Base Events:
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About this task

WebSphere Application Server is configured to use an event factory that automatically populates
WebSphere Application Server-specific information into the Common Base Events that it generates. In
general, it is good practice to create events using the WebSphere Application Server default Common
Base Event factory because this approach ensures consistency of Common Base Event content across
events. However, you can create and use other Common Base Event factories.

Common Base Events are initiated and logged in the following sequence:

1.

Application code invokes the createCommonBaseEvent method on the EventFactory class to create a
CommonBaseEvent.

2. Application code wraps CommonBaseEvent event in a CommonBaseEventLogRecord record, and
adds event-specific data.

3. Application code calls the CommonBaseEvent event complete method.

4. The CommonBaseEvent event invokes the ContentHandler completeEvent method.

5. The ContentHandler handler adds XML template data to the CommonBaseEvent event. Not all
ContentHandler handlers support templates.

6. The ContentHandler handler adds runtime data to the CommonBaseEvent event.

7. Application code passes the CommonBaseEventLogRecord record to the logger using the Logger.log
method.

8. Logger passes CommonBaseEventLogRecord record to Handlers.

9. Handlers format data and write to the output device.

Procedure

* You can use the default Common Base Event factory to generate content. Read [‘Generate Common|

[Base Event content with the default event factory” on page 68| for more information.

» If you do not wish to use the default event factory, you can create custom content handlers and event

factories.

1. Create a custom factory home. Read [‘Creating custom Common Base Event factory homes” on|
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2. Create a custom content handler. Read [‘Creating custom Common Base Event content handlers” on|

Results

After completing all the above steps you will have a Common Base event based on your configuration
settings.

Generate Common Base Event content with the default event factory

A default Common Base Event content handler populates Common Base Events with WebSphere
Application Server runtime information. This content handler can also use a Common Base Event template
to populate Common Base Events.

The default content handler is used when the server creates CommonBaseEventLogRecords as would be
the case in the following example:

// Get a named logger

Logger logger = Logger.getLogger("com. ibm.somelogger");

// Log to the logger -- implicitly the default content handler

// will be associated with the CommonBaseEvent contained in the

// CommonBaseEventLogRecord.

Togger.warning("MSG_KEY_001");

To specify a Common Base Event template in the above case, a Logger.properties file would need to be
provided with an eventfactory entry for com.ibm.someLogger. If a valid template is found on the classpath,
then the Logger's event factory will use the specified template's content in addition to the WebSphere
Application Server runtime information when populating Common Base Events. If the template is not found
on the classpath, or is invalid, then the Logger's event factory will only use the WebSphere Application
Server runtime information when populating Common Base Events.

The default content handler is also associated with the event factory home supplied in the global event
factory context. This is convenient for creating Common Base Events that need to be populated with
content similar to that generated from the WebSphere Application Server:

// Request the event factory from the global event factory home

EventFactory eventFactory =
EventFactoryContext.getInstance().getEventFactoryHome().getEventFactory(templateName);

// Create a Common Base Event
CommonBaseEvent commonBaseEvent = eventFactory.createCommonBaseEvent();

// Complete the Common Base Event using content from the template (if specified above)
// and the server runtime information.
eventFactory.getContentHandler().completeEvent (commonBaseEvent);

In the above example, if the template referenced by templateName is found on the classpath, and the
template is valid, then the event factory home will return an event factory which uses a content handler
that combines the template's content with the WebSphere Application Server runtime information when
populating Common Base Events. If the template is not found on the classpath, or is invalid, then the
event factory home will return an event factory which uses a content handler that uses only the
WebSphere Application Server runtime information when populating Common Base Events.

The default content handler populates Common Base Events in the server environment with the following
runtime information:

CommonBaseEvent.globallnstanceld
Value: The unique_record_id

Set this value only if the CommonBaseEvent.globallnstanceld value is null before the
completeEvent method is called.
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CommonBaseEvent.msg
Value: A localized message that is based on the MsgDataElement element.

Set this value only if the CommonBaseEvent.msg message is null before the completeEvent
method is called.

CommonBaseEvent.severity
Value: Set based on the value of level set on the CommonBaseEventLogRecord record, if level >=
Level.SEVERE, set to 50; if level >= Level. WARNING, set to 30; the default is set to 10.

Set this value only if the CommonBaseEvent.severity value is null before the completeEvent
method is called.

CommonBaseEvent.Componentldentification.component
Value:Set based on the LoggerName value that is set on the CommonBaseEventLogRecord
record.

Set this value only if the CommonBaseEvent.Componentldentification.component is null before the
completeEvent method is called.

CommonBaseEvent.Componentldentification.componentldType
Value: "Unknown"

Set this value only if the CommonBaseEvent.Componentldentification.componentldType value is
null before the completeEvent method is called.

CommonBaseEvent.Componentidentification.executionEnvironment
Value: 0Sname[0Sarch] #0Sversion

Set this value only if the CommonBaseEvent.Componentldentification.executionEnvironment value
is null before the completeEvent method is called.

CommonBaseEvent.Componentldentification.instanceld
Value: cel1Name\nodeName\serverName

Set this value only if the CommonBaseEvent.Componentldentification.instanceld value is null
before the completeEvent method is called. Set only in a server environment because this value is
ignored in a client application.

CommonBaseEvent.Componentldentification.location
Value:The host name

Set this value only if both the CommonBaseEvent.Componentldentification.location and the
CommonBaseEvent.Componentldentification.locationType values are null before the
completeEvent method is called.

CommonBaseEvent.Componentldentification.locationType
Value: The host name

Set this value only if both the CommonBaseEvent.Componentldentification.location and the
CommonBaseEvent.Componentldentification.locationType values are null before the
completeEvent method is called.

CommonBaseEvent.Componentldentification.processid
Value: An internally generated representation of the process number.

Set this value only if the CommonBaseEvent.Componentldentification.processld value is null
before the completeEvent method is called

CommonBaseEvent.Componentldentification.subComponent
Value: Set based on values of the sourceClassName and the sourceMethodName names that are
set on the sourceClassName.sourceMethodName name of the CommonBaseEventLogRecord
record.
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Set this value only if the CommonBaseEvent.Componentldentification.subComponent values is null
before the completeEvent method is called and both the sourceClassName and the
sourceMethodName names are set.

CommonBaseEvent.Componentldentification.threadld
Value: Set to the value of the Java Virtual Machine (JVM) thread name.

Set this value only if the CommonBaseEvent.Componentldentification.threadld values is null before
the completeEvent value is called.

CommonBaseEvent.Componentldentification.componentType
Value: http://www.ibm.com/namespaces/autonomic/WebSphereApplicationServer

Set this value only if the CommonBaseEvent.Componentldentification.componentType values is
null before the completeEvent method is called.

CommonBaseEvent.MsgDataElement.msglLocale
Value: Set based on the default locale of the JVM.

Set this value only if the CommonBaseEvent.msg value is null before the completeEvent method
is called.

CommonBaseEvent.Situation.categoryName
Value: ReportSituation

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

CommonBaseEvent.Situation.situationType.type
Value: ReportSituation

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

CommonBaseEvent.Situation.situationType.reasoningScope
Value: EXTERNAL

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

CommonBaseEvent.Situation.situationType.reportCategory
Value: LOG

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

The sourceComponentldentification value is populated if no reporterComponentldentification ID exists
when the completeEvent method is invoked on the content handler. Otherwise, the
reporterComponentldentification ID is populated instead.

Common Base Event content handler

Content handlers populate data into Common Base Events when the Common Base Event complete
method is invoked. You can associate content handlers with Common Base Event templates, which
provide default information to transfer into each Common Base Event.

Content handlers might also provide any other information that is relevant to completing the population of
the Common Base Event, such as appropriate runtime defaults. The use of content handlers ensures
consistency of field use in the Common Base Event within a component or within a set of components that
share the same runtime. For example, some content handlers support the specification of a template. If
used consistently across a component, this template ensures that all events for that component have the
same template information filled in. Similarly, some content handlers can also supply runtime information to
their associated Common Base Events. If consistently used throughout the entire runtime, runtime
information ensures that all events use runtime data in a similar way.
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The event factory home that is used in the WebSphere Application Server runtime is associated with a
content handler that both reads from a template, and supplies runtime data. Have components use Event
Factories that are obtained from this event factory home with their own templates, to produce consistency
between application events and server events.

More details can be found in‘Creating custom Common Base Event content handlers” or the API
documentation for org.eclipse.hyades.logging.events.cbe.ContentHandler at |www.ec|ipse.org/hyades|.

Creating custom Common Base Event content handlers
Create a custom Common Base Event content handler or template to automate configuration or values for
specific events.

Before you begin

A content handler is an object that automatically sets the property values of each event based on any
arbitrary policies that you want to use.

The following content handler classes were added to WebSphere Application Server to facilitate the use of
the Common Base Event infrastructure:

Class Name Description

WsContentHandlerImpl This provides an implementation of
org.eclipse.hyades.logging.events.cbe.ContentHandler specifically for use in
the WebSphere Application Server environment. This content handler
completes Common Base Events using information from the WebSphere
Application Server runtime, and it uses the same content handler as is used
internally by the WebSphere Application Server when completing Common
Base Events for logging.

WsTemplateContentHandlerlmpl This provides the same function as WsContentHandlerlmpl, but it extends
the org.eclipse.hyades.logging.events.cbe.impl.TemplateContentHandlerImpl
class to enable the use of a Common Base Event template. Template
content takes precedence in cases where the template data specifies values
for the same Common Base Event fields as does the
WsContentHandlerimpl.

About this task

In some situations, you might want some event property data set automatically for every event that you
create. This automation is a way to fill in certain standard values that do not change, such as the
application name, or to set some properties based on information that is available from the runtime
environment, like creation time or thread information. You can set property data automatically by creating a
content handler.

Procedure
» Use the following code sample to implement the CustomContentHandler class:
public class CustomContentHandler extends WsContentHandlerImpl {
public CustomContentHandler() {
super();
// TODO Custom initialization code goes here

}

public void completeEvent(CommonBaseEvent cbe) throws CompletionException {
// following code will add WAS content to the Content Base Event
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super.completeEvent (che);

// TODO Custom content can be added to the Content Base Event here
}
}

» The following shows how to implement the CustomTemplateContentHandler class:

public class CustomTemplateContentHandler extends WsTemplateContentHandlerImpl {

public CustomTemplateContentHandler() {
super();
// TODO Custom initialization code goes here

}

public void completeEvent(CommonBaseEvent cbe) throws CompletionException {
// following code will add WAS content to the Content Base Event
super.completeEvent (che);

// TODO Custom content can be added to the Content Base Event here

}
}

Results

You now have a content handler or a custom content handler template based on the settings that you
specified.

Common Base Event factory home
Event Factory homes provide Event Factory instantiation that is based on a unique factory name.

Event factory home implementations are tightly coupled with content handlers that are used to populate
Common Base Events with template or default data. Event factory instances are maintained by the
associated event factory home, based on their unique name. For example, when application code requests
a named event factory, the newly created Event Factory instance is returned and persisted for future
requests for that named event factory. An abstract event factory home class provides the implementation
for the APIs in the event factory home interface. Implementers extend the abstract event factory home
class and implement the createContentHandler API to create a typed content handler that is based on the
type of event factory home implementation.

In WebSphere Application Server, the default event factory home that is obtained with a call to
EventFactoryContext.getinstance.getEventFactoryHome method is associated with a ContentHandler
handler capable of supplying both event template information, as well as WebSphere Application Server
runtime default information.

More details can be found in the API documentation for
org.eclipse.hyades.logging.events.cbe.EventFactoryHome at www.eclipse.org/hyades.

Creating custom Common Base Event factory homes
Use custom Common Base Event factory homes to control configuration and implementation of unique
event factories.

Before you begin

Event factory homes create and provide homes for Event Factory instances. Each event factory home has
a content handler. This content handler is assigned to every event factory the event factory home creates.
In turn, when a Common Base Event is created, the content handler from the event factory is assigned to
it. Event factory instances are maintained by the associated event factory home, based on their unique
name. For example, when application code requests a named event factory, the newly created event
factory instance is returned and persisted for future requests for that named event factory.
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The following classes were added to facilitate the use of event eactory homes for logging Common Base

Events:

Class Name

Description

WsEventFactoryHomelmpl

This class extends the
org.eclipse.hyades.logging.events.cbe.impl.AbstractEventFactoryHome class.
This event factory home returns event factory instances associated with the
WsContentHandlerlmpl content handler. The WsContentHandlerimpl is the
content handler used by the WebSphere Application Server by default when no
event factory template is in use.

WsTemplateEventFactory
Homelmpl

This class extends the
org.eclipse.hyades.logging.events.cbe.impl.EventXMLFileEventFactoryHomelmpl
class. This event factory home returns event factory instances associated with
the WsTemplateContentHandlerlmpl Content Handler. The
WsTemplateContentHandlerlmpl is the content handler used by the WebSphere
Application Server when an Event Factory template is required.

About this task

Custom event factory homes support the use of Common Base Event for logging in WebSphere
Application Server and make logging easy and consistent between the WebSphere Application Server
runtime and the exploiters of this API. The [CustomEventFactoryHome|and

[CustomTemplateEventFactoryHome| classes will be used to obtain an event factory. These classes are

there to make sure the correct content handler is being used with a particular event factory. The

[CustomEventFactoryHelper class is an example of how the infrastructure provider can hide the factory

selection details from infrastructure users, using their own set of parameters to decide which the

appropriate event factory is.

Procedure

» The following code samples provide examples of how to implement and use the
CustomEventFactoryHome class.

1. Implementation of the CustomEventFactoryHome class is as follows:
public class CustomEventFactoryHome extends AbstractEventFactoryHome {

public CustomEventFactoryHome() {

super();

// TODO Custom intialization code goes here

}

public ContentHandler createContentHandler(String arg0) {
// Always use custom content handler
return resolveContentHandler();

}

public ContentHandler resolveContentHandler() {
// Always use custom content handler
return new CustomContentHandler();

}
}

2. The following is an example of how to use the CustomEventFactoryHome class:

// get the event factory

EventFactory eventFactory=(new CustomEventFactoryHome()).getEventFactory("XYZ");
// create an event - call appropriate method
eventFactory.createCommonBaseEvent();

// Tog event ...

» For the CustomTemplateEventFactoryHome class you can use the following code for implementation

and use:
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1. Implement the CustomTemplateEventFactoryHome class by using this code:

public class CustomTemplateEventFactoryHome extends
EventXMLFileEventFactoryHomeImpl {

public CustomTemplateEventFactoryHome() {
super();
// TODO Custom intialization code goes here

}

public ContentHandler createContentHandler(String arg0) {
// Always use custom content handler
return resolveContentHandler();

}

public ContentHandler resolveContentHandler() {
// Always use custom content handler
return new CustomTemplateContentHandler();

}
}

2. Use the CustomTemplateEventFactoryHome class by following this sample code:

// get the event factory
EventFactory eventFactory=(new
CustomTemplateEventFactoryHome()).getEventFactory ("XYZ");
// create an event - call appropriate method
eventFactory.createCommonBaseEvent();
// log event ...

» The CustomEventFactoryHelper class can be implemented and used by following the code below:
1. Implement the custom CustomEventFactoryHelper class using this code:

public class CustomTemplateEventFactoryHome extends
EventXMLFileEventFactoryHomeImpl {

public CustomTemplateEventFactoryHome() {
super();
// TODO Custom intialization code goes here

}

public ContentHandler createContentHandler(String arg0) {
// Always use custom content handler
return resolveContentHandler();

}

public ContentHandler resolveContentHandler() {
// Always use custom content handler
return new CustomTemplateContentHandler();

}

1

Figure 4 CustomTemplateEventFactoryHome class
public class CustomEventFactoryHelper {

// name of the event factory to use

pubTic static final String FACTORY_NAME="XYZ";

public static EventFactory getEventFactory(String paraml, String param2) {

EventFactory factory=null;

switch (resolveFactory(paraml,param2)) {

case 1:

factory=(new CustomEventFactoryHome()).getEventFactory(FACTORY_NAME);
break;

case 2:
factory=(new
CustomTemplateEventFactoryHome()).getEventFactory (FACTORY_NAME);
break;

default:
// Add default for event factory

74  Troubleshooting and support



break;

}

return factory;

}

private static int resolveFactory(String paraml, String param2) {
int factory=0;
// Add code here to resolve which factory to use
return factory;

}

}

2. To use the CustomEventFactoryHelper class, use the following code:

// get the event factory
EventFactory eventFactory=
CustomEventFactoryHelper.getEventFactory("paraml”, "param2", "param3");
// create an event - call appropriate method
eventFactory.createCommonBaseEvent();
// log event ...

Results

Use the information provided here to implement a custom content factory home and the associated
classes based on the settings that you specify.

Common Base Event factory context
The event factory context provides a service to look up event factory homes. Retrieve the event factory
context using a call to the EventFactoryContext.getinstance method.

Using this class, you can look up the event factory homes by name, and avoid the need to include the
typed home in code. The EventFactoryHome name must be located on the class path to be found. The
EventFactoryContext context also stores an EventFactoryHome name as a default, which can be obtained
with a call to the EventFactoryContext.getinstance.getEventFactoryHome method.

In WebSphere Application Server, the EventFactoryContext context is configured with a default
EventFactoryHome name which is associated to a ContentHandler handler that is capable of supplying
both event template information, as well as WebSphere Application Server runtime default information.

More details can be found in the API documentation for
org.eclipse.hyades.logging.events.cbe.EventFactory at www.eclipse.org/hyades.

Common Base Event factory
Use event factories to create Common Base Events and complete event properties with associated
content handlers.

Content handlers populate data into Common Base Events when the Common Base Event invokes the
complete method. All event properties set by the application code have priority over all properties that are
specified by the content handler. Event factory implementations are tightly coupled with the content
handler instance, which is associated with the event factory when the event factory is instantiated. Factory
instances can be retrieved only from their associated event factory home. Event factory instances are
retrieved and maintained based on unique names. Event factory names are hierarchical; they are
represented using the standard Java dot-delimited, name-space naming conventions.

More details can be found in the API documentation for
org.eclipse.hyades.logging.events.cbe.EventFactory at www.eclipse.org/hyades.

java.util.logging -- Java logging programming interface
The java.util.logging.Logger class provides a variety of methods with which data can be logged.
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In the WebSphere Application Server, the Java logging API (java.util.logging) automatically creates
Common Base Events for events that are logged at the WsLevel. DETAIL level or above (including
WsLevel.DETAIL, Level. CONFIG, Level.INFO, WsLevel. AUDIT, Leve WARNING, Level.SEVERE, and
WsLevel.FATAL). These Common Base Events are created using the event factory that is associated with
the logger to which the message is logged. If no event factory is specified, WebSphere Application Server
uses a default event factory which automatically fills in WebSphere Application Server-specific information.

The WebSphere Application Server uses a special implementation of the java.util.logging.Logger class that
automatically creates Common Base Events for the following methods:

» config

* info

* warning

> severe

* log: All variants except log(LogRecord) when used with the WsLevel.DETAIL level or more severe levels
* logp: When used with the WsLevel.DETAIL level or more severe levels

* logrb: When used with the WsLevel.DETAIL level or more severe levels

The WebSphere Application Server logger implementation is used only for named loggers for example,
loggers that are instantiated with calls, such as Logger.getLogger("com.xyz.SomeLoggerName"). Loggers
instantiated with calls to the Logger.getAnonymousLogger and Logger.getLogger, or Logger.global
methods do not use the WebSphere Application Server implementation, and do not automatically create
Common Base Events for logging requests made to them. Log records that are logged directly with the

Logger.log(LogRecord) method are not automatically converted by WebSphere Application Server loggers
into Common Base Events.

The following diagram illustrates how application code can log Common Base Events:

Application
code

v

Logger .- EventFactory

ContentHandler CBE
®ML

Runtime Data template

CommonBaseEventLogRecord

CommonBaseEvent

Handler

v

Cutput
device

The Java logging API processing of named loggers and message-level events proceeds as follows:
1. Application code invokes the named logger (WsLevel.DETAIL or above) with event-specific data.

2. The logger creates a Common Base Event using the createCommonBaseEvent method on the event
factory that is associated with the logger.

3. The logger creates a Common Base Event using the event factory associated to the logger.
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4. The logger wraps the common base event in a CommonBaseEventLogRecord record, and adds
event-specific data.

5. The logger calls the Common Base Event complete method.
6. The Common Base Event invokes the ContentHandler completeEvent method.

7. The content handler adds XML template data to the Common Base Event (including for example, the
component name). Not all content handlers support templates.

8. The content handler adds runtime data to the Common Base Event (including for example, the
current thread name).

9. The logger passes the CommonBaseEventLogRecord record to the handlers.
10. The handlers format data and write to the output device.

Logger.properties file
Use the Logger.properties file to set logger attributes for your component.

The properties file is loaded the first time the Logger.getLogger(loggername) method is called within an
application. The Logger.properties file must be either on the WebSphere Application Server class path, or
the context class path.

The logging subsystem uses Common Base Events to represent all the messages in the WebSphere
Application Server activity.log file. You can specify your own event factory template to be used with your
loggers. Use the eventfactory property in your Logger.properties file. See|“Sample Common Base Event]
template” on page 65|for details on the Common Base Event template.

By convention, the name of the event factory template file should be the fully qualified package name of
the package using the template. The name of the file must end with the .event.xml extension. For
example, a valid event factory template file name for the com.abc.somepackage package is:

com.abc.somepackage.event.xml

When you specify the property value for the eventfactory property in the Logger.properties file, include
the full path name with no leading slash relative to the root of your class path entry. Do not include the
.event.xml extension.

For example, if the template files from the example above are located in the com/abc/templates directory,
the valid value for the eventfactory property is:

com/abc/templates/com.abc.somepackage

Finally, if this event factory template file is used by the com.abc.somepackage.SomeClass logger, then the
following entry will appear in the Logger.properties file:

com.abc.somepackage.SomeClass.eventfactory=com/abc/templates/com.abc.somepackage

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Logging Common Base Events in WebSphere Application Server

The following practices ensure consistent use of Common Base Events within your components, and
between your components and WebSphere Application Server components.

Follow these guidelines:
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» Use a different logger for each component. Sharing loggers across components gets in the way of
associating loggers with component-specific information.

» Associate loggers with event templates that specify source component identification. This association
ensures that the source of all events created with the logger is properly identified.

» Use the same template for directly created Common Base Events (events created using the Common
Base Event factories) and indirectly created Common Base Events (events created using the Java
logging API) within the same component.

» Avoid calling the complete method on Common Base Events until you are finished adding data to the
Common Base Event and are ready to log it. This approach ensures that any decisions made by the
content handler based on data already in the event are made using the final data.

The following sample Logger.properties file entry demonstrates how to associate the
com.ibm.componentX logger with the com.ibm.componentX event factory:

com. ibm.componentX.eventfactory=com.ibm.componentX

The following sample code demonstrates the use of the same event factory setting for direct (Part 1) and
indirect (Part 2) Common Base Event logging:

<?xml version="1.0" encoding="UTF-8"?>
<TemplateEvent>
version="1.0.1"

xmins:xsi=http://www.w3.0rg/2001/XMLSchema-instance
xsi:noNamespaceSchemalocation="templateEvent.xsd">

<CommonBaseEvent>
<sourceComponentId application="My application" component="com.ibm.componentX"/>
<extendedDataElements CommonBaseEventname="Sample ExtendedDataElement name" type="string">
<values>Sample ExtendedDataElement value</values>

</extendedDataElements>

< /CommonBaseEvent>

< /TemplateEvent>

Showlog commands for Common Base Events
The showlog command converts the service log from binary format into plain text.

Purpose

These showlog commands to produce output in Common Base Event XML format.
* showlog -start startDateTime -format CBE-XML-1.0.1 logStreamName

where:

startDateTime
Specifies the start date and time, in yyyy-MM-ddTHH:mm:ss.SSSZ format. Milliseconds and time
zone are optional.

logStreamName
Is the name of the configured error log stream.

For examples of showlog scripts, see Viewing the service log.
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Chapter 4. Configuring Java logging using the administrative
console

Java logging provides a standard logging API for your applications. Before applications can log diagnostic
information, you need to specify how you want the server to handle log output and what level of logging
you require.

About this task

Developing, deploying and maintaining applications are complex tasks. When an application encounters an
unexpected condition, it might not be able to complete a requested operation. You might want the
application to inform the administrator that the operation failed and tell the administrator why the operation
failed. This information enables the administrator to take the proper corrective action. Application
developers might need to gather detailed information that relates to the path of a running application to
determine the root cause of a failure that is due to a code bug. The facilities that are used for these

purposes are typically referred to as logging and tracing. For more information read |“Java logging” on|
hpage 18.

Using the administrative console, you can:

* Enable or disable a particular log, specify where log files are stored and how many log files are kept.
» Specify the level of detail in a log, and specify a format for log output.

» Set a log level for each logger.

You can change the log configuration statically or dynamically. Static configuration changes affect
applications when you start or restart the application server. Dynamic or run time configuration changes
apply immediately.

When a logger is created, the level value for that logger is set from the configuration data. If no
configuration data is available for a particular logger name, the level for that logger is obtained from the
parent of the logger. If no configuration data exists for the parent logger, the parent of that logger is
checked, and so on up the tree, until a logger with a non-null level value is found. When you change the
level of a logger, the change is propagated to the children of the logger, which recursively propagates the
change to their children, as necessary.

Procedure
1. Set the logging levels for your logs:

a. In the navigation pane, click Servers > Application Servers.
Click the name of the server that you want to work with.
Under Troubleshooting, click Logs and Trace.

Click Change Log Detail levels.

To make a static change to the configuration, click the Configuration tab. A list of well-known
components, packages, and groups is displayed. To change the configuration dynamically, click the
Runtime tab. The list of components, packages, and groups displays all the components that are
currently registered on the running server.

Select a component, package, or group to set a logging level.

©® oo o

—

g. [High Performance Extensible Logging] Select whether or not you want to disable the logging and
tracing of potentially sensitive data.

h. Click Apply.

i. Click OK.

2. To have static configuration changes take effect, stop then restart the application server.
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Log streams and expected output

Investigating the logging and tracing output for the application server is an excellent way to observe
performance, diagnose problems, and gain a general understanding of how the application server is
working within your environment. The expected output locations for logging and trace information can be
different depending on the operating system on which the application server is running.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot

applications for more information on using HPEL.

Distributed and IBM i - Basic log and trace mode

Java Trace

Java Logs

v

System.out

System.err

Trace.log

S

S
)

Activity.log

Showlog

SystemOut.log

—"

SystemErr.log

S

cout

Native stdout

—"

cerr

Native stderr

S

Distributed and IBM i - HPEL log and trace mode
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Java Trace — »  TraceData
Java Logs LogViewer
. S
System.out “ P> LogData
l‘ v
System.err
toosoooo ~py Text log
= HPEL
cout » Native stdout
I v
cerr » Native stderr
I v

Table 15. Log and trace output for z/OS. This table lists the expected output for logging and tracing output streams
when the application server is installed on z/OS.

Log or trace stream

Expected output - traditional log and
trace mode

Expected output - HPEL log and trace
mode

Java trace

SYSPRINT

Note: Trace information, which includes
events at the Fine, Finer and Finest levels,
is written only to this output. If you do not
enable diagnostic trace, setting the log
detail level to Fine, Finer, or Finest does
not affect the logged data.

» HPEL trace repository

» HPEL TextLog*.log, when you enable
this log

Java logs (Audit level)

Transformed into write-to-operator (WTO)
output to the hard copy logging stream

Same outputs as traditional log and trace
mode, plus the following:

» HPEL log repository

» HPEL TextLog*.log, when you enable
this log

Java logs (other levels)

SYSOUT or your configured error stream

Same outputs as traditional log and trace
mod, plus the following:

» HPEL log repository

» HPEL TextLog*.log, when you enable
this log

System.out SYSPRINT « HPEL Iog repository
» HPEL TextLog*.log, when you enable
this log
System.err SYSouT + HPEL log repository
* HPEL TextLog*.log, when you enable
this log
cout (the C or C++ output stream) SYSPRINT SYSPRINT
cerr (the C or C++ error stream) SYSOUT SYSOUT
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Table 15. Log and trace output for z/OS (continued). This table lists the expected output for logging and tracing
output streams when the application server is installed on z/OS.

Log or trace stream

Expected output - traditional log and
trace mode

Expected output - HPEL log and trace
mode

Native trace

SYSPRINT

Note: Trace information, which includes
events at the Fine, Finer and Finest levels,
is written only to this output. If you do not
enable diagnostic trace, setting the log
detail level to Fine, Finer, or Finest does
not affect the logged data.

SYSPRINT

Note: Trace information, which includes
events at the Fine, Finer and Finest levels,
is written only to this output. If you do not
enable diagnostic trace, setting the log
detail level to Fine, Finer, or Finest does
not affect the logged data.

Native Message logs

SYSOUT or your configured error stream

SYSOUT or your configured error stream

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

When considering the direction of log and trace streams, keep in mind the following acronyms and

abbreviations:

cerr C or C++ error steam

cout C or C++ output steam

DD Data Description statements

HFS HTTP File Server

JCL  Java Control Language

JES Java error stream

MVS  Multiple Virtual Storage

WTO
WTOR

Write-to-operator

Write-to-operator with reply

z/0OS - Traditional log and trace mode
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Java Trace
Java L > Filein HFS
avatogs 2/0S DD or MVS
(specified in
proc JCL)
System.out . JES
System.err
zNative
b Trace
Runtime
> CTRACE
z/OS Trace
v
z/OS SYSPRINT
cout DD
G »Z/0S SD\ISSOUT
z/OS
A
» LogStream
(plain text)
zNative Operator
b Message » Console
Runtime (WTO / WTOR) z/0S Logging

2/0S - HPEL log and trace mode
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Java Trace > TraceData '7
Java Logs LogViewer
! S—
System.out 3 > LogData
v
System.err 1
Leecee. iy Textlog
o HPEL
zNative
Trace
Runtime
» CTRACE
z/OS Trace
v
» Z/0OS SYSPRINT
cout > DD
y zZ/0S SYSOUT
cerr > DD
z/OS
A
»  LogStream
(plain text)
zNative Operator
Message > Console
Runtime (WTO / WTOR) z/OS Logging

Log level settings

Use this topic to configure and manage log level settings.

Using log levels you can control which events are processed by Java logging. When you change the level
for a logger, the change is propagated to the children of the logger.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Disable logging and tracing of potentially sensitive data
The application server has a list of loggers which are known to potentially write sensitive
information to the log and trace when enabled. For example, enabling certain HTTP related
loggers at FINEST level may result in confidential user-specified information from HTTP requests
being stored in the trace files. If you want the server to avoid enabling these loggers at levels
which are known to be used for potentially sensitive information, check the "Disable logging and
tracing of potentially sensitive data" checkbox. When the server is started, or when the log detail
level specification is modified at runtime, the server will compare the list of loggers and levels
specified in the log detail level specification to the list of loggers and levels in the sensitive logger
list, and will update the log detail level specification as needed.
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Change Log Detail Levels

Enter a log detail level that specifies the components, packages, or groups to trace. The log detail
level string must conform to the specific grammar described in this topic. You can enter the log
detail level string directly, or generate it using the graphical trace interface.

If you select the Configuration tab, a static list of well-known components, packages, and groups is
displayed. This list might not be exhaustive.

If you select the Runtime tab, the list of components, packages, and group are displayed with all
the components that are registered on the running application server and in the static list.

The format of the log detail level specification is:
<component> = <level>

where <component> is the component for which to set a log detail level, and <level> is one of the
valid logger levels (off, fatal, severe, warning, audit, info, config, detail, fine, finer, finest, all).
Separate multiple log detail level specifications with colons (:).

Components correspond to Java packages and classes, or to collections of Java packages. Use
an asterisk (*) as a wildcard to indicate components that include all the classes in all the packages
that are contained by the specified component. For example:

*  Specifies all traceable code running in the application server, including the product system
code and customer code.

com.ibm.ws.*
Specifies all classes with the package name beginning with com.ibm.ws.

com.ibm.ws.classloader.JarClassLoader
Specifies the JarClassLoader class only.

An error can occur when setting a log detail level specification from the administrative console if
selections are made from both the Groups and Components lists. In some cases, the selection
made from one list is lost when adding a selection from the other list. To work around this
problem, enter the log detail level specification directly into the log detail level entry field.

Select a component or group to set a log detail level. The table following lists the valid levels for
application servers at WebSphere Application Server Version 6 and later, and the valid logging and trace

levels for earlier versions.

Note: Logging level values are case-sensitive and begin with a lower-case letter.

Table 16. Valid logging levels. The following table lists the valid levels for application servers at WebSphere
Application Server Version 6 and later, and the valid logging and trace levels for earlier versions.

Version 6 logging level

Logging level before
Version 6

Trace level before Version
6

Content / Significance

off

off

All disabled*

Logging is turned off.

* In Version 6, a trace level
of All disabled turns off
trace, but does not turn off
logging. Logging is enabled
from the Info level.

fatal

fatal

Task cannot continue and
component, application, and
server cannot function.
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Table 16. Valid logging levels (continued). The following table lists the valid levels for application servers at
WebSphere Application Server Version 6 and later, and the valid logging and trace levels for earlier versions.

severe

error

Task cannot continue but
component, application, and
server can still function.
This level can also indicate
an impending fatal error.

warning

warning

Potential error or impending
error. This level can also
indicate a progressive
failure (for example, the
potential leaking of
resources).

audit

audit

Significant event affecting
server state or resources

info

info

General information
outlining overall task
progress

config

Configuration change or
status

detail

General information
detailing subtask progress

fine

Event

Trace information - General
trace + method entry, exit,
and return values

finer

Entry/Exit

Trace information - Detailed
trace

finest

Debug

Trace information - A more
detailed trace that includes
all the detail that is needed
to debug problems

all

All enabled

All events are logged. If you
create custom levels, All
includes those levels, and
can provide a more detailed
trace than finest.

When you enable a logging level in Version 6.0 or above, you are also enabling

all of the levels with

higher severity. For example, if you set the logging level to warning on your Version 6.x application server,

then warning, severe and fatal events are processed.

[Basic mode logging] Trace information, which are events at the Fine, Finer and Finest levels, can be
written only to the trace log. Therefore, if you do not enable diagnostic trace, setting the log detail level to

Fine, Finer, or Finest will not have an effect on the data that is logged.

Changing the message IDs used in log files

You can change the default format for message IDs in server logs by setting the

com.ibm.websphere.logging.messageld.version system property.

Before you begin

Note: Beginning with WebSphere Application Server Version 6.0, logging files are formatted according to
a standardized system. However, the default runtime behavior is still configured to use the older
format. In new releases of WebSphere Application Server, the message IDs that are written to log

86 Troubleshooting and support




files will be changed to ensure they do not conflict with other IBM products. The default runtime
behavior is still configured to use the older message IDs, deprecated in Version 8.0.

As a result of the default runtime behavior, you might see a mixture of messages that use 4—letter
message prefixes and 5-letter message prefixes. The information in this topic explains how to
change your configuration so that the messages consistently show with 5—letter message prefixes.
The default behavior has not changed to minimize the impact on customers that depend on the
existence of the 4-letter message prefixes.

The following is a sample of an entry in a trace.log file using a default message ID. Note that the message
ID is PMONOOO1A

[1/26/05 10:17:12:529 EST] 0000000a PMIImpl A PMONOOO1A: PMI is enabled

A sample of the same entry using a new message ID follows. Note that the message ID is CWPMIO001A.
All new WebSphere Application Server message IDs begin with 'CW'.

[1/26/05 10:17:12:529 EST] 0000000a PMIImpl A CWPMIOOO1A: PMI is enabled.

About this task

If you are using a logging tool that uses the standardized format, you might want to change the default
configuration settings to format the logging output appropriately. You will need to change the configuration
for each Java virtual machine (JVM) in the cell if you want the output formatting to be the same across
application servers.

Procedure

» To configure logging files so that they use the newer, 5-letter error message prefixes for each process,
use the following commands with the wsadmin utility:

— Using Jacl:

set cfgdvmList [$AdminConfig list JavaVirtualMachine]

set cfgdvm [lindex $cfgdvmList JavaVirtualMachine]

$AdminConfig create Property $cfgdvm {{name com.ibm.websphere.logging.messageld.version} {value 6} {required false}}
$AdminConfig save

— Using Jython:
1s = java.lang.System.getProperty("line.separator")
cfgdvmList = AdminConfig.list("JavaVirtualMachine").split(1s)
print cfgdvmList
cfgdvm = cfgdvmList[JavaVirtualMachine]
AdminConfig.create('Property', cfgdvm, [['name', 'com.ibm.websphere.logging.messageld.version'], ['value', '6'],
['required', 'false']])
AdminConfig.save()
Where JavaVirtualMachine is the number of the process that you want to use.
When you specify the process, the first process listed is zero (0), the second process is one (1), and

so on. Make the changes for each JVM in the cell for consistent output formatting.

Important: Restart the application server for the changes to take effect.

» To change the configuration so that the log files contain the newer, 5-letter message prefixes in the
startServer.log or stopServer.log files, modify the startServer and stopServer scripts in the

install root|/bin directory.
Within these scripts, append the following code to the end of the existing D_ARGS parameter:
$DEBUG -Dcom.ibm.websphere.logging.messageld.version=6

Results

Message IDs written to log files will now be compliant with the new standard.
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Converting log files to use IBM unique Message IDs

The convertlog command creates a new log file with either new or old message IDs substituted in place of
the message IDs in the source file.

Before you begin

Note: Prior to Version 6.x, components were assigned message IDs that are not necessarily unique
across IBM software products. In Version 6.0, a system property was provided to map the message
IDs in output logs to a set of IBM unique message IDs (all WebSphere Application Server message
IDs now start with CW) that do not conflict with other IBM software products. The default runtime
behavior still uses the old message IDs.

About this task

To facilitate the migration of logging tools that are reliant on the old message IDs, the convertlog command
is provided to convert the message IDs of log entries from the old standard to the new standard, or the
new standard back to the old. By default, the software is configured to use the old message IDs when
logging, but you can change the default output with the com.ibm.websphere.logging.messageld.version
system property. Read [‘Changing the message IDs used in log files” on page 86|for more information.

Procedure

Use the convertlog command to convert the log output:

convertlog <source file name> <destination file name> [options]
options: -newMessageFormat convert message IDs to CCCCCnnnnS format
(cannot be used with -m5)
-oldMessageFormat convert message IDs to CCCCnnnnS format
(cannot be used with -m6)

Results

After using the convertlog command you have a new file with message IDs in the chosen format.

convertlog command

The convertlog command is used to convert the message IDs in log entries from the old standard to the
new standard, or the new standard back to the old.

Previous versions of WebSphere Application Server used message IDs that are deprecated in WebSphere
Application Server Version 8.0. To facilitate the migration of tools based on the old message IDs, the
convertlog command is implemented to translate log files from one message ID standard to the other.

Use the convertlog command as follows:

convertlog <source file name> <destination file name> [options]
options: -newMessageFormat convert message IDs to CCCCCnnnnS format
(cannot be used with -m5)
-oldMessageFormat convert message IDs to CCCCnnnnS format
(cannot be used with -m6)

MessageConverter class

The com.ibm.websphere.logging.MessageConverter class provides a method to convert a message ID at
the front of a String into either a new message ID or an old message ID. The direction of the conversion is
controlled with the conversionType argument.

Use the MessageConverter class with log analysis tools to convert message IDs from earlier versions of
WebSphere Application Server into the corresponding message IDs that are used in later releases, or to
revert message IDs to an earlier format.

Method
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public static java.lang.String convert(java.lang.String in, short conversionType)
Parameters

Use the following parameters with the MessageConverter class:

Parameter Name Description

in The message to convert. The method assumes the
message ID is the first part of the supplied message with
no leading white space.

conversionType CONVERSION_TYPE_WASV5_TO_WASV6
CONVERSION_TYPE_WASV6_TO_WASV5

HTTP error, FRCA, and NCSA access log settings

Use this page to configure the global HTTP error log, and National Center for Supercomputing Applications
(NCSA) access log settings for an HTTP inbound channel. If you are running the product on z/OS, you
can also use this page to configure the global Fast Response Cache Accelerator (FRCA) log settings for
an HTTP inbound channel. A FRCA log is a specialized form of a NCSA log and can only be created in a
z/OS environment.

To view this administrative console page, click Servers > Server Types > WebSphere application
servers > server_name. Under Troubleshooting, click NCSA access and HTTP error logging. This
console page has separate sections for each type of logging. The FRCA logging section only appears if
you are running the product on z/OS.

The HTTP error log contains a record of HTTP processing errors that occur. The level of error logging that
occurs is dependent on the value that is selected for the Error log level field.

The NCSA access log contains a record of all inbound client requests that the HTTP transport channel
handles. All of the messages that are contained in a NCSA access log are in NCSA format.

The FRCA log is a specialized NCSA access log that can only be created if you are running the product
on z/OS. This log contains a record of all inbound client requests that are handled by the Fast Response
Cache Accelerator. All of the messages that are contained in this log are in NCSA format.

In a z/OS environment, HTTP error, and NCSA access, and FRCA logging must be configured at the
controller level.

After you configure the HTTP error logs, NCSA access logs, and FRCA logs, you must explicitly enable
each type of logging on the settings page for the HTTP channels for which you want a specific types of
logging to occur. To view the settings page for an HTTP channel, click Servers > Server Types >
WebSphere application servers > server_name > Web Container Settings > HTTP inbound channel
> Web container transport chains.

gotcha: The settings for any of these logs can also be modified on the settings page for a specific HTTP
inbound channel. Any changes that you make on the HTTP inbound channel settings page only
apply to that specific inbound channel. and override any global configuration settings that you
specify on this page.

Enable logging service at server start-up

Select this option if you want any of the following logging to start when the server starts:
* FRCA logging
* NCSA access logging
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e HTTP error logging

gotcha: Even if you select this option, you must explicitly enable the type of logging that you want to
occur on this page and on the settings page for the HTTP transport channel for which you want
that type of logging to occur.

Enable FRCA access logging

When this field is selected, a record of inbound client requests that the HTTP transport channel handles is
kept in the FRCA log.

This field only displays if you are running the product on z/OS.

FRCA log file path

Specifies the directory path and name of the FRCA log. You should use a server-specific variable, such as
$(SERVER_LOG_ROOT), to prevent log file name collisions.

This field only displays if you are running the product on z/OS.

FRCA log maximum size

Specifies the maximum size, in megabytes, of the FRCA access log. When the content of the FRCA
access log reaches the specified maximum size limit, a log_name.1 archive log is created. The current
content of the FRCA access log is then copied to this archive log.

The next time the content in the FRCA access log reaches the specified maximum log size, the content of
the FRCA access log is again copied to the log_name.1 archive log. The copy process overwrites the
current content of the archive file with the most current content of the FRCA access log.

This field only displays if you are running the product on z/OS.

Maximum number of historical files

Specifies the maximum number of historical versions of the FRCA log file that are kept for future
reference.

This field only displays if you are running the product on z/OS.

FRCA log format

Specifies which FRCA format is used when logging client access information. If you select Common, the
log entries contain the requested resource and a few other pieces of information, but does not contain
referral, user agent, and cookie information. If you select Combined, referral, user agent, and cookie
information is included.

This field only displays if you are running the product for z/OS.

Enable NCSA access logging

When selected, a record of inbound client requests that the HTTP transport channel handles is kept in the
NCSA access log.

NCSA access log file path

Specifies the directory path and name of the NCSA access log. Standard variable substitutions, such as
$(SERVER_LOG_ROOT), can be used when specifying the directory path.
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On the z/OS platform, you should use a server-specific variable, such as $(SERVER_LOG_ROQT), to
prevent log file name collisions.

NCSA access log maximum size

Specifies the maximum size, in megabytes, of the NCSA access log. When the content of the NCSA
access log reaches the specified maximum size limit, a log_name.1 archive log is created. The current
content of the NCSA access log is then copied to this archive log.

The next time the content in the NCSA access log reaches the specified maximum log size, the content of
the NCSA access log is again copied to the log_name.1 archive log. The copy process overwrites the
current content of the archive file with the most current content of the NCSA access log.

Maximum number of historical files

Specifies the maximum number of historical versions of the NCSA access log file that are kept for future
reference.

NCSA access log format

Specifies which NCSA format is used when logging client access information. If you select Common, the
log entries contain the requested resource and a few other pieces of information, but does not contain
referral, user agent, and cookie information. If you select Combined, referral, user agent, and cookie
information is included.

Enable error logging

When selected, HTTP errors that occur while the HTTP channel processes client requests are recorded in
the HTTP error log.

Error log file path

Specifies the directory path and the name of the HTTP error log. Standard variable substitutions, such as
$(SERVER_LOG_ROOT), can be used when specifying the directory path.

On the z/OS platform, you should use a server-specific variable, such as $(SERVER_LOG_ROOQT), to
prevent log file name collisions.

Error log maximum size

Specifies the maximum size, in megabytes, of the HTTP error log. When the content of the HTTP error log
reaches the specified maximum size limit, a log_name.1 archive log is created. The current content of the
HTTP error log is then copied to this archive log.

The next time the content in the HTTP error log reaches the specified maximum log size, the content of
the HTTP error log is again copied to the log_name.1 archive log. The copy process overwrites the current
content of the archive file with the most current content of the HTTP error log.

Maximum number of historical files
Specifies the maximum number of historical versions of the Error log file that are kept for future reference.

Error log level
Specifies the type of error messages that are included in the HTTP error log.

You can select:

Critical
Only critical failures that stop the Application Server from functioning properly are logged.
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Error The errors that occur in response to clients are logged. These errors require Application Server
administrator intervention if they result from server configuration settings.

Warning
Information on general errors, such as socket exceptions that occur while handling client requests,
are logged. These errors do not typically require Application Server administrator intervention.

Information
The status of the various tasks that are performed while handling client requests is logged.

Debug
More verbose task status information is logged. This level of logging is not intended to replace
RAS logging for debugging problems, but does provide a steady status report on the progress of
individual client requests. If this level of logging is selected, you must specify a large enough log
file size in the Error log maximum size field to contain all of the information that is logged.
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Chapter 5. Using HPEL to troubleshoot applications

You can use High Performance Extensible Logging (HPEL) to help diagnose problems in WebSphere
Application Server.

About this task

Administrators using WebSphere Application Server need to use log and trace files to determine whether
their applications and the server are running correctly.

Logs typically contain information that is of interest to administrators and must be looked at periodically to
ensure there are no unexpected errors or warnings.

Trace typically contains information that is useful for debugging application or server problems and can
help identify specific problems with individual components.

Procedure

1. Enable HPEL if you have not done so already. Read about changing from basic mode to HPEL logging
and tracing for more information.

2. Configure the HPEL facility. For example, configure HPEL to store your logs and trace in appropriate
directories, and specify how long you want log and trace content to be retained before being deleted.
Read about HPEL to learn about the log and trace framework overall, and read about configuring
HPEL for more configuration information.

3. Restart the application server after making static configuration changes.

High Performance Extensible Logging (HPEL)

High Performance Extensible Logging (HPEL) is a log and trace facility that is provided as a part of
WebSphere Application Server.

Overview

Note: The basic log and trace facility is enabled by default. To use HPEL you must enable it.

Note: HPEL provides a convenient mechanism for storing and accessing log, trace, System.err, and
System.out information produced by the application server or your applications. It is an alternative
to the existing log and trace facilities offered on the z/OS platform which exploit JES, LogStreams,
Component Trace, Hierarchical File System, or other facilities.

HPEL log and trace storage

HPEL provides a log data repository, a trace data repository, and a text log file. See the following figure to
understand how applications and the application server store log and trace information.
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HPEL log data repository

The log data repository is a storage facility for log records. Log data is typically intended to be reviewed by
administrators. This includes any information applications or the server write to System.out, System.err, or
java.util.logging at level Detail or higher (including Detail, Config, Info, Audit, Warning, Severe, Fatal, and
any custom levels at level Detail or higher).

HPEL trace data repository

The trace data repository is a storage facility for trace records. Trace data is typically intended for use by
application programmers or by the WebSphere Application Server support team. This includes any
information applications or the server write to java.util.logging at levels below level Detail (including Fine,
Finer, Finest, and any custom levels below level Detail).

Note: Log and trace content written to the deprecated JRAS logging APl is also included in the log and
trace data repositories. Some logging APIs, such as Jakarta Commons Logging can also be
configured to route their log and trace data to java.util.logging, and would have their output stored
in the log data or trace data repository as well.

HPEL text log

The text log file is a plain text file for log and trace records. The text log file is provided for convenience,

primarily so that log content can be read without having to run the LogViewer command-line tool to convert

the log data repository content to plain text.

The text log file does not contain any content that is not also stored in either the log data repository or

trace data repository. You can disable the text log to enhance server performance. The text log can be

configured to record trace content for debugging convenience.

Note: Writing trace to the text log is expensive from a performance perspective.

Log and trace performance

Log and trace events are each stored in only one place
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Log events, System.out, and System.err are stored in the log data repository. Trace events are stored in
the trace data repository. If the text log file is disabled, HPEL might only write log and trace content to
these repositories. Storing each type of event in one place ensures that performance is not wasted on
redundant data storage.

Log events, and optionally trace events, are written to the text log file when it is enabled. Since this data is
always also stored in the log data and trace data repositories, the text log file content is redundant. The
text log is convenient for users who do not want to run the LogViewer command-line tool to see their logs
and trace; but you can disable the text log if this convenience is not needed.

System.out, N
System.err, N~
log data .| Log data
repository
~_
Application server
Y
N
trace data | Trace data
repository
~
System.out,
System.err,
log data,
trace data Text
»> log
(optional)

Log and trace repositories are not shared across processes

Synchronizing activities between processes causes a degradation in performance to all processes
involved. With HPEL, each server process has its own log data repository, trace data repository, and text
log file. Since these files are not shared across processes, the server runtime environment does not need
to synchronize with other processes when writing to these destinations.

Data is not formatted unless it is needed

Formatting data for an user to read uses processor time. Rather than format log event and trace event
data at run time, HPEL log and trace data is stored more rapidly in a proprietary binary representation.
This improves the performance of the log and trace facility. By deferring log and trace formatting until the
LogViewer is run, sections of the log or trace that are never viewed are never formatted.

You can enable the text log file, which stores the log data and trace data in an already readable text
format.

Note: Disable the text log when performance of your server is a key concern, or if the text log is not
wanted.

Log and trace data is buffered before being written to disk

Writing large blocks of data to a disk is more efficient than writing the same amount of data in small
blocks. HPEL provides buffer log and trace data before writing it to disk. By default, log and trace data is
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stored in an 8 KB buffer before being written to disk. If the buffer is filled within 10 seconds, the buffer is
written to disk. If the buffer is not filled within that time it is automatically written to disk to ensure that the
logs have the most current information.

Note: The size of the buffer can be controlled by setting the HPEL.BUFFER.SIZE system property. The
frequency that the buffer writes to disk can be controlled by setting the
HPEL.FLUSH.PERIOD.SECS system property.

Administration of log and trace

Note: HPEL has been designed to be easy to configure and understand. For example, administrators can
easily configure how much disk space to dedicate to logs or trace, or how long to retain log and
trace records, and leave the management of log and trace content up to the server. As another
example all log, trace, System.out, and System.err content can be accessed using one easy-to-use
command (LogViewer), avoiding any possible confusion over which file to access for certain
content.

Reading from the log data and trace data repositories

The log data and trace data repositories are stored in a WebSphere Application Server proprietary format
and cannot be read using text file editors such as Notepad or VI. You can copy the log data and trace data
repositories in to a plain text format using the LogViewer command.
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N~

Trace Data
Repository
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HPEL LogViewer command

The HPEL LogViewer is an easy-to-use, command-line tool provided for HPEL users to work with the log
data and trace data repositories. The LogViewer provides filtering and formatting options that make finding
important content in the log data and trace data repositories easy. For example, a user might filter any
errors or warnings, then filter all log and trace entries that occurred within 10 seconds of a key error
message on the same thread.

HPEL in the administrative console

The administrative console contains panels that enable HPEL administrators to:
» Configure the HPEL log data repository.

» Configure the HPEL trace data repository.

» Configure the HPEL text log file.

* View the contents of the HPEL log and trace data repositories.

* View and set the log detail levels for logging and tracing.

To use these capabilities, in the administrative console, click Troubleshooting > Logs and Trace link.
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Development resources

Note: HPEL has been designed to make working with log and trace content more flexible and effective
than the basic logging facility. Log and trace content can be easily filtered to show only the records
that are of interest. You can use the command line (see the description of the HPEL LogViewer
command), or developers can create powerful log handling programs using the HPEL API.

Scripts and Java programs read from the log data and trace data repositories

Developers and scripters have a number of options for how to read the log data and trace data

repositories:

» Locally or remotely from a wsadmin script, using the HPELControlService JMX MBean
* Locally or remotely from a Java program, using the HPELControlService JMX MBean
* Locally from a Java program, using the com.ibm.websphere.logging.hpel API

System.out,
System.err,
log data Log data

Application server

‘I Trace data

trace data
System.out,
System.err,
log data,
trace data

HPEL-related JMX MBeans

A MBean interface has been provided to make it easy to access HPEL repository content remotely. For
example, a developer might write a JMX client program to read log content from across their WebSphere
Application Server cell. This interface is part of the HPELControlService MBean. Refer to the MBean
interface documentation for details on the HPEL remote log reading interface.

Table 17. JMX MBeans related to HPEL. The JMX MBeans are related to the operation of HPEL

JMX MBean Description

HPELControlService Provides operations related to configuring the log or trace detail level of
the server, viewing the log component registry, and querying the log and
trace repositories

HPELLogDataService Provides operations related to configuring the log data repository of the
server

HPELTraceDataService Provides operations related to configuring the trace data repository of the
server

HPELTextLogService Provides operations related to configuring the text log file of the server

RasLoggingService Only used for JMX Notification of log events
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When using HPEL for log and trace rather than basic logging, the log and trace JMX MBean,
TraceService, is not used.

HPEL API

An API has been provided to make it easy for developers to develop tools to consume content from the
HPEL log and trace repositories. For example, a developer might write a Java program to search the log
and trace content to find any messages with message IDs that match a known list of important message
IDs. This APl is in the com.ibm.websphere.logging.hpel package. Refer to the APl documentation for
details on the HPEL log reading API.

Basic mode and HPEL mode

Two modes of logging and tracing exist in the product, which are basic mode and High Performance
Extensible Logging (HPEL) mode. Use this topic to understand the differences between these modes.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Basic mode, the default mode, is the existing log and trace framework from prior releases of WebSphere
Application Server. Any existing scripts and tools you have that use logs and trace might need minor
modifications to work with HPEL mode.

To take advantage of the new log and trace framework, HPEL mode must be enabled. After HPEL mode is
enabled the JVM logs (typically SystemOut.log and SystemErr.log), the trace log (typically trace.log), and
the service log (typically activity.log) are no longer written to. Instead, log and trace content is written to a
log data or trace data repository in a proprietary binary format and, if configured, to a text log file.
Disabling the writing of the text log file results in the largest possible performance benefit of HPEL. A log
viewing tool, LogViewer, is provided to allow for viewing, filtering, monitoring, and formatting the log and
trace data in the repositories.

Log and Trace files
The following figure shows the files used by the basic mode and HPEL mode log and trace facilities. When
enabled, the HPEL text log file stores content from Java trace (optional), Java logs, System.out, and

System.err. You can disable the HPEL text log in cases where it is not needed as indicated by the dotted
lines.
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Table 18. Basic mode and HPEL mode files. This table shows where each of the application and application server
log, trace, JVM log, and native JVM log content is routed and how to view that content.

Source Basic mode files HPEL mode files How to view the HPEL files
System.out SystemOut.log logdata/*.wbl logdata - use LogViewer, with
optional filtering, to render log data
trace.log (when trace enabled) TextLog_<timestamp>.log (when repository as readable text, then
text log enabled) use any text editor
TextLog - any text editor
System.err SystemErr.log Same as System.out Same as System.out

java.util.logging (levels DETAIL and
above)

SystemOut.log
activity.log

trace.log (when trace enabled)

Same as System.out

Same as System.out

java.util.logging (levels below
DETAIL)

trace.log

tracedata/*.wbl

TextLog_<timestamp>.log (when
text log enabled)

tracedata - use LogViewer, with
optional filtering, to render trace
data repository as readable text,
then use any text editor

TextLog - any text editor

native cout

native_stdout.log

native_stdout.log

Any text editor

native cerr

native_stderr.log

native_stderr.log

Any text editor

MBean services

Table 19. Basic mode and HPEL mode MBeans. This table shows the JMX MBeans that are associated with the

basic mode and HPEL mode log and trace frameworks.

Basic mode MBeans

HPEL mode MBeans

HPEL MBean Descriptions

RasLoggingServiceMBean

RasLoggingServiceMBean

Provides JMX Notification

HPELLogDataServiceMBean

Configures the log repository such as location,
retention policy, out of space behavior, buffering,

and file switching

HPELTraceDataServiceMBean

Configures the trace repository such as location,
retention policy, out of space behavior, buffering,

and file switching
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Table 19. Basic mode and HPEL mode MBeans (continued). This table shows the JMX MBeans that are associated
with the basic mode and HPEL mode log and trace frameworks.

Basic mode MBeans HPEL mode MBeans HPEL MBean Descriptions

HPELTextLogServiceMBean Configures the text log such as location,
retention policy, out of space behavior, buffering,
file switching, and SystemErr or SystemOut
format

TraceServiceMBean HPELControlServiceMBean Configures trace specification levels, and
provides access to log and trace repository
content

Changing from basic mode to HPEL logging and tracing

The basic mode log and trace framework is enabled by default when you set up a new application server.
Use this topic to switch to the High Performance Extensible Logging (HPEL) log and trace framework.

Before you begin

Before beginning this task, read about the differences between HPEL mode and basic mode. Be aware of
changes you might need to make to any tools and scripts you have that use the basic mode log and trace
files.

About this task

HPEL provides faster log and trace handling capabilities and more flexible ways to use log and trace
content than the basic mode. You can switch to HPEL mode using the administrative console, or using
wsadmin scripting.

Procedure

» Use the administrative console to switch to HPEL.

Log on to the administrative console.

If using an admin agent topology select a node that you want to manage and navigate to it.
From the navigation section in the console choose Troubleshooting > Logs and trace .
Select the server that you want to switch to HPEL.

Click Switch to HPEL Mode .

Save the changes.

» Use wsadmin scripting to switch to HPEL. Complete these steps to modify the server configuration.

1. Start wsadmin. In this case, you can connect wsadmin to a running server or access the
configuration data for a stopped server. Read about starting the wsadmin scripting client for more
information.

2. Get a reference to the HighPerformanceExtensibleLogging configuration object.
Using Jython:

HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:
myServer/HighPerformanceExtensiblelLogging:/")

ook wN =

Table 20. AdminConfig command description. The table lists AdminConfig command and description.

Command Description

myCell The name of the cell
myNode The host name of the node
myServer The name of the server

3. Set the HighPerformanceExtensibleLogging enable attribute to true.
Using Jython:
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AdminConfig.modify(HPELService, "[[enable true]]l")
4. Get a reference to the RASLoggingService object.
Using Jython:
RASLogging = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/RASLoggingService:/")

Table 21. AdminConfig command description. The table lists AdminConfig command and description.

Command Description

myCell The name of the cell
myNode The host name of the node
myServer The name of the server

5. Set the RASLoggingService enable attribute to false.
Using Jython:
AdminConfig.modify(RASLogging, "[[enable false]]l")
6. Save the configuration.
Using Jython:
AdminConfig.save()

Results
The server is now configured to use HPEL when you restart.

If this task was done using the deployment manager, you might need to synchronize the node agent on
the target node before restarting the server.

What to do next

Configure HPEL to meet your needs. If you have any tools or scripts that were using the basic mode log
and trace files, you might need to modify them to continue working with HPEL.

Changing from HPEL to basic mode logging and tracing

Use this topic if you need to switch from HPEL to the basic mode log and trace framework. The basic
mode log and trace framework is enabled by default when you set up a new application server.

Before you begin

Before beginning this task, read about the differences between HPEL mode and basic mode. Be aware of
changes you might need to make to any tools and scripts you have that use HPEL files or commands.

About this task

You can switch to basic mode using the administrative console, or using wsadmin scripting. HPEL provides
faster log and trace handling capabilities and more flexible ways to exploit log and trace content than the
basic mode.

Procedure
» Use the administrative console to switch to basic mode.
1. Log on to the administrative console.
2. If using an administrative agent topology, select a node that you want to manage and navigate to it.
3. From the navigation section in the console click Troubleshooting > Logs and trace.
4. Select the server that you want to switch to basic mode.
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5. Click Change log and trace mode.
6. Click Switch back to basic mode.
7. Save the changes.

» Use wsadmin scripting to switch to basic mode. These steps modify the server configuration. The server
does not need to be running to perform these steps.

1. Start wsadmin. In this case, wsadmin can be connected to a running server or accessing the
configuration data for a stopped server. Read about starting the wsadmin scripting client for more
information.

2. Get a reference to the HighPerformanceExtensibleLogging configuration object.

Using Jython:
HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:
myServer/HighPerformanceExtensiblelLogging:/")

Table 22. AdminConfig command description. The table lists AdminConfig command and description.

Command Description

myCell The name of the cell
myNode The host name of the node
myServer The name of the server

3. Set the HighPerformanceExtensibleLogging enable attribute to false.
Using Jython:
AdminConfig.modify(HPELService, "[[enable false]]")

4. Get a reference to the RASLoggingService object.
Using Jython:

RASLogging = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:
myServer/RASLoggingService:/")

Table 23. AdminConfig command description. The table lists AdminConfig command and description.

Command Description

myCell The name of the cell
myNode The host name of the node
myServer The name of the server

5. Set the RASLoggingService enable attribute to true.
Using Jython:
AdminConfig.modify(RASLogging, "[[enable true]l]")
6. Save the configuration.
Using Jython:
AdminConfig.save()

Results
The server is now configured to use the basic mode log and trace framework when you restart.

If this task was done using the deployment manager, you might need to synchronize the node agent on
the target node before restarting the server.
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Configuring HPEL

Configuring HPEL with wsadmin scripting

You can configure the High Performance Extensible Logging (HPEL) log and trace framework using
wsadmin scripting. Use the examples in this topic as a guide to build your own wsadmin scripts.

About this task

HPEL provides faster log and trace handling capabilities and more flexible ways to use log and trace
content than the basic mode. You can configure the HPEL mode using the administrative console, or using
wsadmin scripting. The examples in this topic show how to configure HPEL using wsadmin. If you
complete this task using the deployment manager, then you might need to synchronize the node agent on
the target node and restart the server before configuration changes take effect.

Table 24. Variable Names. The table applies to all examples in this topic. All examples use the Jython scripting

language.

Variable Description

myCell The name of the cell
myNode The host name of the node
myServer The name of the server
Procedure

» Use the AdminConfig object to configure HPEL.
Changes you make using the AdminConfig object take effect the next time you start the server.
1. Change the trace specification.

The following example shows how to change the trace specification to
*=info:com.ibm.ws.classloader.*=all

HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/
HighPerformanceExtensibleLogging:/")

AdminConfig.modify(HPELService, "[[startupTraceSpec *=info:com.ibm.ws.classloader.*=al1]]")
AdminConfig.save()

2. Change the size of the log repository.

The following example shows how to set HPEL to automatically delete the oldest log content from
the log repository when the repository size approaches 65 MB. Specify HPELTrace or HPELTextLog
instead of HPELLog to change the setting for the HPEL trace repository or HPEL text log.
HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/
HighPerformanceExtensibleLogging:/")

HPELLog = AdminConfig.list("HPELLog", HPELService)

AdminConfig.modify(HPELLog, "[[purgeMaxSize 65]]1")

AdminConfig.save()

3. Change the log repository location.

The following example shows how to change the HPEL log repository directory name to
/tmp/myDirectory. Specify HPELTrace or HPELTextLog instead of HPELLog to change the setting for
the HPEL trace repository or HPEL text log.

HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/
HighPerformanceExtensibleLogging:/")

HPELLog = AdminConfig.list("HPELLog", HPELService)

AdminConfig.modify(HPELLog, "[[dataDirectory /tmp/myDirectory]]")
AdminConfig.save()

4. Disable log record buffering.

The following example shows how to change the HPEL log repository to not use log record
buffering. Specify HPELTrace or HPELTextLog instead of HPELLog to change the setting for the
HPEL trace repository or HPEL text log.
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HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/
HighPerformanceExtensibleLogging:/")

HPELLog = AdminConfig.list("HPELLog", HPELService)
AdminConfig.modify(HPELLog, "[[bufferingEnabled false]]")
AdminConfig.save()

Note: Enable log record buffering in almost all cases. Only disable log record buffering when your
server is failing unexpectedly and cannot write buffered content to disk before stopping.

Start writing to a new log file each day at a specified time.

The following example shows how to enable the HPEL log repository to start a new log file each day
at 3pm. Specify HPELTrace or HPELTextLog instead of HPELLog to change the setting for the
HPEL trace repository or HPEL text log.

HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/
HighPerformanceExtensibleLogging:/")

HPELLog = AdminConfig.list("HPELLog", HPELService)

AdminConfig.modify(HPELLog, "[[fileSwitchTime 15]]")

AdminConfig.modify(HPELLog, "[[fileSwitchEnabled true]]")

AdminConfig.save()

Change the out of space action for the log repository.

The following example shows how to change the out of space action for the HPEL log repository.
Specify HPELTrace or HPELTextLog instead of HPELLog to change the setting for the HPEL trace
repository or HPEL text log.

HPELService = AdminConfig.getid("/Cell:myCell/Node:myNode/Server:myServer/
HighPerformanceExtensibleLogging:/")

HPELLog = AdminConfig.list("HPELLog", HPELService)
AdminConfig.modify(HPELLog, "[[outOfSpaceAction Purge01d]]")
AdminConfig.save()

* Use the AdminControl object to configure HPEL. Changes you make using the AdminControl object take
effect immediately.

1.
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Change the trace specification.

The following example shows how to change the trace specification to
*=info:com.ibm.ws.classloader.*=all

HPELControlMBean = AdminControl.queryNames('cell=myCell,node=myNode,
type=HPELControlService,process=myServer,*")

AdminControl.setAttribute (HPELControlMBean, "traceSpecification",
"x=info:com.ibm.ws.classloader.*=all")

Change the size of the log repository.

The following example shows how to set HPEL to automatically delete the oldest log content from
the log repository when the repository size approaches 65 MB. Specify HPELTraceDataService or
HPELTextLogService instead of HPELLogDataService to change the setting for the HPEL trace
repository or HPEL text log.

HPELLogDataMBean = AdminControl.queryNames('cell=myCell,

node=myNode ,type=HPELLogDataService,process=myServer,*")
AdminControl.setAttribute (HPELLogDataMBean, "purgeMaxSize", "65")

Change the log repository location.

The following example shows how to change the HPEL log repository directory name to
/tmp/myDirectory. Specify HPELTraceDataService or HPELTextLogService instead of
HPELLogDataService to change the setting for the HPEL trace repository or HPEL text log.
HPELLogDataMBean = AdminControl.queryNames('cell=myCell,

node=myNode ,type=HPELLogDataService,process=myServer,*")
AdminControl.setAttribute (HPELLogDataMBean, "dataDirectory", "/tmp/myDirectory")

Disable log record buffering.

The following example shows how to change the HPEL log repository to not use log record
buffering. Specify HPELTraceDataService or HPELTextLogService instead of HPELLogDataService
to change the setting for the HPEL trace repository or HPEL text log.
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HPELLogDataMBean = AdminControl.queryNames('cell=myCell,node=myNode,
type=HPELLogDataService,process=myServer,*")
AdminControl.setAttribute (HPELLogDataMBean, "bufferingEnabled", "false")

Note: Enable log record buffering in almost all cases. Only disable log record buffering when your

server is failing unexpectedly and cannot write buffered content to disk before stopping.
5. Start writing to a new log file each day at a specified time.

The following example shows how to enable the HPEL log repository to start a new log file each day

at 3pm. Specify HPELTrace or HPELTextLog instead of HPELLog to change the setting for the

HPEL trace repository or HPEL text log.

HPELLogDataMBean = AdminControl.queryNames ('cell=myCell,node=myNode,

type=HPELLogDataService,process=myServer,*"')

AdminControl.setAttribute (HPELLogDataMBean, "fileSwitchTime", "15")
AdminControl.setAttribute (HPELLogDataMBean, "fileSwitchEnabled", "true")

6. Change the out of space action for the log repository.
The following example shows how to change the out of space action for the HPEL log repository.

Specify HPELTraceDataService or HPELTextLogService instead of HPELLogDataService to change
the setting for the HPEL trace repository or HPEL text log.

HPELLogDataMBean = AdminControl.queryNames('cell=myCell,node=myNode,
type=HPELLogDataService,process=myServer,*")
AdminControl.setAttribute (HPELLogDataMBean, "outOfSpaceAction", "PurgeOld")

Results

HPEL is now configured. If you made changes with the AdminConfig command, restart the server to make
the changes take effect.

HPEL logging and trace settings

Use this page to view and configure High Performance Extensible Logging (HPEL) logging and trace
settings for the server.

Note: You can only access this page when the server is configured to use HPEL log and trace mode.

To view this administrative console page, click Troubleshooting > Logs and Trace > server_name.

Configure HPEL logging

Use this link to configure HPEL log options. If this server is in running state, then important log
configuration values are displayed below the link. These values summarize the current runtime values
being used by the server.

Configure HPEL trace

Use this link to configure HPEL trace options. If this server is in running state, then important trace
configuration values are displayed below the link. These values summarize the current runtime values
being used by the server.

Configure HPEL text log

Use this link to configure HPEL text log options. If this server is in running state, then important text log
configuration values are displayed below the link. These values summarize the current runtime values
being used by the server.

View HPEL logs and trace

Use this page to view log data from the HPEL repository. You can also use this page to filter and search
the repository. You can export the customized view or full repository into a text file or into a new HPEL
repository.
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Change log detail levels
Use this page to enter a log detail level that specifies the components, packages, or groups to trace.

Change log and trace mode
Use this link to switch back to basic mode logging, instead of HPEL mode logging currently enabled for
this server.

Manage process logs

WebSphere Application Server processes contain two output streams that are accessible to native code,
which runs in a particular process. These streams are the stdout and stderr streams. Native code,
including Java virtual machines (JVM), might write data to these process streams. In addition, you can
also configure JVM-provided System.out and System.err streams to write their data to these streams.

HPEL log configuration settings
Use this page to configure High Performance Extensible Logging (HPEL) log settings.

Note: You can only access this page when the server is configured to use HPEL log and trace mode.

To view this administrative console page, click Troubleshooting > Logs and trace > server_name >
Configure HPEL logging .

Directory path
Specifies the directory to which log files are written. A subdirectory, logdata, is created in this directory, and
the log files are written to this location.

Enable log record buffering

Specifies that the logging system avoids writing to disk each time a log record is created. The logging
system creates a buffer that can hold a number of log records, and writes the buffered events when the
buffer is full. The logging system also writes the buffered events after a few seconds have passed, even if
the buffer is not full.

Selecting this setting significantly improves logging performance; however, if the server stops
unexpectedly, the contents might not be written to the log repository.

Note: Enable log record buffering in almost all cases. Only disable log record buffering when your server
is failing unexpectedly and cannot write buffered content to disk before stopping.

Start new log file daily at <time>
Enables the logging framework to close the log file and start a new file at the specified time of day.
Closing the file makes it easy to copy the file to an archive.

Note: If you want to automatically archive your log files, set up your backup program to copy files after
the time you configured for new logs to be started. Configure the backup to occur at least 10
minutes after the time configured for new logs to be started to ensure that the server has closed the
previous file.

Begin cleanup of oldest records
Specifies the log cleanup settings to be used to automatically purge the oldest log records, or log records
that no longer fit in the configured space, from the log repository.

Select When log size approaches maximum to configure automatic log file cleanup to begin when the
total size of the log repository approaches the configured maximum size.

Select When oldest records reach age limit to configure automatic log file cleanup to begin when log
content is the age limit specified.
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Select When either age or size restriction is met to configure automatic log file cleanup to begin when
either of the previous conditions is met.

Regardless of the selection chosen, records are deleted from the log repository in the order in which they
were written to the log repository.

Log record age limit:

Specifies the lifespan, in hours, that log records can remain in the log repository before the log records
can be automatically deleted by the server. When the oldest records in the log repository have existed
longer than the age limit specified, then those records are targeted for deletion by the server.

Maximum log size:

Specifies the maximum total size, in megabytes, that the server allows the log repository to reach. When
the log repository approaches this size limit, the server deletes the oldest records from the log repository
to make space for new log records.

Out of space action
Specifies how the server reacts to an inability to add content to the log repository.

Select Stop server to specify that the server stops when the server is unable to write to the log repository.

Select Purge old records to specify that the server continues to run, and that the oldest log records are
immediately removed when the server is unable to write to the log repository.

Select Stop logging to specify that the server continues to run, but that the server cannot continue to
write to the log when the server is unable to write to the log repository.

Save runtime changes to configuration as well

Specifies that changes are made to both the dynamic state of the running server, and the server
configuration, which takes effect on the next restart. If this check box is not selected, the server does not
copy the settings into the server configuration.

HPEL trace configuration settings
Use this page to configure High Performance Extensible Logging (HPEL) trace settings.

Note: You can only access this page when the server is configured to use HPEL log and trace mode.

To view this administrative console page, click Troubleshooting > Logs and trace > server_name >
Configure HPEL trace.

Trace to a directory
Specifies that the tracing system writes trace records to the trace directory as they are created by the
server.

Enable log record buffering

Specifies that the tracing system avoids writing to disk each time a trace record is created. The tracing
system creates a buffer that can hold a number of trace records, and writes the buffered events when the
buffer is full. The tracing system also writes the buffered events after a few seconds have passed, even if
the buffer is not full.

Selecting this setting significantly improves tracing performance; however, if the server stops unexpectedly,
the contents might not be written to the trace repository.
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Note: Enable trace record buffering in almost all cases. Only disable trace record buffering when your
server is failing unexpectedly and cannot write buffered content to disk before stopping.

Start new log file daily at <time>
Enables the tracing framework to close the trace file and start a new file at the specified time of day.
Closing the file makes it easy to copy the file to an archive.

Note: If you want to automatically archive your trace files, set up your backup program to copy files after
the time you configured for new files to be started. Configure the backup to occur at least 10
minutes after the time configured for new files to be started to ensure that the server has closed the
previous file.

Begin cleanup of oldest records
Specifies the trace cleanup settings to be used to automatically purge the oldest trace records, or trace
records that no longer fit in the configured space, from the trace repository.

Select When log size approaches maximum to configure automatic trace file cleanup to begin when the
total size of the trace repository approaches the configured maximum size.

Select When oldest records reach age limit to configure automatic trace file cleanup to begin when
trace content is the age limit specified.

Select When either age or size restriction is met to configure automatic trace file cleanup to begin when
either of the previous conditions is met.

Regardless of the selection chosen, records are deleted from the trace repository in the order in which
they were written to the trace repository.

Log record age limit:

Specifies the lifespan, in hours, that trace records can remain in the trace repository before the trace
records can be automatically deleted by the server. When the oldest records in the trace repository have
existed longer than the age limit specified, then those records are targeted for deletion by the server.

Maximum log size:

Specifies the maximum total size, in megabytes, that the server allows the trace repository to reach. When
the trace repository approaches this size limit, the server deletes the oldest records from the trace
repository to make space for new trace records.

Out of space action
Specifies how the server reacts to an inability to add content to the trace repository.

Select Stop server to specify that the server stops when the server is unable to write to the trace
repository.

Select Purge old records to specify that the server continues to run, and that the oldest trace records are
immediately removed when the server is unable to write to the trace repository.

Select Stop logging to specify that the server continues to run, but that the server cannot continue to
write to the trace when the server is unable to write to the trace repository.

Trace to a memory buffer
Specifies that the tracing system writes trace records to a memory buffer.

You can write the memory buffer contents to the trace directory from the runtime tab.
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Memory buffer size
Specifies the amount of memory the tracing system allocates in the server to contain trace records.

In cases where the memory buffer is full when a new trace record is created, the oldest entry from the
memory buffer is deleted to make space.

Dump button
Use this button to write the contents of the trace memory buffer to the trace directory.

The tracing system resets the memory buffer after you dump it. The tracing system continues to record
trace records in the memory buffer after you dump the buffer.

Directory to use for tracing and dumping memory buffer
Specifies the directory to which trace files are written. A subdirectory, trace data, is created in this
directory, and the trace files are written to this location.

Save runtime changes to configuration as well

Specifies that changes are made to both the dynamic state of the running server, and the server
configuration, which takes effect on the next restart. If this check box is not selected, the server does not
copy the settings into the server configuration.

HPEL text log configuration settings
Use this page to configure High Performance Extensible Logging (HPEL) settings for text log.

Note: You can only access this page when the server is configured to use HPEL log and trace mode.

To view this administrative console page, click Troubleshooting > Logs and trace > server_name >
Configure HPEL Text Log.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Enable Text Log
Enables writing log and trace records into the text log file.

Specifies that in addition to writing log and trace records in binary format, the logging system writes them
in a text format as well. You can configure the text log to be formatted in either of the formats that the
basic mode SystemOut.log file uses.

Note: All content written to the text log is also written to either the log repository or trace repository.
Enabling the text log degrades performance for applications that frequently create log or trace
entries.

Directory path
Specifies the directory to which log files are written.

Text log file names have the following format: TextLog_<yy.mm.dd>_<hh.mm.ss>, where "TextLog_" is a

fixed prefix, <yy.mm.dd> is a date (year, month, date) of the first record in the file, and <hh.mm.ss> is the
time (hour, minute, second).
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Enable log record buffering

Specifies that the logging system avoids writing to disk each time a log record is created. The logging
system creates a buffer that can hold a number of log records, and writes the buffered events when the
buffer is full. The logging system also writes the buffered events after a few seconds have passed, even if
the buffer is not full.

Selecting this setting significantly improves logging performance; however, if the server stops
unexpectedly, the contents might not be written to the text log file.

Note: Enable log record buffering in almost all cases. Only disable log record buffering when your server
is failing unexpectedly and cannot write buffered content to disk before stopping.

Start new log file daily at <time>
Enables the logging framework to close the log file and start a new file at the specified time of day.
Closing the file makes it easy to copy the file to an archive.

Note: If you want to automatically archive your log files, set up your backup program to copy files after
the time you configured for new logs to be started. Configure the backup to occur at least 10
minutes after the time configured for new logs to be started to ensure that the server has closed the
previous file.

Begin cleanup of oldest records
Specifies the log cleanup settings to be used to automatically purge the oldest log records, or log records
that no longer fit in the configured space, from the text log directory.

Select When log size approaches maximum to configure automatic log file cleanup to begin when the
total size of the text log files approaches the configured maximum size.

Select When oldest records reach age limit to configure automatic log file cleanup to begin when log
content is the age limit specified.

Select When either age or size restriction is met to configure automatic log file cleanup to begin when
either of the previous conditions is met.

Regardless of the selection chosen, text log files are deleted from the text log directory in the order in
which they were written.

Log record age limit:

Specifies the lifespan, in hours, that log records can remain in the text log directory before the log records
can be automatically deleted by the server. When all records in a text log file have existed longer than the
age limit specified, then that file is targeted for deletion by the server.

Maximum log size:

Specifies the maximum total size, in megabytes, that the server allows the text log files to reach. When the
total size of the text log files approaches this size limit, the server deletes the oldest text log files from the
text log directory to make space for new log records.

Out of space action
Specifies how the server reacts to an inability to add content to the text log directory.

Select Stop server to specify that the server stops when the server is unable to write to the text log
directory.
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Select Purge old records to specify that the server continues to run and that the file containing the oldest
log records is immediately removed when the server is unable to write to the text log directory.

Select Stop logging to specify that the server continues to run, but that the server cannot continue to
write to the log when the server is unable to write to the text log directory.

Text Output Format
Specifies the format to use in the text log file.

Select Basic to specify a shorter, one-line-per-record format.

Select Advanced to specify a longer format using full logger name and more details about each record.

Include trace records
Specifies whether trace records are included in the text log file, as well as log records.

Save runtime changes to configuration as well

Specifies that changes are made to both the dynamic state of the running server and the server
configuration, which take effect on the next restart. If this check box is not selected, the server does not
copy the settings into the server configuration.

Log viewer settings

Use this page to view your High Performance Extensible Logging (HPEL) log, trace, System.out, and
System.err content.

Note: You can only access this page when the server is configured to use basic log and trace mode.

To view this administrative console page, click Troubleshooting > Logs and trace > server_name >
View HPEL logs and trace.

If HPEL is not enabled, you must enable it. Read about changing to HPEL logging and tracing from basic
mode for more information.

You can view log and trace data for servers that are currently running and configured to use HPEL. You
can also view log and trace data for servers that are currently stopped as long as a node agent or
administrative agent is running on the same machine and that agent is configured to use HPEL.

Log view table
Displays the log, trace, System.out, and System.err records.

The log view section displays the records. Use the First Page, Previous Page, Next Page, and Last Page
buttons to move through the list of records, or specify filter criteria in the Content and Filtering Details
section to limit the rows displayed. Records are always displayed in the order they were recorded by the
server. By default the log view has 5 columns as listed in the following table..

Table 25. Log view table columns. The table columns provide information on the log records.

Column Description

Time Stamp The time when the event was recorded.

Thread ID The identity of the thread that recorded the event in hexadecimal
notation.

Logger The logger that recorded the event.

Level The type of event that was recorded.
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Table 25. Log view table columns (continued). The table columns provide information on the log records.

Column Description

Message The message from the recorded event. If the message has a
message ID the message ID is underlined. Click the message ID
to get an explanation and recommended user action for the
message.

To manipulate the log view, you can complete the following actions using available buttons.

Table 26. Log view table buttons. The table buttons help you configure the log settings.

Button Resulting action

Refresh View Clears the contents of the viewer and reinitializes the view using
records from the server. Use this button to retrieve information
about any additional rows created since the log viewer was
started.

Show Only Selected Threads Filters any records created by any thread other than the one
selected in the selection area. Clicking on this button enables the
Show All Threads button.

Show All Threads Displays any records that were filtered when you clicked Show
Only Selected Threads.. This button is only enabled when you
have restricted the view using the Show Only Selected Treads

button.

Select Columns Enables you to select the columns in the viewer that you want to
view.

Export Exports logs to local workstation in any of basic, advanced, or
binary (HPEL) formats

Copy to Clipboard Copies the records that are highlighted in the selection area into

the operating system clipboard.

Server Instance Information Displays attributes for the selected server instance process. Use
this table to find attributes and corresponding values for the
server instance process environment. These properties are
similar to the ones found in the header of basic mode logs.

Content and filtering details

Provides selection options to specify what content sources to include and what content to filter from the
log view.

To change what content sources are shown in the table, or to filter what content is shown, expand the
Content and Filtering Details section.

Server instance
Changes the server instance from which log records are retrieved.

A server instance represents a run of a server process. Each time the server is restarted, a new server
instance is created. By default, the log view table shows log records generated in the most recent server
instance. To select a different server start time, choose a server instance with the appropriate start
timestamp. The timestamps shown represent the timestamp of the first record written to each server
instance.

View contents
Controls what content sources are displayed in the log view.

System Out

Specifies that content logged to the System.out output stream is included in the log view.
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System Error
Specifies that content logged to the System.err output stream is included in the log view.

Logs and trace
Specifies that log and trace records are included in the log view.

Log and trace entries can be further specified to include a minimum or maximum level. Minimum and
maximum can be specified together, for example to display only a certain level of trace. If log and trace is
not selected neither log nor trace records of any severity might be displayed.

Examples of log and trace filtering:

» Selecting logs and trace and clearing minimum level and maximum level fields results in the log view
displaying records with any log or trace level.

+ Selecting logs and trace and setting minimum level to WARNING results in the log view displaying log
records with levels WARNING, FATAL, or SEVERE.

» Selecting logs and trace and setting maximum level to FINE results in the log view displaying trace
records with levels FINE, FINER, or FINEST.

» Selecting logs and trace and setting minimum level to DETAIL and maximum level to AUDIT results in
the log view displaying log records with levels DETAIL, CONFIG, INFO, or AUDIT.

Filtering

Controls which records are included in and excluded from the log view.

For all filters in this section, multiple entries might be specified using a colon () as a separator character.
A limited set of regular expression characters can be used. Refer to console documentation for more
details. If multiple filter settings are specified, the filter conditions must all be true for a record to be
displayed in the log view.

Include loggers
Specifies the list of loggers whose records are included in the log view.

Exclude loggers
Specifies the list of loggers whose records are excluded from the log view.

Message contents
Specifies the message content that each record must contain to be included in the log view.

Event timing
Controls what records are displayed in the log view based on a start and end date and time.

From

Specifies the time of day, which the record creation time must be greater than or equal to for the record to
be displayed in the log view.

Time must be specified as HH:mm:ss using the 24-hour clock. If the From value is not specified, a default
value of 00:00:00 is used.

* HH represents the hour of the day. Valid values are from 0 to 23.
* mm represents the minute of the hour. Valid values are from 0 to 59.
» ss represents the seconds of the minute. Valid values are from 0 to 59.
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On (first occurrence)

Specifies the date, which the record creation date must be greater than or equal to for the record to be
displayed in the log view.

Until

Specifies the time of day, which the record creation time must be less than or equal to for the record to be
displayed in the log view.

Time must be specified as HH:mm:ss using the 24-hour clock. If the Until value is not specified, a default
value of 23:59:59 is used.

* HH represents the hour of the day. Valid values are from 0 to 23.
* mm represents the minute of the hour. Valid values are from 0 to 59.
* ss represents the seconds of the minute. Valid values are from 0 to 59.

On (second occurrence)

Specifies the date, which the record creation date must be less than or equal to for the record to be
displayed in the log view.

LogViewer command-line tool

Use the LogViewer command to query the contents of the High Performance Extensible Logging (HPEL)
log and trace repositories. You can also use the LogViewer command to view new log and trace repository
entries as the server writes content to them.

LogViewer

The High Performance Extensible Logging (HPEL) facility writes to the log and trace repositories in a
binary format. You can view, query and filter the repository using the LogViewer command. The LogViewer
command provides options for quickly converting HPEL logs into a text file in various formats, including
basic, advanced, and Common Base Event format. The command also provides options to make getting
the data you need from the logs easier; for example, allowing you to filter what log records you want by
level, logger name, or date and time.

Use the following command to view the full contents of your log and trace repositories:

Optional parameters

-repositoryDir directory name
Specifies the path to the repository directory. In the case where you want to query both the log and
trace data together, provide the path to the parent directory, which contains both the log data and
tracedata directories. If you use the default repository location, profile_root/logs/application_server/,
and run this tool from the profile bin directory, then this argument is optional. The tool checks the
default location if one is not provided. If multiple application servers exist in this profile with HPEL
repositories, you are prompted to select which server log and trace repository you want to view.

-outlog file name
Specifies the file name you want the text output written to. If you do not provide this information, the
text output is displayed on the console.

-format basic | advanced | cbe-1.0.1
Specifies the output format. Supported formats include basic, advanced, and the CBE-1.0.1 format. If
you do not provide this information, the output is in basic format.

-monitor [interval]
Specifies that you want the logViewer to continuously monitor the repository and output new log record
entries as they are created. You can provide an optional integer argument after this parameter to
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specify how often you want the LogViewer tool to query the repository for new records. By default the
logViewer queries the repository for new records every 5 seconds. When used with other filtering
options, only those new records that match the filter criteria are displayed.

-help
Use this parameter to have the LogViewer tool list the full set of options that are available.

-startDate date_time
You can filter the results that are displayed from the repository by date and time. Use the startDate
parameter to filter out log entries that occurred before the date or date time provided as an argument.
Provide either a date or date and time, entered in the MM/dd/yy format or the MM/dd/yy H:m:s:S
format.

-stopDate date time
Use this parameter to filter out log entries that occurred after the specified date or date time. Provide
the argument in the same format as the -startDate option.

-level level name
Specifies that you want the tool to only display those log events which match the level name you
provide as an argument. Valid values for the level name are FINEST, FINER, FINE, DETAIL, CONFIG,
INFO, AUDIT, WARNING, SEVERE, FATAL.

-minLevel level name
Specifies that you want the tool to only display records which are at or above the specified level. Valid
values for the level name are FINEST, FINER, FINE, DETAIL, CONFIG, INFO, AUDIT, WARNING,
SEVERE, FATAL.

-maxLevel level name
Specifies that you want the tool to only display records that are at or below the specified level. Valid
values for the level name are FINEST, FINER, FINE, DETAIL, CONFIG, INFO, AUDIT, WARNING,
SEVERE, FATAL.

-includelLoggers logger names
When this option is used, only log events from the specified loggers are included in the LogViewer
output. Separate multiple entries with a comma. The * symbol can be used as a wild card to include all
loggers below a parent logger. When used in combination with the -excludedLoggers option, the more
specific match determines if the log event is included or excluded.

-excludeLoggers logger _names
Use this option to exclude log events from the specified loggers in the LogViewer output. Separate
multiple entries with a comma. The * symbol can be used as a wildcard to include all loggers below a
parent logger. When used in combination with the -includeLoggers option, the more specific match
determines if the log event is included or excluded.

-thread thread ID
Use this option to restrict LogViewer output to only those log events from a specific thread. Any log
messages that were not created by the thread ID provided as an argument to this option are not
displayed. Specify the thread ID in hex format.

-extractToNewRepository directory name
This option redirects log and trace records from a binary repository to a new binary repository at the
location that you specify. You can use this option with other filtering options to get a subset of log and
trace records into the new repository. This option uses the directory path where the new repository
must be written as an argument. Therefore, the directory must be empty. If the directory does not
exist, the directory is created. However, errors that occur during the directory creation might create
extraneous directories.

-listInstances
Use this option to list the IDs of available server process instances that are available to use with the
-instance option. After running LogViewer with the -listinstances option, you can then use the -instance
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option to invoke LogViewer with one of the server process instance IDs as an argument. Since this
option does not process any log or trace records, all other options are ignored when you specify this
option.

-instance instanceld
Use this option to retrieve the log and trace data for a given server process instance by providing the
server instance ID. Run LogViewer, along with the -listinstances option, before you use this option to
obtain a valid instance ID. This option is required when viewing logs and trace from an environment
that contains subprocesses, such as the z/OS operating system.

If this option is combined with -latestinstance, -instance is ignored.

-latestInstance
Use this option to retrieve the log and trace data from the most recent server instance. If this option is
used with the -instance option, the -instance option is ignored.

-message match_string
Use this option to retrieve only log or trace data with a message field that matches the requested text.

Filtering considerations

Be aware of LogViewer filtering optimizations. The LogViewer tool is able to filter log and trace data most
efficiently when used with the following filter options:

» startDate

» stopDate

 thread

* level

* minLevel

* maxLevel

Example usage

See the following examples of LogViewer commands on UNIX-based systems. The examples show how to

run LogViewer from the profile bin directory where the repositoryDir parameter is not required.

» Write all records in the default repository between July 19th, 2009 and August 2nd, 2009 to a file called
/tmp/promo.logs.

logViewer.sh -outLog /tmp/promo.logs -startDate 07/19/2009 -stopDate 08/02/2009

» Display new records whose specified level is WARNING or higher using the advanced format as the
server writes them to the log repository.

logViewer.sh -monitor -minLevel WARNING -format advanced

* Write only those log messages that were written to the error stream of a specific repository to a file
called logged_errors.txt.

logViewer.sh -repositoryDir /apps/serverl/logs -includelLoggers SystemErr -outLog logged_errors.txt

* View events from the default repository that occurred before September 14th, 2009 4:28 PM eastern
daylight time.

TogViewer.sh -stopDate "09/14/2009 16:28:00:000 EDT"

On z/OS operating systems where multiple processes exist, you must provide the instance ID to identify
which process you want to view logs and trace from. The instance ID of a controller is represented by a
numeric value while the instance ID of a servant is represented by a combination of a numeric value, job
name, job ID, and process ID. To obtain a list of valid instance IDs, run LogViewer with the -listinstances
option.
* Invoke LogViewer with the -listinstances option; for example:

logViewer.sh -listinstances

The following example is a list of instance IDs from one controller and three servants:
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Instance ID Start Date

1280334046 5/10/10 18:53:12:770 GMT
1280334046/000001BC00000002_BBOS1S STC003119 5/10/10 18:53:39:220 GMT
1280334046/000001B400000002_BB0S1S_STC003120 5/10/10 18:54:44:339 GMT
1280334046/000001C000000001_BBOS1S STC003121 5/10/10 18:55:43:520 GMT

Invoke LogViewer with the -instance option using one of the instance IDs from the previous example.
The ID type is a controller; for example:

logViewer.sh -instance 1280334046
* Invoke LogViewer with -instance option for a servant instance; for example:
logViewer.sh -instance 1280334046/000001BC00000002_BBOS1S_STC003119

Developing log and trace reading applications

Determining which of basic mode and HPEL mode is enabled

WebSphere Application Server offers both a High Performance Extensible Logging (HPEL) log and trace
framework, and a basic log and trace framework. There are a number of ways to determine which of the
two frameworks is enabled.

About this task

In many circumstances it might be important to know whether the HPEL or basic log and trace framework
is enabled, for example, when writing a script whose purpose is to read from any log files of the server.

Since the configuration files of a server can differ from the running state of a server (for example when
configuration changes have been made but the server has not been restarted), steps are provided for
determining the log and trace mode in various ways.

Procedure
» Use wsadmin to determine the log and trace mode that a running server uses.

1. Start wsadmin. In this case, wsadmin must be connected to a running server, for example through
the SOAP port. Read about starting the wsadmin scripting client for more information.

2. Determine whether the HPELControlService object is available. If the HPELControlService is present
it can be concluded that the server is running with the HPEL log and trace framework.

Using Jython:

HPELMBean = AdminControl.queryNames('cell=myCell,node=myNode,
type=HPELControlService,process=myServer,*")
if (HPELMBean == ''):
print "HPEL is not enabled"
else:
print "HPEL is enabled"

Table 27. AdminControl command description. The table lists AdminControl command and their description.

Command Description

myNode The host name of the node

myServer The name of the server

* Use wsadmin to determine the log and trace mode that a servers configuration specifies.

1. Start wsadmin. In this case, wsadmin can be connected to a running server or accessing the
configuration data for a stopped server. Read about starting the wsadmin scripting client for more
information.

2. Determine whether the RASLoggingService configuration object is enabled. If the
RASLoggingService config object is enabled then it can be concluded that the server is configured
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to run with the basic log and trace framework. Otherwise, if the HighPerformanceExtensibleLogging
config object is enabled it can be concluded that the server is configured to run with the HPEL log

and trace framework.

Note: If both the RASLoggingService config object and the HighPerformanceExtensibleLogging
config object are enabled it can be concluded that the server is configured to run with the
basic log and trace framework.

Using Jython:

RASLogging = AdminConfig.getid("/Cell:myCel1/Node:myNode/Server:myServer/RASLoggingService:/")

basicEnabled = AdminConfig.showAttribute(RASLogging, "enable")

if (basicEnabled == "true"):

print "Basic mode logging in effect"

else:
HPELSvc = AdminConfig.getid("/Cell:myCel1/Node:myNode/Server:myServer/HighPerformanceExtensiblelLogging:/")

HpelEnabled = AdminConfig.showAttribute(HPELSvc, "enable")
if (HpelEnabled == "true"):

print "HPEL is enabled"
else:

print "No Togging is enabled"

Table 28. AdminControl command description. The table lists AdminControl command and their description.

Command Description

myCell The name of the cell
myNode The host name of the node
myServer The name of the server

» Use the administrative console to determine the log and trace mode that a running server uses.
1. Log into the administrative console.
2. Click Troubleshooting > Logs and Trace > myServer (where myServer is the name of the server
you are interested in)

3. Find the Switch to HPEL Mode button. If this button is available, the server is using the basic log
and trace framework. Otherwise, the server is using HPEL.

Results

For any method selected, the result is that you now know whether a server is configured to use the HPEL
or basic mode log and trace framework.
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Chapter 6. Using sensitive log and trace guard

You can protect information with the sensitive log and trace guard. The sensitive log and trace guard
prevents loggers from writing sensitive information in your log and trace files.

Sensitive log and trace guard

The sensitive log and trace guard is a feature that helps administrators prevent sensitive information from

being exposed in log and trace files.

The sensitive log and trace guard uses an internal list of allowable levels for sensitive loggers which
specifies the lowest level at which listed loggers can generate log or trace data without containing
potentially sensitive data. You can also add your own loggers to the list that the sensitive log and trace

guard will block.

An example is as follows: If a servlet writes URL request parameters verbatim to logger
com.xyz.SomelLogger at level Level.FINE, and these request parameters could contain information such as
credit card numbers or passwords, then you should add an entry to the sensitive logger list to allow only
levels higher than Level.FINE to be logged - com.xyz.SomeLogger=CONFIG.

When the server initializes the log and trace system, or when you attempt to change the log detail level for
a server, the list of allowable levels for sensitive loggers is compared to the stated log detail level. Any

attempt to enable logging or tracing that is in conflict with entries in the list is overridden. In cases where
the same loggers are specified multiple times in the list the most restrictive entry is used. For example, if
the list of allowable levels for sensitive loggers contains a.b.*=INFO and a.b.*=FINE, then the a.b.” loggers
are restricted to only being able to log at levels INFO and higher. The following table provides examples of
how lists of allowable levels for sensitive loggers modify specified log detail level settings to determine

effective log detail level settings:

Table 29. Restriction list. Examples of how sensitive log and trace guard settings affect log detail level settings

Log detail level setting List of allowable levels for sensitive loggers | Resulting effective log detail level setting
a.b.*=SEVERE a.b.*=FINE *=INFO:a.b.*=SEVERE

a.b.*=SEVERE a.b.*=SEVERE *=INFO:a.b.*=SEVERE

a.b.*=FINE a.b.*=FATAL *=INFO:a.b.*=FATAL

a.*=SEVERE a.b.*=FINE *=INFO:a.*=SEVERE

a.*=SEVERE a.b.*=SEVERE *=INFO:a.*=SEVERE

a.*=FINE a.b.*=FATAL *=INFO:a.*=FINE:a.b.*=FATAL
a.b.*=SEVERE a.*=FINE *=INFO:a.b.*=SEVERE

a.b.*=SEVERE a.*=SEVERE *=INFO:a.b.*=SEVERE

a.b.*=FINE a.*=FATAL *=INFO:a.b.*=FATAL

a.b.*=FINE *=SEVERE *=SEVERE:a.b.*=SEVERE

a.b.*=FINE *=FINE *=INFO:a.b.*=FINE

a.b.*=FINE *=FINEST *=INFO:a.b.*=FINE

a.b.*=FINE x.y.z.*=SEVERE *=INFO:a.b.*=FINE:x.y.z.*=SEVERE
a.b.*=FINE x.y.z.*=FINE *=INFO:a.b.*=FINE

a.b.*=FINE x.y.z.*=FINEST *=INFO:a.b.*=FINE

a.b.*=FINE *=WARNING:x.y.z.*=SEVERE *=WARNING:a.b.*<WARNING:x.y.z.*=SEVERE
a.b.*=FINE *=WARNING:*=SEVERE:x.y.z.*=SEVERE *=SEVERE:a.b.*=SEVERE

By using this log and trace guard, you can prevent loggers from logging at levels which might expose

sensitive information.
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The product is preconfigured with a known list of loggers to restrict, however you might find that further
restrictions are required. .

Enabling and disabling sensitive log and trace guard

You can either enable or disable the sensitive log and trace guard to help control whether loggers write
sensitive information in your log and trace files.

About this task

Administrators using WebSphere Application Server can prevent sensitive information, such as data
provided from users in HTTP requests, from being written in log and trace files. In some cases, when
having access to private data can help with debugging, you might want to disable sensitive log and trace
guard. For example, you might see that a credit card number that was entered in a web form did not have
the required number of digits.

Sensitive log and trace guard works by preventing administrators from enabling certain loggers to levels at
which they are known to log or trace sensitive information.

Use the administrative console to enable or disable the sensitive log and trace guard.

Procedure
1. Log on to the administrative console.

2. If you are using an administrative agent topology, then select a node that you want to manage, and
navigate to it.

3. From the navigation section in the console, choose Troubleshooting > Logs and trace.
4. Select the server that you want to enable or disable with sensitive log and trace guard.
5. Click Change log detail levels.

6

Select the Disable logging and tracing of potentially sensitive data check box to enable sensitive
log and trace guard. To disable sensitive log and trace guard, clear the Disable logging and tracing
of potentially sensitive data check box.

7. Click OK
8. Save the changes.

Results

After you enable sensitive log and trace guard, the server is now configured to prevent known sensitive
loggers from writing sensitive content to the log and trace files. After you disable sensitive log and trace
guard, the server is now configured to allow known sensitive loggers to write sensitive content to the log
and trace files. If you completed these steps using the deployment manager, you might need to
synchronize the node agent on the target node before restarting the server.

Maintaining sensitive log and trace guard lists

The sensitive log and trace guard relies on lists which declare which loggers can potentially log or trace
sensitive information, and the levels at which the sensitive information would be logged. You can extend
the default list of loggers and their corresponding levels in cases where you find sensitive information in
your log or trace that you want to block from being logged or traced in the future.

Before you begin

Read about log level settings for information about enabling the Sensitive Log and Trace Guard.
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About this task

The application server has a private default list of sensitive loggers and their corresponding levels which it
will block whenever the sensitive log and trace guard feature is enabled. The application server also

provides a sensitive log and trace guard property file, and a sensitive log and trace guard API that you can
use to declare new logger restrictions if you discover other loggers which log or trace sensitive information.

Note: If you attempt to add loggers to the sensitive log and trace guard list that have already been
declared, the sensitive log and trace guard will use the more restrictive logger setting of the already
declared and newly specified levels. For example, if the server is already configured to only allow
logger com.xyz.SomelLogger to log at level FINE, and you attempt to declare that the same logger
should only be allowed to log at level FINEST, the server will ignore the update, but if you attempt
to declare that the same logger should only be allowed to log at level INFO, then the server will
reconfigure the sensitive log and trace guard to use level INFO for that logger.

Procedure

* You can use a properties file to declare new logger restrictions. This file is in the cell-scoped
configuration for each profile. The name is:
<profileHome>/config/cells/<cellname>/ras.rawtracelist.properties
This file contains documentation and syntax samples, but contains no actual entries. If you edit this file
on the deployment manager the file is automatically synchronized with all nodes in the cell. If you edit

this file on a specific node, it will be replaced the next time the file is synchronized with the deployment
manager. Thus, it is best to maintain the list at the deployment manager.

* You can use the com.ibm.websphere.logging.RawTraceList API to declare new logger restrictions This
API allows you to add individual entries or an array of entries (using the PatternLevel object in the same
package). It also allows passing in an input stream in the same format as the properties file.
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Chapter 7. Diagnosing problems (using diagnosis tools)

Various diagnosis tools are provided to help you determine the source and impact of problems occurring in
your application serving environment.

About this task

The purpose of this section is to aid you in understanding why your enterprise application, application
server, or WebSphere Application Server is not working and to help you resolve the problem. Unlike
performance tuning, which focuses on solving problems associated with slow processes and non-optimized
performance, problem determination focuses on finding solutions to functional problems.

Procedure

1.

2.

10.

If deploying or running an application results in exceptions such as ClassNotFoundException,
[Class Loader Viewer|to diagnose problems with class loaders.

If you already have an error message and want to quickly look up its explanation and recommended
response, look up the message by expanding the Messages section of the Information Center under
Reference > Messages.

For help in knowing where to find error and warning messages, interpreting messages, and
configuring log files, see [Working with message logs|

Difficult problems can require the use of tracing, which exposes the low-level flow of control and
interactions between components. For help in understanding and using traces, see [Working with

race

For help in viewing diagnostic information like dumps, error logs and CTRACE information, see
[Viewing diagnostic information|
To learn how to work with Diagnostic Providers, see Working with Diagnostic Providers]..

To find out how to look up documented problems, common mistakes, WebSphere Application Server
prerequisites, and other problem-determination information on the WebSphere Application Server
public website, or to obtain technical support from IBM, see |Obtaining help from IBM|

The |BM developer kits: Diagnosis documentation| describes debugging techniques and the diagnostic
tools that are available to help you solve problems with Java. It also gives guidance on how to submit
problems to IBM. You can find the guide at |http://www.ibm.com/developerworks/java/jdk/diagnosis/.

For current information available from IBM Support on known problems and their resolution, see the
WebSphere Application Server Product supporf page. For last minute updates, limitations, and known
g

problems, refer to the Release notes section.

IBM Support has documents that can save you time gathering information needed to resolve this
problem. Before opening a PMR, see the|Must éather_ documents page for information to gather to
send to IBM Support.
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Chapter 8. Diagnosing problems with message logs

WebSphere Application Server can write system messages to several general purpose logs, including
JVM, process, and IBM service logs, which can be examined for problem determination.

Before you begin

The JVM logs are created by redirecting the System.out and System.err streams of the JVM to
independent log files. WebSphere Application Server writes formatted messages to the System.out stream.
In addition, applications and other code can write to these streams using the print() and printin()
methods defined by the streams. Some Developer Kit built-ins such as the printStackTrace() method on
the Throwable class can also write to these streams. Typically, the System.out log is used to monitor the
health of the running application server. The System.out log and System.err log can be used for problem
determination. The System.err log contains exception stack trace information that is useful when
performing problem analysis.

Because each application server represents a JVM, there is one set of JVM logs for each application
server and all of its applications located by default in the following directory:

* install_root/profiles/profile name/1ogs/server_name

In the case of a WebSphere Application Server, Network Deployment configuration, JVM logs are also
created for the deployment manager and each administrative agent because they also represent JVMs.

There is one set of STDOUT and STDERR log streams for each application server and all of its applications.
JVM logs are also created for the deployment manager and each administrative agent because they also
represent JVMs.

The process logs are created by redirecting the STDOUT and STDERR streams of the process to independent
log files. Native code, including the Java virtual machine (JVM) itself, writes to these files. As a general
rule, WebSphere Application Server does not write to these files. However, these logs can contain
information relating to problems in native code or diagnostic information written by the JVM.

As with JVM logs, there is a set of process logs for each application server, since each JVM is an
operating system process. For WebSphere Application Server, Network Deployment configuration, a set of
process logs is created for the deployment manager and each administrative agent.

The IBM service log contains both the WebSphere Application Server messages that are written to the
System.out stream and some special messages that contain extended service information that is normally
not of interest, but can be important when analyzing problems. There is one service log for all WebSphere
Application Server JVMs on a node, including all application servers. The IBM Service log is maintained in
a binary format and requires a special tool to view. This viewer, the Log and Trace Analyzer, provides
additional diagnostic capabilities. In addition, the binary format provides capabilities that are utilized by IBM
support organizations.

In addition to these general purpose logs, WebSphere Application Server contains other specialized logs
that are specific to a particular component or activity. For example, the HTTP server plug-in maintains a
special log. Normally, these logs are not of interest, but you might be instructed to examine one or more of
these logs while performing specific problem determination procedures. For details on how and when to
view the plug-in log, see the Accessing a web resource through the application server and bypassing the
HTTP server subsection of the A web resource does not display topic.

Note: The System.out and STDOUT streams are redirected to the SYSPRINT ddname under z/OS. The

System.err and STDERR streams are redirected to the SYSOUT ddname under z/OS. By default, the
WebSphere Application Server for z/OS cataloged procedures associate these ddnames with print
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(SYSOUT=") data sets, causing message logs to go into WebSphere Application Server job output.
Job output can be viewed with the Spool Display and Search Facility (SDSF) or equivalent
software.

About this task

Sometimes server and application problems can be diagnosed by examining log output from the
WebSphere Application Server.

Procedure

Determine which type of logs you would like to implement:

* |JVM Iog§|

+ [IBM service logs|

Example
How to direct SYSPRINT and SYSOUT output to an HFS file.

If you are familiar with UNIX or Windows environments, you might be reluctant to use the facilities of
SDSF (or IOF) to view the SYSPRINT and SYSOUT output from servants. If you would rather use a
familiar editor (such as vi) in a Telnet session to view your output, it is possible to redirect the SYSPRINT
and SYSOUT outputs to files in an HFS.

The JCL example below shows how to modify the SYSPRINT DD card in your startup procedure to
redirect the output to an HFS file. The old SYSPRINT DD card has been commented out by preceding it
with /*, and a new SYSPRINT DD card points to a file in the "/myDir/myServer" directory, in this case
named was.log.d&LYYMMDD. . t&LHHMMSS.1og. The extra period between the date and time variables is not a
typographical error, but rather an instance of JCL syntax that is necessary to terminate the first variable.
&LYYMMDD will be replaced with the local date in YYMMDD format and &LHHMMSS will be replaced by
the local time in HHMMSS format. The PATHMODE subparameter sets the file mode to 775 and the
PATHOPTS subparameter OWRONLY opens the file for WRITE access. The sub-parameter OCREAT
indicates that if the file does not already exist, create it.

You can modify the SYSPRINT DD card in either your Servant or Controller startup procedure. In addition,
the SYSOUT DD card can be modified in the same way to redirect the SYSOUT output.

//*YSPRINT DD SYSOUT=+,SPIN=UNALLOC,FREE=CLOSE

//SYSPRINT DD PATHMODE=(STRWXU,SIRWXG,SIROTH),

// PATHOPTS=(OWRONLY,OCREAT),
//  PATH='/myDir/myServer/was.log.d&LYYMMDD. . t&LHHMMSS'

Note: If you try to direct the output for multiple streams to the same file, such as setting both DEFALTDD
and HRDCPYDD variables, the allocation for the HRDCPYDD file fails and output is sent to the
default location (JOBLOG/SYSLOG).

Viewing JVM logs

The Java virtual machine (JVM) logs are written as plain text files.

About this task

The SystemOut.Tog and SystemErr.log JVM logs are located in the job logs of the application server.
Note: This topic references one or more of the application server log files. Beginning in WebSphere

Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
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SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

JVM log interpretation

View the JVM log files to determine problems within application environments.

The JVM logs contain print data written by applications. The application can write this data directly in the
form of System.out.print(), System.err.print(), or other method calls. The application can also write
data indirectly by calling a JVM function, such as an Exception.printStackTrace(). In addition, the
System.out JVM log contains system messages written by the WebSphere Application Server.

If you allow the application server to format the application data, it is printed in the normal z/OS trace
format. If you do not allow the application server to format the application data, the raw text is printed,
which is much harder to analyze.

Format of an error log entry

1| 2005/03/62 17:31:17.641 01 t=8FB718 c=UNK key=S2 (13007002)

2| ThreadId: 0000004e

3| FunctionName: com.ibm.ws.sm.workspace.impl.WorkSpaceManagerImpl

4] Sourceld: com.ibm.ws.sm.workspace.impl.WorkSpaceManagerImp]l

5| Category: AUDIT

6| ExtendedMessage: BB000222I: WKSP0023I: Workspace configuration consistency check is disabled.

Table 30. Parts of a log stream record. The following table explains the error log entry previously mentioned.

Line number Component Description

1 2005/03/02 17:31:17.641 01 Date / timestamp / 2-digit record version

number

1 t=8FB718 MVS TCB (thread) Address

1 c=UNK Request correlation information

1 key=S2 State/Key (S=Supervisor,P=Problem)

1 (13007002) Trace Point Identifier

2 Threadld: 0000004e Thread Identifier (TID)

3 FunctionName: Function name
com.ibm.ws.sm.workspace.impl.WorkSpaceManagerimpl

4 Sourceld: Source Identifier
com.ibm.ws.sm.workspace.impl.WorkSpaceManagerimpl
Category: AUDIT Category

6,7 ExtendedMessage: ... Log message

Monitoring application logging using JMX notifications

Java developers can create programs to monitor application server logs using JMX notifications.
About this task

The most common log message listeners are written in Java, and connect to the deployment manager or
an application server using SOAP. Use this topic to build a Java client that listens for log events.

Note: Be careful when adding listeners to servers with high logging volume as JMX notifications can slow
down your server.
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Procedure

1. Import the necessary packages. You will typically need the following import statements at the beginning
of your Java program:

import javax.management.Notification;

import javax.management.NotificationListener;

import javax.management.ObjectName;

import javax.management.InstanceNotFoundException;
import javax.management.MalformedObjectNameException;

import com.ibm.websphere.management.AdminClient;
import com.ibm.websphere.management.AdminClientFactory;
import com.ibm.websphere.management.exception.ConnectorException;

Additionally, to handle the messages, and the types returned from the calls in subsequent steps you
will need the following import statements.

import java.util.Iterator;

import java.util.Properties;

import java.util.Set;

import com.ibm.websphere.ras.RasMessage;

2. Create a Java class that implements the NotificationListener interface.

3. Implement the handleNotification method. The following example is a sample that writes the message
text to the Java console:

public void handleNotification(Notification notification, Object handback) {
RasMessage rasMessage = (RasMessage)notification.getUserData() ;
System.out.printin("Localized message: " + rasMessage.getlLocalizedMessage(null));

}
4. Connect to the SOAP port of the server whose JMX MBeans you want to monitor. The following code
creates a SOAP-connected AdminClient object with a specified host and a specified port:

AdminClient adminClient = null ;
String hostName = "someHostName";
String soapPort = "8880";

Properties connectProps = new Properties();
connectProps.setProperty(AdminClient.CONNECTOR_TYPE, "SOAP");
connectProps.setProperty(AdminClient.CONNECTOR_HOST, hostName);
connectProps.setProperty (AdminClient.CONNECTOR_PORT, soapPort);

try {
adminClient = AdminClientFactory.createAdminClient(connectProps);

} catch (ConnectorException e) {
// error handling code
1

5. Retrieve the MBean object name for the RasLoggingService MBean. The following code retrieves the
RasLoggingService MBean object name:

String queryString = "WebSphere:cell="+cellName+",node="+nodeName+",process="+serverName+",
type=RaslLoggingService,*" ;

Set<ObjectName> objectMBeans = null;
try {

ObjectName queryName = new ObjectName(queryString);

objectMBeans = (Set<ObjectName>)adminClient.queryNames(queryName, null);

if (objectMBeans.size() > 1) {

// error handling code to deal with the case where we get more than one name returned.

} catch (MalformedObjectNameException e) {
// error handling code

} catch (ConnectorException e) {
// error handling code

1

if (objectMBeans.isEmpty()) {
// error handling code to deal with the case where the MBean is not found
1
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Iterator<ObjectName> objectNames = objectMBeans.iterator() ;
ObjectName objectName = objectNames.next() ;

6. Add the notification listener. This sample code adds a notification listener, waits for 60 seconds while it

processes notifications, then removes the notification listener. A listener can stay connected as long as
needed.

try {
adminClient.addNotificationListener(objectName, this, null, null);
Thread.sleep(60 * 1000) ;
adminClient.removeNotificationListener(objectName, this) ;
} catch (InstanceNotFoundException e) {
// error handling code
} catch (ConnectorException e) {
// error handling code
} catch (Exception e) {
// error handling code
}

7. Add the necessary jar to your classpath. Add the admin client jar file to your classpath to be able to

compile and run your code. The admin client jar file is in the <install_root>/runtimes directory.

Results

You have created a Java program that can listen to, and take actions as a result of log event notifications
from an application server.

Setting up the error log

WebSphere Application Server for z/OS uses an error log to record error information when an unexpected
condition or failure is detected within the product's own code. You can use the log stream to record activity
and help diagnose problems.

About this task

Unexpected conditions or failures include:

Assertion failures

Unrecoverable error conditions

Failures related to vital resources, such as memory

Operating system exceptions

Programming defects in WebSphere Application Server for z/OS code.

Procedure

Because WebSphere Application Server for z/OS is predefined as a z/OS system logger application,
you can use a log stream as the product's error log. By doing so, you can direct error information to a
coupling facility log stream, which provides sysplex-wide error logging, or to a DASD-only log stream,
which provides single system-only error logging.

You can set up a common log stream for all WebSphere Application Server for z/OS servers, or
individual log streams for each application server. Local z/OS client ORBs can also log data in log
streams. The system logger APls are unauthorized, but log stream resources can be protected using
security products such as RACF®.

You can use the WebSphere variable ras_time_Tocal to control whether timestamps in the error log
appear in local time (ras_time_local=1) or Greenwich Mean Time (GMT)(ras_time_local=0), which is
the default.

For additional information about z/OS log stream requirements, access the zZ0OS MVS Setting up a
Sysplex, SA22-7625 available on the [z/OS Library web page]
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Viewing the service log

Service logs are logs written in a binary format. You cannot view a service log directly using a text editor.
You should never directly edit the service log, as doing so will corrupt the log.

Before you begin

You can view a service log using the Showlog tool to convert the contents of the service log to a text
format that you can then write to a file or dump to the command shell window.

About this task

Run the showlog script to view the contents of the service log as described in the following procedure.

Procedure

1.
2.

Open a shell window on the machine where the service log resides.

Change the directory to [app_server_roo/bin where |app_server_rool is the fully qualified path where
the WebSphere Application Server product is installed.

Run the showlog script.
Use the following format:

showlog.sh {-start startDateTime [-end endDateTime] | -interval interval}
[-format CBE-XML-1.0.1] [-encoding encoding] logStreamName
loutputFilename]

where:

-start Specifies the start date and time, in yyyy-MM-ddTHH:mm:ss.SSSZ format. Milliseconds and
time zone are optional.

-end  Specifies the end date and time, in yyyy-MM-ddTHH:mm:ss.SSSZ format. Milliseconds and
time zone are optional.

-interval
Specifies the start date as the system date and time minus interval milliseconds, and end date
as the system date and time. Valid values are integers greater than O.

-format
Specifies the output format. Currently only CBE-XML-1.0.1 format is supported (this complies
with the Common Base Event specification version 1.0.1). If no format is given, showlog
outputs in a tabular format.

-encoding
Specifies the output file encoding, a character encoding supported by the local Java Virtual
Machine .

logStreamName
Is a log file name.

outputFilename
Is optional. If no file name is given, the showlog script creates a default showlog.out filename,
outputFilename is created in the current directory unless it is a fully qualified file name.

The formatted contents of the service log are always written to a file. There are parameters to
showlog.sh which control content and encoding of the output. Enter showlog.sh without parameters for
parameter usage information.

The showlog script can return informational messages containing service names, return codes, and
reason codes. For more information about using the z/OS log stream, or to look up service names,
return codes, and reason codes, refer to z/OS MVS Authorized Assembler Services Reference
ENF-IXG(SA22-7610). Return and reason codes are listed for each service.
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Refer to the topic "Authorization for System Logger Application Programs" in z/0S MVS Assembler
Services Guide (SA22-7605) for advice on permitting access to the log stream.

4. Run the following showlog script with no parameters to display usage instructions.
showlog.sh
5. Format and write the service log contents to a file.
showlog service_log_filename output_filename
If the service log is not in the default location, you must fully qualify the service log filename

Example

Here are examples of showlog scripts on z/OS systems

» To write all records from the WAS.ERROR. LOG file since July 14, 2004 in log analyzer format into the
myoutput.Tog file, use the following format:

showlog.sh -start 2004-07-14T00:00:00 WAS.ERROR.LOG myoutput.log

» To write all records from WAS.ERROR.LOG file since July 14, 2004 in Common Base Event XML 1.0.1
format into myoutput.log file, use the following format:

showlog.sh -start 2004-07-14T00:00:00 -format CBE-XML-1.0.1
WAS.ERROR.LOG myoutput.Tog

* To write all records from WAS.ERROR.LOG file between July 14, 2004 and April 9, 2005 in Common Base
Event XML 1.0.1 format into myoutput.log file, use the following format:

showlog.sh -start 2004-07-14T00:00:00 -end 2005-04-09T700:00:00
-format CBE-XML-1.0.1 WAS.ERROR.LOG myoutput.log

» To write all records from WAS.ERROR.LOG file since December 6, 2004 at 9pm Eastern standard time into
myoutput.Tog file (the default output file), use the following format:

showlog.sh -start 2004-12-06T21:00:00EST WAS.ERROR.LOG

Generating messages in Common Base Event format
Use the administrative console to enable writing of the logstream in Common Base Event format.

About this task

The z/OS logs can be stored in Common Base Event format. This enables the Showlog tool to read the
data in the logstream. In turn, the showlog output can be read by the log and trace analyzer (included as
part of the Application Server Toolkit).

Procedure

1. Click Application servers > server1 > Process Definition > Control > Java Virtual Machine >
Custom Properties

2. Add a new custom property with name="com.ibm.ws.logging.z0S.errorLog.format" and value
"CBE-XML-1.0.1"

3. Restart your application server for this setting to take effect.

Results

When this property is set to CBE-XML-1.0.1, the messages written to the error logstream are in binary
Common Base Event format. You can then use the showlog script to view the binary Common Base Event

records in the logstream.

Note:
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If you enable writing of the logstream in Common Base Event format, the error log is no longer
viewable with the log browse utility. This action changes the format used to write to the logstream
so that only the showlog tool can read it.

Logstream size considerations

You might need to modify the size of the logstream record size if the application server is attempting to
write messages that are too large. If a message is too large, you will receive an error message that will be
written to the job log.

If the logstream record size is too small for a message being written to it, you see a message similar to
the following written to your job log:

TRAS00241: Log entry is of size 5012 bytes which is too large to be added to
log stream which is configured for 4096 byte records. Log entry will not be
logged to the Tog stream.

The original message is also written to the job log and can be viewed there.

To resolve this issue and ensure your messages fit into your logstream, change the MAXBUFSIZE of the
error log logstream. The following code shows an example where the sample BBOERRLG job generated
by the Profile Management Tool or the zpmt command is modified to set the MAXBUFSIZE to 8192:

//BBOERRLG JOB (ACCTNO,ROOM), 'USER10',CLASS=A,REGION=0M
/1%
/1*
/1%
//BBORCLGS EXEC PGM=IXCMIAPU
//STDOUT DD STDERR=*
//SYSIN DD *
DATA TYPE(LOGR)
DEFINE LOGSTREAM NAME (WAS.TY5.ERROR.LOG)
DASDONLY (YES)
HLQ(LOGGER)
LS_SIZE(500)
STG_SIZE(500)
MAXBUFSIZE (8192)
AUTODELETE (YES)
RETPD(1)
LS_DATACLAS (STANDARD)
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Chapter 9. Working with trace

Use trace to obtain detailed information about running the WebSphere Application Server components,
including application servers, clients, and other processes in the environment.

About this task

Trace files show the time and sequence of methods called by WebSphere Application Server base
classes, and you can use these files to pinpoint the failure. Collecting a trace is often requested by IBM
technical support personnel. If you are not familiar with the internal structure of WebSphere Application
Server, the trace output might not be meaningful to you.

You can configure trace settings with the administrative console, or you can configure tracing from the
MVS console using the modify command.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.Tog ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Procedure

1. an output destination to which trace data is sent.

2. [Enable trace|for the appropriate WebSphere Application Server or application components.
3. Run the application or operation to generate the trace data.
4. Analyze the trace data or forward it to the appropriate organization for analysis.

Results

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Support] page.

Enabling trace on client and stand-alone applications

When stand-alone client applications (such as Java applications which access enterprise beans hosted in
WebSphere Application Server) have problems interacting with WebSphere Application Server, it might be
useful to enable tracing for the application. Enabling trace for client programs will cause the WebSphere
Application Server classes used by those applications, such as naming-service client classes, to generate
trace information.

About this task

A common troubleshooting technique is to enable tracing on both the application server and client
applications, and match records according to timestamp to try to understand where a problem is occurring.

You can also configure tracing from the MVS console using the modify command.
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Procedure

1. To enable trace for the WebSphere Application Server classes in a client application, add the system
properties shown in the following example to the startup script or command of the client application.
The location of the output and the classes and detail included in the trace follow the same rules as for
adding trace to WebSphere Application Servers. For example, trace the stand-alone client application
program named com.ibm.sample.MyClientProgram, enter the following command:
java -DtraceSettingsFile=MyTraceSettings.properties
-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager
-Djava.util.logging.configureByServer=true com.ibm.samples.MyClientProgram
The file identified by file name must be a properties file placed in the class path of the application
client or stand-alone process. You must create a trace properties file by copying the
%install_root\properties\TraceSettings.properties file to the same directory as your client
application Java archive (JAR) file.

You cannot use the -DtraceSettingsFile=TraceSettings.properties property to enable tracing of the
ORB component for thin clients. ORB tracing output for thin clients can be directed by setting
com.ibm.CORBA.Debug.Output = debugOutputFilename parameter in the command line.

The java.util.logging.manager and java.util.logging.configureByServer system properties configure Java
logging to use a WebSphere Application Server-specific LogManager class and to use the
configuration from the file specified by the traceSettingsFile property. The default Java Logging
properties file, located in the Java SE Runtime Environment 6 (JRE6), will not be applied.

2. You can also specify a trace string for writing messages with the Trace String property, Specify a
startup trace specification similar to that available on the server. For your convenience, you can enter
multiple individual trace strings into the trace settings file, one trace string per line.

Results

Here are the results of using each optional property setting:

» Specify a valid setting for the traceFileName property without a trace string to write messages to the
specified file or System.out only.

» Specify a trace string without a traceFileName property value to generate no output.

» Specify both a valid traceFileName property and a trace string to write both message and trace entries
to the location specified in the traceFileName property.

Tracing and logging configuration

Configure tracing and logging settings to help diagnose problems or evaluate system performance.

You can configure the application server to start in a trace-enabled state by setting the appropriate
configuration properties. You can only enable trace for an application client or stand-alone process at
process startup.

You can also configure tracing from the MVS console using the modify command.

In WebSphere Application Server, V6 and later, a logging infrastructure, extending Java Logging, is used.

This results in the following changes to the configuration of the logging infrastructure in WebSphere

Application Server:

* Loggers defined in Java logging are equivalent to, and configured in the same way as, trace
components introduced in previous versions of WebSphere Application Server. Both are referred to as
"components."

» Both Java logging levels and WebSphere Application Server levels can be used. The following is a
complete list of valid levels, ordered in ascending order of severity:

Trace option Output file

all trace.log
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Trace option Output file

finest or debug trace.log

finer or entryExit trace.log

fine or event trace.log

detail SystemOut.log

config trace.log and SystemOut.log (If tracing is not enabled, the

output file is SystemOut.log)

info trace.log and SystemQut.log (If tracing is not enabled, the
output file is SystemOut.log)

audit trace.log and SystemOut.log (If tracing is not enabled, the
output file is SystemOut.log)

warning trace.log and SystemOut.log (If tracing is not enabled, the
output file is SystemOut.log)

severe or error trace.log and SystemOut.log (If tracing is not enabled, the
output file is SystemOQOut.log)

fatal trace.log and SystemQut.log (If tracing is not enabled, the
output file is SystemOut.log)

off trace.log and SystemOut.log (If tracing is not enabled, the
output file is SystemOut.log)

+ Setting the logging and tracing level for a component to all will enable all the logging for that
component. Setting the logging and tracing level for a component to off will disable all the logging for
that component.

* You can only configure a component to one level. However, configuring a component to a certain level
enables it to perform logging on the configured level and any higher severity level.

» Several levels have equivalent names: finest is equivalent to debug; finer is equivalent to entryExit; fine
is equivalent to event; severe is equivalent to error.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Java Logging does not distinguish between tracing and message logging. However, previous versions of
WebSphere Application Server have made a clear distinction between those kind of messages. In
WebSphere Application Server, V6 and later, the differences between tracing and message logging are as
follows:

» Tracing messages are messages with lower severity (for example, tracing messages are logged on
levels fine, finer, finest, debug, entryExit, or event).

» Tracing messages are generally not localized.

* When tracing is enabled, a much higher volume of messages will be produced, and the trace output will
be in the trace file, not the SystemOut/Err log files. The trace file will only appear if tracing is enabled.

* Tracing messages provide information for problem determination.
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Trace and logging strings

In WebSphere Application Server, V5.1.1 and earlier, trace strings were used for configuring tracing only.
Starting in WebSphere Application Server, Version 6 and later, the "trace string" becomes a "logging
string"; it is used to configure both tracing and message logging.

In WebSphere Application Server, V5.1.1 and earlier, the trace service for all WebSphere Application
Server components is disabled by default. To request a change to the current state of the trace service, a
trace string is passed to the trace service. This trace string encodes the information detailing which level of
trace to enable or disable and for which components.

In all versions of WebSphere Application Server, the tracing for all components is disabled by default. To
change to the current state of the tracing and message logging, a logging string must be constructed and
passed to the server. This logging string specifies what level of trace or logging to enable or disable for
specific components.

You can type in trace strings (or logging strings), or construct them using the administrative console. Trace
and logging strings must conform to a specific grammar.

For WebSphere Application Server, V5.1.1 and earlier, the specification of this grammar is as follows:
TRACESTRING=COMPONENT TRACE_STRING[:COMPONENT TRACE_STRING]=*

COMPONENT_TRACE_STRING=COMPONENT_NAME=LEVEL=STATE[,LEVEL=STATE]*

LEVEL

all | entryExit | debug | event

STATE

enabled | disabled

COMPONENT_NAME = COMPONENT | GROUP

For WebSphere Application Server, V6 and later, the previous grammar is supported. However a new
grammar has been added to better represent the underlying infrastructure:

LOGGINGSTRING=COMPONENT_LOGGING_STRING[:COMPONENT_LOGGING_STRING]*
COMPONENT_TRACE_STRING=COMPONENT_NAME=LEVEL

LEVEL = all | (finest | debug) | (finer | entryExit) | (fine | event )
| detail | config | info | audit | warning | (severe | error) | fatal | off

COMPONENT_NAME = COMPONENT | GROUP

The COMPONENT_NAME is the name of a component or group registered with the trace service logging
infrastructure. Typically, WebSphere Application Server components register using a fully qualified Java
class name, for example com.ibm.servlet.engine.ServletEngine. In addition, you can use a wildcard
character of asterisk (*) to terminate a component name and indicate multiple classes or packages. For
example, use a component name of com.ibm.servlet.” to specify all components whose names begin with
com.ibm.servlet. Use a wildcard character of asterisk (*) at the end of the component or group name to
make the logging string applicable to all components or groups whose names start with specified string.
For example, a logging string specifying "com.ibm.servlet.* as a component name will be applied to all
components whose names begin with com.ibm.servlet. When an asterisk (*) is used by itself in place of
the component name, the level the string specifies, will be applied to all components.

The following are examples of using an asterisk (*) in logging strings. Note that the asterisk (*) in the

logging string does not need to have a period (.) in front of it. The period (.) can be used anywhere in the

logging string.

* com.ibm.ejs.ras.*=all - enables tracing for all loggers with names starting with "com.ibm.ejs.ras.". If
there is a logger named "com.ibm.ejs.ras" it will not have trace enabled.
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* com.ibm.ejs.ras*=all - enables tracing for all loggers with names starting with "com.ibm.ejs.ras", such
as com.ibm.ejs.ras, com.ibm.ejs.raslogger, com.ibm.ejs.ras.ManagerAdmin

Note:

* In WebSphere Application Server, V5.1.1 and earlier, you could set the level to "all=disabled" to
disable tracing. This syntax, beginning with Version 6.0, will result in LEVEL=info; tracing will be
disabled, but logging will be enabled.

* In WebSphere Application Server, V6 and later, "info" is the default level. If the specified
component is not present (*=xxx is not found), *=info is always implied. Any component that is
not matched by the trace string will have its level set to info.

 If the logging string does not start with a component logging string specifying a level for all
components, using the "*" in place of component name, one will be added, setting the default
level for all components.

e STATE = enabled | disabled is not needed in Version 6 and later. However, if used, it has the
following effect:

"enabled" sets the logging for the component specified to the level specified
"disabled" sets the logging for the component specified to one level above the level specified.

Table 31. Logging string and resulting logging level. The following examples illustrate the effect that disabling has on
the logging level:

Logging string Resulting logging level Notes®

com.ibm.ejs.ras=debug=disabled com.ibm.ejs.ras=finer debug (version 5) = finest (version 6)

com.ibm.ejs.ras=all=disabled com.ibm.ejs.ras=info "all=disabled" will disable tracing;
logging is still enabled.

com.ibm.ejs.ras=fatal=disabled com.ibm.ejs.ras=off

com.ibm.ejs.ras=off=disabled com.ibm.ejs.ras=off off is the highest severity

Proceed from broad to specific trace specifications in the trace string

best-practices: Start the trace string from the most broad component groups and then select more
specific traces. The advantage to this approach is that the trace settings for classes or
packages that are contained in a larger group are specified correctly by including them
later in the trace string.

The logging string is processed from left to right. During the processing, part of the logging string might be
modified or removed if the levels they configure are overridden by another part of the logging string.

Groups that contain packages that disable traces disable any packages that are enabled previously on the
same line. For example:

*=0ff : MyGroupl=info : MyGroup2=finest : com.mycompany.mypackage.*=info : com.mycompany.mypackage.MyClass=finest

This trace string indicates that the only tracing should come from the MyGroup1 group, the MyGroup2
group, and the com.mycompany.mypackage.* package with more specific tracing for MyClass class. If you
reverse this string, all tracing is disabled.

Examples

Table 32. Version 5 and Version 6 strings. Examples of legal trace strings include:

Version 5 syntax Version 6 syntax
com.ibm.ejs.ras.ManagerAdmin=debug=enabled com.ibm.ejs.ras.ManagerAdmin=finest

com.ibm.ejs.ras.ManagerAdmin=all=enabled,event=disabled |com.ibm.ejs.ras.ManagerAdmin=detail
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Table 32. Version 5 and Version 6 strings (continued). Examples of legal trace strings include:

Version 5 syntax Version 6 syntax
com.ibm.ejs.ras.*=all=enabled com.ibm.ejs.ras.x=all
com.ibm.ejs.ras.*=all=enabled:com.ibm.ws.ras=debug= com.ibm.ejs.ras.*=all:com.ibm.ws.ras=finer
enabled,entryexit=enabled

Enabling trace at server startup

Use the administrative console to enable tracing at a server's startup. You can use trace to assist you in
monitoring system performance and diagnosing problems.

About this task

The diagnostic trace configuration settings for a server process determines the initial trace state for a
server process. The configuration settings are read at server startup and used to configure the trace
service. You can also change many of the trace service properties or settings while the server process is
running.

You can also configure tracing from the MVS console using the modify command.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Procedure
1. Start the administrative console.
2. Click Servers > Application Servers > server_name > Troubleshooting > Diagnostic Trace
Service.
3. Click Configuration.
4. Select whether to direct trace output to either a file or an in-memory circular buffer.

Note: Different components can produce different amounts of trace output per entry. Naming and
security tracing, for example, produces a much higher trace output than web container tracing.
Consider the type of data being collected when you configure your memory allocation and
output settings.

5. If the in-memory circular buffer is selected for the trace output set the size of the buffer, specified in
thousands of entries. This is the maximum number of entries that will be retained in the buffer at any
given time.

6. If a file is selected for trace output, set the maximum size in megabytes to which the file should be
allowed to grow. When the file reaches this size, the existing file will be closed, renamed, and a new
file with the original name reopened. The new name of the file will be based upon the original name
with a timestamp qualifier added to the name. In addition, specify the number of history files to keep.

7. Select the desired format for the generated trace.

8. Save the changed configuration.

9. To enter a trace string to set the trace specification to the desired state:
a. Click Troubleshooting > Logs and trace in the console navigation tree.
b. Select a server name.
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c. Click Change Log Level Details.

d. If All Components has been enabled, you might want to turn it off, and then enable specific
components.

e. Click a component or group name. For more information see the page on log level settings. If the
selected server is not running, you will not be able to see individual component in graphic mode.

f. Enter a trace string in the trace string box.
g. Select Apply, then OK.
10. Allow enough time for the nodes to synchronize, and then start the server.

Enabling trace on a running server

Use the administrative console to enable tracing on a running server. You can use trace to assist you in
monitoring system performance and diagnosing problems.

About this task

You can modify the trace service state that determines which components are being actively traced for a
running server by using the following procedure.

You can also configure tracing from the MVS console using the modify command.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemQut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Procedure
1. Start the administrative console.

2. Click Servers > Application Servers > server_name > Troubleshooting > Diagnostic Trace
Service.

3. Select the Runtime tab.

4. Select the Save runtime changes to configuration as well check box if you want to write your
changes back to the server configuration.

5. Change the existing trace state by changing the trace specification to the desired state.
6. Configure the trace output if a change from the existing one is desired.
7. Click Apply.

Diagnostic trace service settings

Use this page to configure diagnostic trace service settings.
Note: You can only access this page when the server is configured to use basic log and trace mode.

To view this page, click the following path:
+ Servers > Application Servers > server_name > Troubleshooting > Diagnostic Trace Service

Note: You can also configure tracing from the MVS console using the modify command.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
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Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Trace Output

Specifies where trace output should be written. The trace output can be written directly to an output file, or
stored in memory and written to a file on demand using the Dump button found on the run-time page.

Different components can produce different amounts of trace output per entry. Naming and security
tracing, for example, produces a much higher trace output than web container tracing. Consider the type of
data being collected when you configure your memory allocation and output settings.

File

Specifies to write the trace output to a self-managing log file. The self-managing log file writes messages
to the file until the specified maximum file size is reached. When the file reaches the specified size,
logging is temporarily suspended and the log file is closed and renamed. The new name is based on the
original name of the file, plus a timestamp qualifier that indicates when the renaming occurred. Once the
renaming is complete, a new, empty log file with the original name is reopened, and logging resumes. No
messages are lost as a result of the rollover, although a single message may be split across the two files.
If you select this option you must specify the following parameters:

¢« Maximum File Size

— Specifies the maximum size, in megabytes, to which the output file is allowed to grow. This attribute
is only valid if the File Size attribute is selected. When the file reaches this size, it is rolled over as
described above.

* Maximum Number of Historical Files
— Specifies the maximum number of rolled over files to keep.
* File Name
— Specifies the name of the file to which the trace output is written.

Runtime tab
Save runtime changes to configuration

Save runtime changes made on the runtime tab to the trace configuration as well. Select this box to copy
run-time trace changes to the trace configuration settings as well. Saving these changes to the trace
configuration will cause the changes to persist even if the application is restarted.

Trace Output

Specifies where trace output should be written. The trace output can be written directly to an output file, or
stored in memory and written to a file on demand using the Dump button found on the run-time page.

File

Specifies to write the trace output to a self-managing log file. The self-managing log file writes messages
to the file until the specified maximum file size is reached. When the file reaches the specified size,
logging is temporarily suspended and the log file is closed and renamed. The new name is based on the
original name of the file, plus a timestamp qualifier that indicates when the renaming occurred. Once the
renaming is complete, a new, empty log file with the original name is reopened, and logging resumes. No
messages are lost as a result of the rollover, although a single message may be split across the two files.
If you select this option you must specify the following parameters:

 Maximum File Size
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— Specifies the maximum size, in megabytes, to which the output file is allowed to grow. This attribute
is only valid if the File Size attribute is selected. When the file reaches this size, it is rolled over as
described above.

* Maximum Number of Historical Files
— Specifies the maximum number of rolled over files to keep.
* File Name
— View the file that is specified by the File Name parameter. This does not apply your configuration.

Select a server to configure logging and tracing

Use this page to select the server for which you want to configure logging and trace settings.
Application Servers

This page lists application servers in the cell and the nodes holding the application servers. The status
indicates whether a server is running, stopped, or encountering problems. If you are using the WebSphere
Application Server, Network Deployment product, this panel also shows the status of the application
servers.

When you select an application server, a panel is displayed that will allow you to choose which log or trace
task to configure for that application server.

To view this administrative console page, click Troubleshooting > Logs and Trace

Server
Specifies the logical name of the server.

Node

Specifies the name of the node for the application server.

Host name
Specifies the name of the host for the application server.

Version
Specifies the version for the application server.

Type

Specifies the type of application server.

Status

Indicates whether the application server is started or stopped. (WebSphere Application Server, Network
Deployment only)

Note that if the status is Unavailable, the node agent is not running in that node, and you must restart the
node agent before you can start the server.
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Log and trace settings

Use this page to view and configure logging and trace settings for the server.
Note: You can only access this page when the server is configured to use basic log and trace mode.

To view this administrative console page, click:
» Servers > Application Servers > server_name > Troubleshooting > Diagnostic Trace Service

Note: You can configure tracing from the MVS console using the modify command.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.log ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

Switch to HPEL Mode button
Use the Switch to HPEL Mode button to change the log and trace mode for the server to HPEL.

Note: Switching the server to HPEL log and trace mode requires a server restart.

Diagnostic Trace

The diagnostic trace configuration settings for a server process determine the initial trace state for a server
process. The configuration settings are read at server startup and used to configure the trace service. You
can also change many of the trace service properties or settings while the server process is running.

Change Log Level Details

Enter a log detail level that specifies the components, packages, or groups to trace. The log detail level
string must conform to the specific grammar described in this topic. You can enter the log detail level string
directly, or generate it using the graphical trace interface.

NCSA access and HTTP error logging

The NCSA access and HTTP error logging page enables you to configure the log settings for your HTTP
server.

Setting up component trace (CTRACE)

WebSphere Application Server for z/OS uses z/OS component trace (CTRACE) facilities to manage the
collection and storage of trace data. CTRACE data is written to address space buffers in private
(pageable) storage, which can be formatted using IPCS if a dump of the address space is taken. CTRACE
data can also be written to trace data sets on disk or tape using an external writer.

Before you begin

Although CTRACE data is primarily output for use by IBM service personnel, using CTRACE capabilities at
your installation allows you to have additional trace data available when a problem first occurs. Because
CTRACE efficiently uses system resources, you can collect valuable trace data with minimal impact on
performance. For detailed information about the CTRACE facilities, see [z/0S MVS Diagnosis: Tools and|
[Service Aids, GA22-7589
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About this task

If you choose to write CTRACE data to trace data sets, you must create an external writer. You can set up
separate trace data sets for each cell or for each WebSphere Application Server for z/OS release, or you
can use a single trace data set for all WebSphere Application Server activity on a particular z/OS system.

Procedure

To implement a CTRACE data trace, read the following articles on preparing and starting CTRACE in your
application server:

» [‘Preparing CTRACE controls and resources’|

* |“Starting CTRACE as part of WebSphere Application Server for z/OS initialization” on page 144{
 |“Starting CTRACE while WebSphere Application Server for z/OS servers are active” on page 145|
* |“CTRACE to collect trace data for Java server applications” on page 146|

Results

After you read articles you will be able to implement CTRACE data tracing in your applications.

Preparing CTRACE controls and resources
You must prepare CTRACE controls and resources before using it for trace data.

Before you begin

Before you start component trace (CTRACE) activity for WebSphere Application Server for z/OS servers,
you need to make some decisions about CTRACE controls and resources as well as create an external
writer if one is needed for trace data recording.

About this task

Perform the following steps to prepare CTRACE controls and resources:

Procedure

1. Decide whether to write CTRACE data to trace data sets (recommended) or keep CTRACE data in
memory buffers only.

2. If you wish to use trace data sets, perform these steps.

a. Decide whether to create one trace data set for all WebSphere Application Server activity on a
single z/OS system or separate trace data sets for each cell or WebSphere Application Server
release.

Trace data sets cannot be shared between z/OS systems; each system should have its own trace
data sets.

b. Choose names for the trace data sets.
To simplify external writer setup, include the z/OS system name in the data set name.

Recommendation: For a single trace data set for all WebSphere Application Server activity, use
something similar to SYS1.sysname.WAS390.CTRACE.

c. Allocate a trace data set on each z/OS system.
Note:

Do not specify DCB parameters RECFM, LRECL, or BLKSIZE; the external writer will
allocate them with record format VB and a system-optimal blocksize and logical record

Chapter 9. Working with trace 143



length. For trace data sets on disk, you should use a minimum of 10 cylinders (3390).
Secondary extents are ignored unless the NOWRAP option is specified when the external
writer is started. For example:

// EXEC PGM=IEFBR14
//TRACE DD DSN=SYS1.MVSS14.WAS390.CTRACE,UNIT=3390,V0L=SER=HPK19A,
/! SPACE=(CYL, (20,0)),DISP=(NEW,CATLG) ,DCB=DSORG=PS

d. Choose a job name for the external writer.

Recommendation: Use BBOWTR if the same trace data set is to be used for all WebSphere
Application Server activity on each z/OS system.

e. Create the external writer cataloged procedure.

1) Copy member BBOWTR from the WebSphere Application Server for z/OS product data set
SBBOJCL to SYS1.PROCLIB or another procedure library defined to the master scheduler.

2) Rename the procedure to the external writer job name that you chose.
3) Customize the cataloged procedure by providing your trace data set name where indicated.

4) If the cataloged procedure will be shared among several z/OS systems, make sure that the
trace data set DD statements point to the appropriate trace data sets on each system.

f. Choose a system user ID under which the external writer started task will run.

This user ID must have read/write access to the trace data sets; you may wish to use an existing
started task user ID such as the default started task user ID for your system. Use the following
RACF command or equivalent to cause the external writer cataloged procedure to run under the
started task user ID:

RDEFINE STARTED external _writer procname.* STDATA(USER(system_user ID)) TRACE(YES)

The external writer started task should run with at least as high a dispatching priority as the
WebSphere Application Server address spaces that will use it for tracing.

g. Start the external writer to verify that the steps above were performed correctly.
Enter the following MVS console command:
TRACE CT,WTRSTART=external_writer_procname
3. Create a CTRACE parmlib member.

a. Copy member BBOCTIOO from the WebSphere Application Server for z/OS product data set
SBBOJCL to a data set in your system parmlib concatenation.

b. Rename the parmlib member to CTIBBOxx, where xx is a two-character suffix to be associated
with the external writer.

This is the value that will be specified during WebSphere Application Server for z/OS
customization.

c. Customize the CTIBBOxx parmlib member to indicate whether trace data sets and an external
writer are to be used and, if so, whether the external writer should be started automatically when
WebSphere Application Server activates the CTRACE.

4. If you plan to use separate trace data sets for different WebSphere Application Server cells or
releases, repeat all of these steps while choosing a new external writer name and parmlib member
suffix for each.

Results

CTRACE for WebSphere Application Server is now set up. Use the parmlib member suffix to associate a
particular WebSphere Application Server for z/OS cell with the CTRACE options that you have chosen.

Starting CTRACE as part of WebSphere Application Server for z/OS
initialization

You can start CTRACE as part of the initialization process for a WebSphere Application Server for a z/OS
cell using this information.
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Before you begin

Make sure that you have properly prepared CTRACE controls and resources as described in

[CTRACE controls and resources” on page 143

About this task

Perform the following steps to start CTRACE as part of the initialization process for a WebSphere
Application Server for z/OS cell:

Procedure
1. Start the CTRACE external writer.

« If you want the external writer to write records to the trace data set until the existing extents are full

then overwrite the oldest records, use the following MVS console command:
TRACE CT,WTRSTART=procname

where procname is the name of the cataloged procedure for the CTRACE writer.

» If you want the external writer to fill all primary and secondary extents then terminate, add the
NOWRAP option as in the following example:
TRACE CT,WTRSTART=procname ,NOWRAP

» If the CTIBBOxx member for the cell contains a WTRSTART parameter, then no command is
necessary. If the external writer is not started, WebSphere Application Server will start it
automatically.

2. Start the WebSphere Application Server for z/OS application server using the generated instructions.

3. When you need to collect trace data for analysis, perform these steps.
a. Disconnect WebSphere Application Server for z/OS from CTRACE.
1) Use the following operator command:
TRACE CT,ON,COMP=cell_short_name
2) You will be prompted for additional options. Enter the following reply:
REPLY x,WTR=DISCONNECT,END
b. Stop the CTRACE external writer.
Use the following operator command:
TRACE CT,WTRSTOP=procname

where procname is the name of the cataloged procedure for the CTRACE writer.

Starting CTRACE while WebSphere Application Server for z/OS servers

are active

Use this page to start CTRACE when a WebSphere Application Server for z/OS server already is active.

Before you begin

Make sure that you have properly prepared CTRACE controls and resources as described in

[CTRACE controls and resources” on page 143

About this task

If you start a WebSphere Application Server for z/OS server before starting the CTRACE writer for

WebSphere, the server still gathers data in its trace buffers. This trace data is not available for use unless

you follow this procedure or until a dump of the server address space is taken.
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Perform the following steps to start CTRACE when a WebSphere Application Server for z/OS server
already is active:

Procedure
1. Perform the following tasks.
a. Start the CTRACE external writer.
Use the following operator command:
TRACE CT,WTRSTART=procname

where procname is the name of the cataloged procedure for the CTRACE writer.

b. If necessary, connect WebSphere Application Server for z/OS to a CTRACE writer other than the
one specified in the CTIBBO xx parmlib member.

1) Use this operator command:
TRACE CT,ON,COMP=cell_short_name

2) You will be prompted for additional options. Enter the following reply:
REPLY x,WTR=procname ,END

where procname is the name of the cataloged procedure for the CTRACE writer.
The CTRACE external writer begins writing the server's trace data to the location specified through the
WebSphere variable ras_trace_outputLocation.
2. When you need to collect trace data for analysis, perform these steps.
a. Disconnect WebSphere Application Server for z/OS from CTRACE.
1) Use the following operator command:
TRACE CT,ON,COMP=cell_short_name
2) You will be prompted for additional options. Enter the following reply:
REPLY x,WTR=DISCONNECT,END
b. Stop the CTRACE external writer.
Use the following operator command:
TRACE CT,WTRSTOP=procname

where procname is the name of the cataloged procedure for the CTRACE writer.

CTRACE to collect trace data for Java server applications

Applications that run in WebSphere Application Server for z/OS can use JRas to provide tracing support
that is consistent with WebSphere tracing.

Instrumented applications use the JRas interfaces and classes for logging and tracing; trace data is written
to the same component trace data set as the internal traces issued by the WebSphere Application Server
for z/OS runtime. So you can gather application trace data in the same locations, and use the same
commands to start and stop CTRACE for these JRas applications as you do for WebSphere Application
Server for z/OS server in which the applications are running.
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Chapter 10. Troubleshooting class loaders

Class loaders find and load class files. For a deployed application to run properly, the class loaders that
affect the application and its modules must be configured so that the application can find the files and
resources that it needs. Diagnosing problems with class loaders can be complicated and time-consuming.
To diagnose and fix the problems more quickly, use the administrative console class loader viewer to
examine class loaders and the classes loaded by each class loader.

Before you begin

This topic assumes that you have installed an application on a server supported by the product and you
want to examine class loaders used by the application or its modules. The modules can be web modules
(.war files) or enterprise bean (EJB) modules (.jar files). The class loader viewer enables you to examine
class loaders in a runtime environment.

This topic also assumes that you have enabled the class loader viewer service. Click Servers > Server
Types > WebSphere application servers > server_name > Class loader viewer service, enable the
service and restart the server.

About this task

The runtime environment of WebSphere Application Server uses the following class loaders to find and
load new classes for an application in the following order:

1. The bootstrap, extensions, and CLASSPATH class loaders created by the Java virtual machine
2. A WebSphere extensions class loader

3. One or more application module class loaders that load elements of enterprise applications running in
the server

4. Zero or more web module class loaders

_'__————_
Java class Juaders

WebSphere extensions

class Inader_//

-\-\-\_\-\—\_
T m e
Mﬁ module class loader

Application mndu@

——

Web module ﬂl@ ﬁeb module ciasskﬁ

Each class loader is a child of the previous class loader. That is, the application module class loaders are
children of the WebSphere extensions class loader, which is a child of the CLASSPATH Java class loader.
Whenever a class needs to be loaded, the class loader usually delegates the request to its parent class
loader. If none of the parent class loaders can find the class, the original class loader attempts to load the
class. Requests can only go to a parent class loader; they cannot go to a child class loader. After a class
is loaded by a class loader, any new classes that it tries to load reuse the same class loader or go up the
precedence list until the class is found.
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If the class loaders that load the artifacts of an application are not configured properly, the Java virtual
machine (JVM) might throw a class loading exception when starting or running that application.[‘Class|

lloading exceptions” on page 149 describes the types of exceptions caused by improperly configured class

loaders and suggests ways to use the class loader viewer to correct configurations of class loaders. The
types of exceptions include:

ClassCastException|
ClassNotFoundException|
NoClassDefFoundException|
UnsatisfiedLinkError

Use the class loader viewer to examine class loaders and correct problems with application or class loader
configurations.

Procedure
» Examine a tree view that lists all installed applications and their modules. The modules can be web

modules (.war files) or EJB modules (. jar files).

Click Troubleshooting > Class loader viewer to access the [Enterprise applications topology page}
Examine the class loader delegation hierarchy.

On the Enterprise applications topology page, select a module to access the Class loader viewer page.
The page lists the class loaders visible to web and EJB modules in an installed enterprise application.
This page helps you to determine which class loaders loaded files of a module and to diagnose
problems with class loaders.

The delegation hierarchy is determined by the class loader delegation mode, or class loader order,
specified for an application or web module. The value can be either Classes loaded with parent class
Toader first or Classes Toaded with local class loader first (parent last). Refer to the
[Configure class loaders| step for more information.

» Export information on class loaders.

1. On the [Class loader viewer page} click Export.

2. Select to open a browser or editor on the class loader information or to save the information to disk
in XML format.

3. Click OK, and specify any additional information requested by the system.

» Display information about class loaders visible to the module in an HTML table format.

On the|Class loader viewer page} click Table View. The Table View page displays the following
information:

Table 33. Table View page. Information available on class loader attributes.

Class loader attribute |Description

Delegation Indicates whether the class loader delegates the loading of the module to its parent class
loader. A value of true implies that the class loader of the parent application is being used
(Classes Toaded with parent class loader first). A value of false implies that the
module class loader is being used (Classes lToaded with Tocal class loader first
(parent last)). Refer to the [Configure class loaders|step for more information.

Classpath Lists the paths over which the class loader searches for classes and resources.

Classes Lists the names of classes loaded in the JVM by this class loader.

The Table View option does not return a value when out-of-memory errors are generated. The
out-of-memory errors might be related to a memory leak. To examine information about class loaders in
a table, resolve the out-of-memory problem, and then click Table View again.

e Search class loaders.

On the Class loader viewer page, click Search to access the on which you can search
class loaders for the following:
— Specific strings
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— Specific . jar files
— The names of files in a specific directory
— The names of files loaded by a specific class loader

The search is case-sensitive. [‘Class loading exceptions’] describes several uses of the Search page.

» Configure class loaders. You can configure class loaders for the following:
— All applications installed on a specific server.
— A specific application
— A specific web module

Note: For detailed information about server, application, and web class loaders, see the chapter on
class loading in the Developing and deploying applications PDF book.

Class loader configuration determines which class loader loads the classes and resource files for an
application or web module. Application and WAR module class loader configuration settings include
Class loader order and WAR class loader policy.

A Class loader order value can be either Classes Toaded with parent class loader first or Classes
Toaded with Tocal class loader first (parent last). The default is Classes Toaded with parent
class loader first. A class loader with the Classes Toaded with parent class Toader first mode
delegates loading a class or resource to its immediate parent class loader before searching its
classpath.

When troubleshooting class loading problems, you might need to override classes visible to a parent
class loader. To override such classes with those specific to an application, set the Class loader order
to Classes Toaded with Tocal class loader first (parent last) on the class loader that contains the
application classes on its classpath. An application can override classes visible to a parent class loader,
but doing so can result in a ClassCastException or UnsatisfiedLinkError if there is a mixed use of
overridden classes and non-overridden classes.

For example, under default class loader policies, a web module has its own Web module (WAR) class
loader to load its artifacts, which are typically in the WEB-INF/classes and WEB-INF/1ib directories. An
application module class loader is the immediate parent of this WAR class loader. To ensure that the
web module class loader searches these paths for a particular class or resource first, before delegating
the load operation to the application module class loader, set the Class loader order of the web
module to Classes loaded with Tocal class loader first (parent Tlast).

Class loader policies determine the structure of the application and WAR module class loaders. Under
the default policies, every running application EAR has its own application module class loader, and
every web module has its own WAR module class loader. The default policies ensure Java EE
compliance regarding visibility and isolation among application artifacts. Changing the default policies is
not suggested when troubleshooting class loading problems.

What to do next

If you continue to have class loader problems, refer to[“Class loading exceptions’] and to the class loading
chapter of the Developing and deploying applications PDF book.

Class loading exceptions

What kind of class-loading error do you see when you develop an application or start an installed
application?

« [“ClassCastException” on page 150

« [“ClassNotFoundException” on page 151|

* |“NoClassDefFoundException” on page 152|

+ [‘UnsatisfiedLinkError” on page 152]
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ClassCastException

A class cast exception results when the following conditions exist and can be corrected by the following
actions:

The type of the source object is not an instance of the target class (type).|

The class loader that loaded the source object (class) is different from the class loader that loaded the|

target class.|

The application fails to perform or improperly performs a narrow operation.|

The type of the source object is not an instance of the target class (type).

This is the typical class cast exception. You can diagnose whether the source object of a cast
statement is not an instance of the target class (type) by examining the class signature of the
source object class, then verifying that it does not contain the target class in its ancestry and the
source object class is different than the target class. You can obtain class information by inserting
a simple print statement in your code. For example:

System.out.printin( source.getClass().getName() + ":" + target.getClass().getName() );

Or use a javap command. For example:

javap java.util.HashMap
Compiled from "HashMap.java"
public class java.util.HashMap extends java.util.AbstractMap
implements java.util.Map,java.lang.Cloneable,java.io.Serializable {

The class loader that loaded the source object (class) is different from the class loader that loaded
the target class.

Assuming that the type of the source object is an instance of the target class, a class cast

exception occurs when the class loader that loaded the source object's class is different that the

class loader that loaded the target class. This condition might occur when the target class is

visible on the classpaths of more than one class loader in the WebSphere Application Server

runtime environment. To correct this problem, use the Search and Search by class name console

pages used to diagnose problems with class loaders:

1. Click Troubleshooting > Class loader viewer > module_name > Search to access the

2. For Search type, select Class/Package.

3. For Search terms, type the name of the class that is loaded by two class loaders.

4. Click OK. The Search by class name page is displayed, listing all class loaders that load the
class.

If there is more than one class loader listed, then the target class was loaded by more than
one class loader. Because the source object is an instance of the target class, the class loader
that loaded the source object class is different from the class loader that loaded the target
class.

5. Return to the [Class loader viewer page|and examine the classpath to determine why two
different class loaders load the class.

6. Correct your code so that the class is visible only to the appropriate class loader.

The application fails to perform or improperly performs a narrow operation.

A class cast exception can occur because, when the application is resolving a remote enterprise
bean (EJB) object, the application code does not perform a narrow operation as required. The
application must perform a narrow operation after looking up a remote object. Examine the
application and determine whether it looks up a remote object and, if so, the result of the lookup is
submitted to a narrow method.

The narrow method must be invoked according to the EJB 2.0 programming model. In particular,
the target class submitted to the narrow method must be the exact, most derived interface of the
EJB. This also causes a class cast exception in the WebSphere Application Server runtime
environment. Examine the application and determine whether the target class submitted to the
narrow method is a super-interface of the EJB that is specified, not the exact EJB type; if so,
modify the application to invoke narrow with the exact EJB interface.
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Lastly, if a class cast exception occurs during a narrow operation, verify that the narrow method is
being applied to the result of a remote EJB lookup, not to a local enterprise bean. A narrow is not
used for local lookups. Examine the application or module deployment descriptor to ensure that
the object being narrowed is not a local object.

ClassNotFoundException

A class not found exception results when the following conditions exist and can be corrected by the
following actions:

The class is not visible on the logical classpath of the context class Ioader.|

The application incorrectly uses a class loader API]

A dependent class is not visible.|

The class is not visible on the logical classpath of the context class loader.

The class not found is not in the logical class path of the class loader associated with the current
thread. The logical classpath is the accumulation of all classpaths searched when a load operation
is invoked on a class loader. To correct this problem, use the Search page to search by class
name and by Java archive (JAR) name:

1. Click Troubleshooting > Class loader viewer > module_name > Search to access the
[Search pagd

2. For Search type, select Class/Package.

3. For Search terms, type the name of the class that is not found.

4. Click OK. The Search by class name page is displayed, listing all class loaders that load the
class.

5. Examine the page to see if the class exists in the list.

6. If the class is not in the list, return to the Search page. For Search terms, type the name of
the .jar file for the class; for Search type, select JAR/Directory.

7. Click OK. The Search by Path page is displayed, listing all directories that hold the JAR file.

If the JAR file is not in the list, the class likely is not in the logical class path, not readable or an
alternate class is already loaded. Move the class to a location that enables it to be loaded.

The application incorrectly uses a class loader API.

An application can obtain an instance of a class loader and call either the loadClass method on
that class loader, or it can call Class.forName(class_name, initialize, class_loader) with that class
loader. The application may be incorrectly using the class loader application programming interface
(API). For example, the class name is incorrect, the class is not visible on the logical classpath of
that class loader, or the wrong class loader was engaged.

To correct this problem, determine whether the class exists and whether the application is properly
using the class loader API. Follow the steps in[The class is not visible on the logical classpath of
the context class loader] to determine whether the class is loaded. If the class has not been
loaded, attempt to correct the application and see if the class loads. If the class is in the class
path with proper permission and is not being overridden by another factory class, examine the API
used to load the class.

1. Click Troubleshooting > Class loader viewer > module_name > Search to access the class

loader|Search page

2. For Search type, select Class/Package.
For Search terms, type the name of the class.

4. Click OK. The Search by class name page is displayed, listing all class loaders that load the
class.

5. Examine the page to see if the class exists in the list.

6. If the class is in the list and a ClassNotFound exception was thrown, then the . jar file or class
is not in the correct context or a wrong API call in the current context was used.

w
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If the class is not in the list, return to the Search page and do the following:

a. Search for the class that generated the exception; that is, the class calling Class.forName.

b. See which class loader loads the class.

c. Determine whether the class loader has access or can load the class not found by
evaluating the class path of the class loader.

A dependent class is not visible.
When a class loader cisldr loads a class cls, the Java virtual machine (JVM) invokes clsldr to load
the classes on which cls depends. Dependent classes must be visible on the logical classpath of
clsldr, otherwise an exception occurs. This condition typically occurs when users make
WebSphere Application Server classes visible to the JVM, or make application classes visible to
the JVM or to the WebSphere extensions class loader. For example:
* Class A depends on Class B.
» Class A is visible to the WebSphere extensions class loader.
» Class B is visible on the local classpath of a WAR module class loader, not the WebSphere

extensions class loader classpath.

When the JVM loads class A using the WebSphere extensions class loader, it then attempts to
load Class B using the same class loader and ultimately creates a class not found exception.

To correct this problem:

1. Make the application-specific classes visible to the appropriate application class loader.

2. Search for the class not found (Class B).

3. If Class B is in the proper location, [search for the class|that loads the dependent class (Class
A) in the Class loader viewer.

4. If the class is loaded and a ClassNotFound exception was thrown, then the . jar file or class is
not in proper context or the wrong API call in the current context was used.

If no class was found, do the following:
a. Search for the class that generated the exception; that is, the class calling Class.forName.
b. See which class loader loads the class.
c. Determine whether the class loader has access or can load the class not found by
evaluating the class path of the class loader.
5. Ensure that the caller class (Class B) is visible to the JVM or WebSphere extensions class
loader.

NoClassDefFoundException
A no class definition found exception results when the following conditions exist and can be corrected by
the following actions:

The class is not in the logical class path.
Refer to [‘ClassNotFoundException” on page 151|for information.

The class cannot load.
There are various reasons for a class not loading. The reasons include: failure to load the
dependent class, the dependent class has a bad format, or the version number of a class.

UnsatisfiedLinkError

A linkage error results when the following conditions exist and can be corrected by the following actions:
« |A user action caused the error.|

» |System.mapLibraryName returns the wrong library file.|

« [The native library is already loaded.|

« |A dependent native library was used|

A user action caused the error.
Several user actions can result in a linkage error:

A library extension name is incorrect for the platform.
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System.loadLibrary is passed an incorrect parameter.

The library is not visible.
As a best practice, use the JVM class loader to find or load native libraries. WebSphere
Application Server prints the Java library path (java.library.path) when starting up. If the
JVM class loader is intended to load the library, verify that the path containing the native
library file is in the Java library path. If not, append the path to the platform-specific native
library environment variable or to the java.library.path system property of the server
process definition.

In general, the Java virtual machine invokes findLibrary() on the class loader xxx that
loads the class that calls System.loadLibrary(). If xxx.findLibrary() fails, the Java virtual
machine attempts to find the library using the JVM class loader, which searches the JVM
library path. If the library cannot be found, the Java virtual machine creates an
UnsatisfiedLinkError exception.

Thus, if a WebSphere class loader is intended to find a native library myNativelLib, the
library must be visible on the nativelibpath of the class loader that loads the class that
calls System.loadLibrary(myNativeLib). This practice is necessary or desirable in the
following situation:

* Native libraries for data source providers must be visible on the nativelibpath of the
WebSphere extensions class loader. In this case, add the path containing the native
library to the Native library path setting of the data source provider configuration.

» Shared libraries have a Native library path in their configuration. Because shared
libraries enable the versioning of application-specific libraries, consider specifying the
paths to any native libraries used by the shared library code in the shared library
configuration.

Ensure that the correct WebSphere class loader loads the class that calls
System.loadLibrary() and that the native library is visible on the Native library path
setting.

The native library is already loaded.
This condition can result from either of the following errors:

User error
Check for multiple calls to System.loadLibrary and remove any extraneous calls.

Error when an application restarts
The JVM has a restriction that only one class loader can load a native library at a time. An
error results when an application restarts before the garbage collector cleans up the class
loader from the stopped application. When the class that loads the native library moves, all
of the classes that depend on that native library and their dependencies also must move.

To correct this condition, move the loading of the native library to a class loader that does

not reload:

1. Locate all application classes that load native libraries or have native methods.

2. Identify any dependent classes for the classes in step 1, such as logging packages.

3. Create a server-associated shared library or an isolated shared library.

4. Move the JAR files loaded for classes in steps 1 and 2 from the application to the
shared library created in step 3.

5. Save your changes.

6. Redeploy the application and rerun the scenario.

For more information about invoking, creating, and managing shared libraries, read
“Managing shared libraries” in the Administering applications and their environment PDF
book.

Chapter 10. Troubleshooting class loaders 153



Classes within server-scoped libraries are loaded once for each server lifecycle, ensuring
that the native library required by the application is loaded once for each Java virtual
machine, regardless of the application's life cycle.

A dependent native library was used.
Dependent native libraries must be found or loaded by the JVM class loader. That is, if a native
library NL is dependent on another native library, DNL, the JVM class loader must find DNL on the
Java library path. This is because the JVM runs native code when loading NL; when it encounters
the dependency on DNL, the JVM native code can call only to the JVM class loader to resolve the
dependency. A WebSphere class loader cannot load a dependent native library.

Modify the platform-specific environment variable defining the Java library path (LIBPATH) to
include the path containing the unresolved native library.

Class loader viewer service settings

Use this page to configure the server to start the class loader viewer service when the server starts. The
Class Loader Viewer helps you diagnose problems with class loaders.

To view this administrative console page, click Servers > Server Types > WebSphere application
servers > server_name > Class loader viewer service.

Class loaders find and load class files. For a deployed application to run properly, the class loaders that
affect the application and its modules must be configured so that the application can find the files and
resources that it needs. Diagnosing problems with class loaders can be complicated and time-consuming.
To diagnose and fix the problems more quickly, enable the class loader viewer service on this page and
then use the console Class loader viewer to examine class loaders and the classes loaded by each class
loader. Click Troubleshooting > Class loader viewer to access the Class loader viewer in the console.

Enable service at server startup

Specifies whether or not the server attempts to start the class loader viewer service when the server
starts.

The default is not to start the class loader viewer service.

Enterprise application topology

Use this page to see where modules reside in a topology of enterprise applications. Knowing where a
module resides helps you to determine which class loader loaded a module and to diagnose problems with
class loaders.

To view this administrative console page, click Troubleshooting > Class loader viewer. This page lists all
installed applications and their modules in a tree view. The modules can be web modules (.war files) or
enterprise bean (EJB) modules (. jar files).

When deploying an application to a server or starting an application, you might encounter problems related
to class loaders. Use the console pages accessed from this page to troubleshoot errors such as the
following:

» ClassCastException

» ClassNotFoundException

* NoClassDefFoundException

» UnsatisfiedLinkError

You can use the Class loader viewer console pages without having to restart or manipulate the application.

154  Troubleshooting and support



Enterprise applications topology

Displays a tree hierarchy of applications installed on a server and lists the module files in the class paths
of the applications.

Expand the hierarchy for an application to see what web modules (.war files) and EJB modules (. jar files)
are in the application class path.

Click on a module name to examine the class loaders of the module.

Class loader viewer settings

Use this page to examine the class loaders visible to a web module (.war file) or enterprise bean (.ejb
file) in an installed enterprise application. This page helps you to determine which class loaders loaded
files of a module and to diagnose problems with class loaders.

To view this administrative console page, click Troubleshooting > Class loader viewer > module_name.

The module is currently running on all nodes and servers listed.

To learn more about classes used by the module and their class loaders, click a button:

Table 34. Class loader viewer buttons. Click a button to access information about classes.

Button Resulting action

Export Opens a dialog that enables you to view or save the class loader information on this page in an
XML file.

Table View Displays the Table view page, which provides information about class loaders visible to the
module in an HTML table format for each class loader. Such information includes:
Delegation

Whether the class loader delegates a load operation to its immediate parent before
searching its local classpath for a class or resource

Classpath
The local classpath, which includes the paths over which the class loader searches for
classes and resources, excluding the classpaths of any parent class loaders.

Classes
The names of classes loaded by the class loader

Search Displays the Search page, on which you can search class loaders for the following:
» Specific strings

* Specific . jar files

* The names of files in a specific directory

» The names of files loaded by a specific class loader

Class Loader

Displays a hierarchy of class loaders that affect the loading of classes used by the web or EJB module.
The Hierarchy tab displays the class loaders in a tree hierarchy. The Search Order tabs lists the class
loaders in the order in which the runtime environment uses them to find and load classes.

Expand a hierarchy of class loaders to view the following:
* Class loader names

» Arrows that point upwards beside class loader names, indicating that requests can go to a parent class
loader only and not go to a child class loader

* The names of classes that are loaded by a class loader
* The paths of property files and . jar files used by the classes
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The following class loaders might be in a hierarchy:

Table 35. Class loader name descriptions. Class loaders that might be in the hierarchy of class loaders.

Class loader name Description

JDK Extension Loader The JDK extensions class loader is a composite class loader that is
comprised of the Java virtual machine (JVM) bootstrap class loader, the
JVM extensions class loader and the JVM system class loader, which load
the core SDK classes and resources as well as classes and resources
visible on the JVM classpath.

WAS Extension Class Loader The WAS Extension Class Loader loads the WebSphere Application Server
classes, stand-alone resource classes, custom service classes, and custom
registry classes. At bootstrap, this class loader uses the ws.ext.dirs
system property to determine the path that is used to load classes. Each
directory in the ws.ext.dirs class path and every . jar file or compressed
.zip file in these directories is added to the class path used by this class
loader.

WAS Compound Class Loader The WAS Compound Class Loaders load classes and resources of
enterprise archive (EAR) modules, web application archive (WAR) modules,
and server-associated shared libraries. Under default class loader policies,
an instance of a WAS Compound Class Loader exists for each running
EAR and WAR module and for each class loader defined in the server
configuration.

Click on Classes to view a list of classes loaded by a class loader.

The class loader viewer service must be enabled to view the list of classes.

Search settings

Use this page to search for information about class loaders visible to a web module (.war file) or
enterprise bean (.ejb file) in an installed enterprise application. This page helps you diagnose problems
with class loaders.

To view this administrative console page, click Troubleshooting > Class loader viewer > module_name
> Search.

On the Search page, you can search class loaders for the following:
» Specific strings

» Specific . jar files

* The names of files in a specific directory

* The names of files loaded by a specific class loader

Search type

Specifies the type of items in which to search for the string.

Table 36. Search type fields. Type searchable information in a field and click Go.

Search type Instructions and resulting action

Class/Package In the Search terms field, type a class name or package name. After you select this search
type and click Go, the program searches class loaders for a class or package name. The
program displays a list of classes and packages that have the string in their name.

JAR/Directory In the Search terms field, type a .jar file name or directory name. After you select this
search type and click Go, the program searches class loaders for a . jar file or directory
name. The program displays a list of . jar files that have the string in their name and of all
files in directories that have the string in their name.
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Search terms
Specifies the string to be found in the items searched.

The search is case-sensitive. If the search string is classname, the string ClassName is not found.

The search matches the entire string. If the search type is JAR/Directory and the search string is
C:/WebSphere/AppServerd0603.185/java/jre/1ib/ext/CmpCrmf. jar, the entire path of the JAR file is
matched. If the search type is JAR/Directory and the search string is Cmp, the string Cmp is not found.

The search supports limited regular expressions. It supports the wildcard characters asterisk (*), question
mark (?), and percent sign (%). The wildcard characters * and % match zero or more characters; ? matches

exactly one character.

Table 37. Search strings with wildcard characters. Use the example search strings to see what items result from

searches.

Search string

Resulting matches

*Cmp* ltems that have Cmp in their name
*Cmp*. jar ltems that have Cmp in their name and that end in . jar
%Cmp% ltems that have Cmp in their name

%Cmp%.jar

ltems that have Cmp in their name and that end in . jar

*Cmp?rmf.jar

ltems that have a name with any characters before Cmp, then any one character,
and then rmf.jar

The search supports full regular expressions if the value for the search string starts and ends with a

forward slash (/).

Table 38. Search strings with regular expressions. Use the example search strings to see what items result from

searches.

Search string

Resulting matches

/.*Cmp.*/

ltems that contain any character before and after Cmp in their name

/.*Cmp.*\.jar/

ltems that have Cmp in their name and that end in . jar

/.*Cmp?rmf\.jar/

ltems that have a name with any characters before Cmp, then any one character,
and then rmf.jar

/.x\d\.jar/

ltems with a name that ends in a number followed by . jar
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Chapter 11. Choosing and using diagnosis tools and controls
on z/0OS

Below is a description of the types of tools and controls you can use for diagnosing and managing
problems in the product environment.

Before you begin

The product uses a variety of different tools and server controls to help you collect specific types of data to
determine where your servers are encountering problems. To efficiently use these tools you need to be
aware of the different functions each can provide and what type of information will be available from each.

Note: This topic references one or more of the application server log files. Beginning in WebSphere
Application Server Version 8.0 you can configure the server to use the High Performance
Extensible Logging (HPEL) log and trace infrastructure instead of using SystemOut.Tog ,
SystemErr.log, trace.log, and activity.log files or native z/OS logging facilities. If you are using
HPEL, you can access all of your log and trace information using the LogViewer command-line tool
from your server profile bin directory. See the information about using HPEL to troubleshoot
applications for more information on using HPEL.

About this task

When your applications or servers are experiencing problems that may be originating from different
sources, use the tools below to collect data and information on processes in your environment. Each tool
has functions specific to different parts of the product, and they can be used in concert to help you better
diagnose your problems.

Procedure

Use the following z/OS tools to access and work with diagnostic information.
» 2/OS console

The console displays configuration errors that cause the termination of the product address spaces.
Whatever goes to the console also goes to SYSLOG.
» System log (SYSLOG)

SYSLOG is the repository for all messages that have appeared on the operator console. It also contains
warning and informational messages that might be helpful after a failure has occurred.
* Job log

The job log contains errors and warnings (non-termination) that are related to configuration. Anything
that goes to the console and SYSLOG automatically goes to the job log.
» System output (SYSOUT)

SYSOUT is a batch log that usually contains diagnostic data from the Java Virtual Machine (JVM) that
runs in the servant. Any messages written to stderr will end up in SYSOUT. In addition, SYSOUT might
contain error messages that usually appear in the log stream, but were redirected to SYSOUT, because
the log stream was not available.

* Error log

The error log contains messages issued through Java logging and JRas support, if any. In addition, the
error log usually contains messages that are only intended for IBM use. These messages support
actions, problems, or issues that are usually externalized through additional messages that are issued
by other functions. When you work with IBM Support personnel, you might be asked to supply the error
log so that service personnel can use these support messages to help diagnose the problem.

Note: You must update the CFRM policy before using log streams that are CF-resident, such as the
WebSphere error log and RRS logs. See |Updating the CFRM policy| for details.
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SYSPRINT

SYSPRINT contains component trace (CTRACE) output for clients, and for servants when the product is
configured to use SYSPRINT instead of CTRACE buffers and data sets.
Component trace (CTRACE) data set

CTRACE data sets contain diagnostic trace entries for various processes, depending on the trace
options configured for the product.
Logrec

When an error occurs, the system records information about the error in the logrec data set or the
logrec log stream. The information provides you with a history of all hardware failures, selected software
errors, and selected system conditions.

Transaction XA Partner Log

This log is used for recovery of XA resources. When an application accesses XA resources, the product
stores information about the resource to enable XA transaction recovery. For instructions on how to use
the Profile Management Tool or the zpmt command to configure the Transaction XA Partner Log see the
"Customization variables: Stand-alone application server cell" topic in the installing your application
serving environment section. For instructions on how to change the location of the Transaction XA
Partner Log, see the transaction service settings information.

SDSF

Use the SDSF DA panel to see how many application server address spaces are active, and observe at
the CPU%, ECPU% and SIO rate. Use the "ENC" panel to see the enclaves running and what service
classes they are running under.

RMF™

See [Chapter 12, “Using RMF,” on page 185]for instructions on starting and using RMF to monitor your
transactions.
MODIFY command

See the getting help for the modify command example documentation for instructions on using the z/OS
modify command to display information about the product servers or servants.

To find additional information about these tools, and about the process of diagnosing problems on z/OS,
use the [z/OS product library|to access the following books:

z/0OS MVS Diagnosis: Procedures, GA22-7587, which helps you diagnose problems in the MVS
operating system, its subsystems, its components, and in applications running under the system.
z/0OS MVS Diagnosis: Tools and Service Aids, GA22-7589, which provides detailed information about
tools and service aids that can help you diagnose problems. This book contains a guide on how to
select the appropriate tool or service aid for your purposes, and also provides an overview of all the
tools and service aids available.

Troubleshooting using WebSphere variables

Troubleshooting problems can be performed by changing certain variables in your application environment.

Before you begin

WebSphere Application Server for z/OS provides configuration variables that control server behavior.

Configuration variables may be set on a cell, node, or server level.

— Variable values set on a cell level apply to all servers in all nodes in the cell, unless a different value
for the same variable is set on a node or server level. Variable settings on a node or server level
override values for the same variable set at the cell level.

— Variables set on a node level apply to all servers in the node, unless a different value for the same
variable is set on the server level. Variable settings on a server level override values for the same
variable set at the node or cell level.

— \Variables set on a server level apply only to the specific server, not to any other servers in the same
node or cell.
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Note: When you are diagnosing particular problems, you are most likely to alter variable values on a
server level, for a particular server. Specifying variable values on the server level affects both the
controller and servant regions.

* You may use scripting interfaces, instead of the administrative console, to alter configuration variable
values.
* These variables allow you to control:

— Output destinations and characteristics for the error log, and for CTRACE bulffers, data sets and the

external writer.

— Trace buffers, data sets, and the content of trace data.

— Types of dumps to be requested.

— Timeout values for system and application behavior.

About this task

Depending on the types of problems you encounter, you might need to change the values set for
configuration variables that control WebSphere Application Server behavior. Generally speaking, the
default values are designed for normal operation in a production environment. Other circumstances might
require different values:

* When you first customize and verify WebSphere Application Server for z/OS installation, or

* When you test application workloads in a test environment, or

» when you encounter a problem, and need to collect more diagnostic data.

The following procedure explains how to use the administrative console to change configuration variable
values, commonly known as console settings.

Procedure

1. Click Environment -> Manage WebSphere Variables in the console navigation tree.

2. On the WebSphere Variables page, select Server as the scope of the variable setting, and click
Apply.

3. On the WebSphere Variables page, click New.

4. On the Variable page, specify a name and value for the variable. So other people can understand
what the variable is used for, also specify a description for the variable. Then click OK.

5. Verify that the variable is shown in the list of variables.
6. Save your configuration.
7. To have the configuration take effect, stop the server and then start the server again.

Types of configuration variables

You can configure a variety of configuration variables to control the behavior of WebSphere Application
Server for z/OS.

These configuration variables allow you to control:

» Output destinations and characteristics for the error log, and for CTRACE buffers, data sets and the
external writer.

» Trace buffers, data sets, and the content of trace data.

* Types of dumps to be requested.

+ Timeout values for system and application behavior.

Log output destinations and characteristics
Use these variables to control log output destinations and characteristics.

client_ras_logstreamname=name: Specifies the name of the log stream for an application client
run-time to use for error information.

Default: If this variable is not specified, the client run-time uses SYSOUT.
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Example:
client_ras_logstreamname=MY.CLIENT.ERROR.LOG

gotcha: Do not put the log stream name in quotes. Log stream names are not data set names.

ras_default_msg_dd=DD_card_name: Redirects write-to-operator (WTO) messages that use the default
routing to hardcopy. These messages are redirected to the location identified through the DD card on the
server's JCL start procedure. These WTO messages are primarily messages that WebSphere Application
Server for z/OS issues during initialization.

Default: No default value is set; WTO messages that use default routing are sent to hardcopy.

Examples:
ras_default_msg_dd=MSGDD
ras_default_msg_dd=DFLTLOG

Example of the DFLTLOG DD card on the server's JCL start procedure:

//DFLTLOG DD SYSOUT=*

ras_hardcopy_msg_dd=DD_card _name: Redirects write-to-operator (WTO) messages that the product
routes to hardcopy. These messages are redirected to the location identified through the DD card on the
server's JCL start procedure. These WTO messages are primarily audit messages issued from Java code
during initialization.

Default: No default value is set; WTO messages that use hardcopy routing are sent to hardcopy.

Example:
ras_hardcopy_msg_dd=MSGDD

ras_log_logstreamName: Specifies the log stream that the produce uses for error information during
bootstrap processing. If the specified log stream is not found, or not accessible, a message is issued and
errors are written to the server's job log.

Default: If this variable is not specified, the product uses SYSOUT.

Example:
ras_log_logstreamName=MY.CB.ERROR.LOG

gotcha: Do not put the log stream name in quotes. Log stream names are not data set names.

Trace control settings
The following trace options allow you to capture the information needed to detect problems.

To view or set these options, use the WebSphere Application Server administrative console:
1. Select Environment > WebSphere variables.
2. Specify the variable name in the name field and specify the setting in the value field. You can also
describe the setting in the description field on this tab.
ras_trace_outputLocation=SYSPRINT | BUFFER | TRCFILE
Specifies where you want trace records to be sent:
* To SYSPRINT
* To a memory buffer (BUFFER), the contents of which are later written to a CTRACE data set

* To a trace data set (TRCFILE) specified on the TRCFILE DD statement in the start procedure for the
server.
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For servers, you can specify one or more values, separated by a space. For clients, you can only
specify SYSPRINT.

Defaults:

* For clients, SYSPRINT

» For all other processes, BUFFER

Example: ras_trace_outputlLocation=SYSPRINT BUFFER

ras_time_local=0 | 1
Specifies whether timestamps in trace records use Greenwich Mean Time (GMT) or local time. This
variable setting controls timestamp format in the error log, and in traces sent to SYSPRINT or
TRCFILE DD.

Default: 0 (GMT)
Example: ras_time_local=1 sets timestamps to local time.

Daemon_ras_trace_ctraceParms=SUFFIX | MEMBER_NAME
Identifies the CTRACE PARMLIB member. The value can be either:

* A two-character suffix, which is added to the string CTIBBO to form the name of the PARMLIB
member, or

* The fully specified name of the PARMLIB member. A fully specified name must conform to the
naming requirements for a CTRACE PARMLIB member.

If the specified PARMLIB member is not found, tracing is defined to CTRACE, but there is no
connection to a CTRACE external writer.

Note: The Daemon is the only server that recognizes this environment variable.

Default: None

Example: Daemon_ras_trace_ctraceParms=01 identifies PARMLIB member CTIBBOO1

ras_trace_BufferCount= n
Specifies the number of trace buffers to allocate. Valid values are 4 through 8.

Default: 4
Example: ras_trace_BufferCount=6

ras_trace BufferSize= n
Specifies the size of a single trace buffer in bytes. You can use the letters K (for kilobytes) or M (for
megabytes). Valid values are 128K through 4M.

Default: 1M
Example: ras_trace_BufferSize=2M

ras_trace_log_version= n
Specifies the version of trace log to display. Valid values are 1 and 2.

Default: 2
Example: ras_trace_log_version=1
Trace log stream record output

This article provides an example of the trace log stream output and explains the various attributes it
contains.

If you do not want the message tag to be included in the trace log output, complete the following actions:
1. In the administrative console, click Environment > WebSphere variables.
2. Select the appropriate scope, and then click New.
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3. Enter ras_trace_log_version in the Name field and 1 in the Value field.
4. Save and synchronize your changes, and then stop, and restart the server.

Sample output from the trace log: The numbers to the left of each sample were added to specify lines.
The numbers will not be in the actual output.

1| Trace: 2009/07/14 17:26:19.577 02 t=6C8B58 c=UNK key=P8 tag=jperf
(13007002)

ThreadId: 0000002d

FunctionName: PingServiet

Sourceld: PingServiet

Category: AUDIT

ExtendedMessage: BB000222I: Audit Message from PingServlet

OB W

The log stream record output fields from stream BB0.BOSSXXXX are:

Table 39. Parts table for a server log stream record output. Components and descriptions.

Component Description

line 1: Trace: 2009/07/14 17:26:19.577 02 Date / timestamp / 2-digit record version number
line 1: t=6C8B58 Thread address

line 1: c=UNK Cell name

line 1: key=P8 System protection key

line 1: tag=jperf Message tag from classification file
line 1: (13007002) Trace specific value for this trace point
line 2: ThreadId: 0000002d Thread ID

line 3: FunctionName:PingServiet Function Name

line 4: Sourceld:PingServiet Source ID

line 5: Category:AUDIT Category

line 6: ExtendedMessage: BB000222I: Audit Extended Message

Message from PingServiet

Attention:  Each field is delimited by a blank.

Dump control settings
Use these settings to manage the dump control configuration in WebSphere Application Server.
ras_dumpoptions_dumptype= n
Specifies the default dump used by the signal handler. Valid values and their meanings are:
« 0
No dump is generated.
e 1
A ctrace dump is taken.
. 2
A cdump dump is taken.
3
A csnap dump is taken.
4
A CEE3DMP dump is taken.

Note: CEE3DMP dumps are not available in WebSphere Application Server for z/OS with 64-bit
support. If this option is chosen, it will be ignored in 64-bit environments.
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CEE3DMP generates a dump of Language Environment® and the member language libraries.
Sections of the dump are selectively included, depending on dump options specified, either by
default or through the

ras_dumpoptions_Tedumpoptons

variable. By default, this value passes
THREAD (ALL) BLOCKS

to CEE3DMP. You can override the default options for CEE3DMP through the

ras_dumpoptions_Tedumpoptons

variable. For more information about CEE3DMP and its options, see [z/0S Language|
[Environment Programming Reference, SA22-7562.}

Default: 3

Example:
ras_dumpoptions_dumptype=2
ras_dumpoptions_ledumpoptons= options
Specifies dump options to be used with a CEE3DMP. If you want more than one option, separate
each option with a blank. Specifies dump options to be used with a CEE3DMP. If you want more
than one option, separate each option with a blank.

This WebSphere variable is used only when you specify
ras_dumpoptions_dumptype=4

. For an explanation of CEE3DMP and valid dump options, see [z/0S Language Environment|
[Programming Reference, SA22-7562.|

Rule: The maximum length of the option string on this environment variable is 255. If the option
string is longer than 255, you receive message BBOM0011W and the CEE3DMP dump options
are set to

THREAD (ALL) BLOCKS

Default:
THREAD (ALL) BLOCKS

Example:
ras_dumpoptions_Tledumpoptons=NOTRACEBACK NOFILES

Timeout properties summary

You can use timeout properties to control the amount of time you allow for various requests to complete.
Some of these properties map to internal variable names. The internal variable names are provided here
to aid you with debugging.

Timer properties as they relate to configuring your message-driven beans to work with
listener ports or activation specifications

For WebSphere Application Server Version 7 and later, listener ports are deprecated. Therefore plan to
migrate your WebSphere MQ message-driven bean deployment configurations from using listener ports to
using activation specifications. However, do not begin this migration until you are sure that the application
does not have to work on application servers earlier than WebSphere Application Server Version 7. In
some cases, you continue to use the WebSphere MQ message-driven bean deployment and listener ports
and in other case you use the WebSphere MQ message-driven bean deployment and activation
specifications.
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The following properties DO NOT apply to activation specification driven message-driven bean
deployment. That is, the properties require you to configure them to use the WebSphere MQ
message-driven bean deployment and listener ports:

» control_region_mdb_request_timeout

» control_region_mdb_queue_timeout_percent

» server_region_mdb_stalled_thread_dump_action

The follow properties DO apply to activation specification driven message-bean deployment. That is, these
properties require you to configure them to use the WebSphere MQ message-driven bean deployment and
activation specifications.

» control_region_wlm_dispatch_timeout

» control_region_iiop_queue_timeout_percent

» server_region_iiop_stalled_thread_dump_action

As you follow the instructions to configure these properties, remember what properties apply to listener
ports versus activation specifications.

Object Request Broker (ORB) service advanced settings

ORB Tistener keep alive
In a non-secure socket layer (SSL) environment, this property defines the value, in seconds, that is
provided to TCP/IP on the SOCK_TCP_KEEPALIVE option for the IIOP listener. The function of this
option is to verify if idle sessions are still valid by polling the client TCP/IP stack. If the client does not
respond, then the session is closed. If the connection to the client is lost without the server receiving
notification, then the session remains active on the server side. Use this option to clean up these
unnecessary sessions.

« If this property is not set, then the TCP/IP option is not set.

» Setting the SOCK_TCP_KEEPALIVE option generates network traffic on idle sessions, which can
be undesirable.

Default: 0

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Container services > ORB service > z/OS
additional settings.

ORB SSL listener keep alive
In an SSL environment, this property defines the value, in seconds, that is provided to TCP/IP on the
SOCK_TCP_KEEPALIVE option for the IIOP listener. The function of this option is to verify if idle
sessions are still valid by polling the client TCP/IP stack. If the client does not respond, then the
session is closed. If the connection to the client is lost without the server receiving notification, then
the session remains active on the server side. Use this option to clean up these unnecessary
sessions.

* |f this property is not set, then the TCP/IP option is not set.

» Setting the SOCK_TCP_KEEPALIVE option generates network traffic on idle sessions, which can
be undesirable.

Default: 0

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Container services > ORB service > z/0S
additional settings.

WLM timeout
Specifies the maximum amount of time, in seconds, that workload management (WLM) waits for [IOP
requests to complete. This time limit includes:

* The time during which the 1IOP request waits on the WLM queue until being dispatched to a servant
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* The time during which an application component, running in the servant, processes the request and
generates a response

The server generates a failure response if this processing does not complete within the specified time.

Attention: This setting does not apply for HTTP requests or scalable messaging support; for that
type of work, the value specified for the ConnectionResponseTimeout server custom property controls
the time allowed for dispatching work to a servant.

Default: 300 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Container services > ORB service > z/OS
additional settings.

Internal variable name (for debugging purposes): Locate the internal variable name,
control_region_wIm_dispatch_timeout, in the was.env file or the JES job log.

Example: WLM timeout=600

Use the control_region_iiop_queue_timeout_percent server custom property to designate a percentage
of the WLM timeout as the amount of time a request can remain on the WLM queue.

Request timeout
Specifies, in seconds, the maximum time that the client waits for the response to a client request. The
value specified for this field is a server wide setting that affects all outbound RMI/IIOP enterprise bean
invocations that are made on this server.

Because the sysplex TCP/IP that runs through the coupling facility does not always tell the client when
the other end of the socket has closed, clients can wait indefinitely for a response unless you set this
property. Setting the Request timeout property ensures that the client gets a response within the
specified time, even if the response is a COMM_FAILURE exception.

Default: O (unlimited). No timeout value is set.

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_ name > > Container services > ORB service > z/0S
additional settings.

If you use command-line scripting, the full name of this system property is
com.ibm.CORBA.RequestTimeout.

Example: Specifying Request timeout=2, sets the time limit to 2 seconds.

Transaction service timeout properties

Total Transaction Lifetime Timeout
Specifies the maximum amount of time, in seconds, that the J2EE server waits for an application
transaction that originated in this server to complete if the application transaction does not set its own
timeout value through the UserTransaction.setTransactionTimeout() method.

If the application transaction is not committed or rolled back within the specified time, the application
transaction is marked for rollback and is allowed to continue running for a grace period of
approximately 4 minutes. If the application transaction is committed or rolled back during the grace
period, then the outcome of the transaction is always rolled back. If the application transaction does
not complete after the grace period, then the controller abnormally ends the servant in which the
application component is running with ABEND EC3 RSN=04130002 or 04130005.

gotcha: Only the total transaction lifetime timeout and the maximum transaction timeout have grace
periods.

Setting this value to 0 indicates that the timeout does not apply, and the value of the maximum
transaction timeout is used instead.
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Default: 120 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Container services > Transaction service.

Internal variable name (for debugging purposes): Locate transaction_defaultTimeout in the was.env
file or the JES job log file.

Maximum transaction timeout
Specifies the maximum amount of time, in seconds, that the J2EE server waits for an application
transaction that is propagated into this server to complete. This value also applies to transactions that
are started in this server, if their associated applications do not set a transaction timeout and the total
transaction lifetime timeout is set to 0.

This value constrains the upper bound of all other timers. If an application uses the
UserTransaction.setTransactionTimeout() method to specify a longer length of time, then the J2EE
server changes the application setting to the value specified for the Maximum transaction timeout
property.

Setting this value to 0 indicates that the timeout does not apply, and any transactions that are affected
by this timeout never time out.

Default: 300 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Container services > Transaction service.

Internal variable name (for debugging purposes): Locate the internal variable name,
transaction_maximumTimeout, in the was.env file or the JES job log.

transaction_recoveryTimeout
Specifies the time, in minutes, that this controller uses to attempt to resolve in-doubt transactions
before issuing a write-to-operator-with-reply (WTOR) message to the console that asks whether the
controller should perform the following actions:

+ Stop trying to resolve in-doubt transactions.

» Write transaction-related information to the job log or hardcopy log and terminate.

If the operator replies that recovery is to continue, then the controller attempts recovery for the
specified amount of time before reissuing the WTOR message. After all the transactions are resolved,

the controller region terminates. This property applies only to controllers in peer restart and recovery
mode.

Default: 15 minutes

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the transaction_recoveryTimeout property in the Name field, and specify a
different value in the Value field.

Internal variable name (for debugging purposes): Locate transaction_recoveryTimeout in the
was.env file or the JES job log.

Example: transaction_recoveryTimeout=7

Server custom properties

control_region_mdb_request_timeout
Specifies the time, in seconds, that the server waits for a message driven bean (MDB) request to
receive a response. If the response is not received within the specified amount of time, then the
servant might abnormally terminate with an EC3 ABEND, RSN=04130008. You can set this value to 0
if you need to disable this function.

Default: 120
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How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the control_region_mdb_request_timeout property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate control_region_mdb_request_timeout in
the was.env file or the JES job log. See the application server z/OS custom properties documentation
for additional information.

Example: control_region mdb request timeout=180

Use the control_region_mdb_queue_timeout_percent server custom property name to designate a
percentage of the value specified for the control_region_mdb_request_timeout property as the amount
of time that a MDB request can remain on the WLM queue. The control_region_mdb_request_timeout
custom property specifies the combined amount of time that the request spends on the WLM queue
and in dispatch. The control_region_mdb_queue_timeout_percent property only applies to the amount
of time that the request spends on the WLM queue.

control_region_timeout_save_last_servant
When set to 1, this property indicates that, when the wim_minimumSRCount custom property is set to
a value that is greater than 1, then the last available servant is not abnormally terminated because of
a timeout situation. The servant can be abnormally terminated after a new servant region starts to
accept work requests. This setting enables work requests to continue without interruption. However,
setting this property to 1 might cause a loss of system resources if the dispatched servant thread that
timed out continues to loop or becomes inactive, preventing the servant threads assigned to this
servant from being released.

This property can be set to 0 or 1.
The setting for this property is ignored if the wim_dynapplenv_single_server property is set to 1.
Default: 0

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the control_region_timeout_save_last_servant property in the Name field, and
specify 1 in the Value field.

Internal variable name (for debugging purposes): Locate control_region_timeout_save_last_servant
in the was.env file or the JES job log.

protocol_http_timeout_output_recovery
Controls the recovery action taken on timeouts for requests received over the HTTP transport.
Specifying SERVANT allows for the termination of servants when timeouts occur. If an HTTP request is
under dispatch in a servant when its timeout value is reached, then the servant terminates with an
ABEND EC3 RSN=04130007. The HTTP request and socket are then cleaned up. A setting of SESSION
only cleans up the HTTP request and socket. No attempt is made to disrupt the processing of a
dispatched HTTP request within a servant. Using the session setting might result in a loss of
resources if the dispatched HTTP request loops or becomes inactive.

Default: SERVANT

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the protocol_http_timeout_output_recovery property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate protocol_http_timeout_output_recovery in
the was.env file or the JES job log.

Example: protocol http timeout output recovery=SERVANT
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protocol_https_timeout_output_recovery
Controls the recovery action taken on timeouts for requests received over the HTTPS transport.
Specifying SERVANT allows for the termination of servants when timeouts occur. If an HTTP request is
under dispatch in a servant when its timeout value is reached, then the servant terminates with an
ABEND EC3 RSN=04130007. The HTTPS request and socket are then cleaned up. A setting of
SESSION only cleans up the HTTPS request and socket. No attempt is made to disrupt the processing
of a dispatched HTTPS request within a servant. Using the session setting might result in a loss of
resources if the dispatched HTTPS request loops or becomes inactive.

Default: SERVANT

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the protocol_https_timeout_output_recovery property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate protocol_https_timeout_output_recovery
in the was.env file or the JES job log.

Example: protocol _https timeout output recovery=SESSION

protocol_sip_timeout_output
Specifies the time, in seconds, that the server waits for a message driven bean (MDB) request, that
was sent over a SIP transport channel, to receive a response. If the response is not received within
the specified amount of time, then the servant might abnormally terminate with ABEND EC3
RSN=04130008. You can set this value to 0 if you need to disable this function.

Default: 120

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the protocol_sip_timeout_output custom property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate protocol_sip_timeout_output in the
was.env file or the JES job log.

Example: protocol_sip_timeout_output=180

Use the control_region_sip_queue_timeout_percent server custom property name to designate a
percentage of the value specified for the protocol_sip_timeout_output property as the amount of time a
request can remain on the WLM queue.

protocol_sips_timeout_output
Specifies the time, in seconds, that the server waits for a message driven bean (MDB) request to
receive a response. If the response is not received within the specified amount of time, then the
servant might abnormally terminate with ABEND EC3 RSN=04130008. Set this value to 0 to disable
the function.

Default: 120

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the protocol_sips_timeout_output custom property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate protocol_sips_timeout_output in the
was.env file or the JES job log. for additional information.

Example: protocol_sips_timeout_output=180

Use the control_region_sips_queue_timeout_percent server custom property name to designate a
percentage of the value specified for the protocol_sips_timeout_output property as the amount of time
a request can remain on the WLM queue.
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protocol_sip_timeout_output_recovery
Controls the recovery action taken on timeouts for requests received over SIP. Specifying SERVANT
allows for the termination of servants when timeouts occur. If a SIP request is under dispatch in a
servant when its timeout value is reached, then the servant terminates with an ABEND EC3
RSN=04130007. The SIP request and socket are then cleaned up. A setting of SESSION only cleans up
the SIP request and socket. No attempt is made to disrupt the processing of a dispatched SIP request
within a servant. Using the session setting might result in a loss of resources if the dispatched SIP
request loops or becomes inactive.

Default: SERVANT

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the protocol_sip_timeout_output_recovery property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate protocol_sip_timeout_output_recovery in
the was.env file or the JES job log.

Example: protocol sip_timeout output recovery=SERVANT

protocol_sips_timeout_output_recovery
Controls the recovery action taken on timeouts for requests received over SIPS. Specifying SERVANT
allows for the termination of servants when timeouts occur. If an SIPS request is under dispatch in a
servant when its timeout value is reached, then the servant terminates with an ABEND EC3
RSN=04130007. The SIPS request and socket are then cleaned up. A setting of SESSION only cleans
up the SIPS request and socket. No attempt is made to disrupt the processing of a dispatched SIPS
request within a servant. Using the session setting might result in a loss of resources if the dispatched
SIPS request loops or becomes inactive.

Default: SERVANT

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the protocol_sips_timeout_output_recovery property in the Name field, and
specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate protocol_sips_timeout_output_recovery in
the was.env file or the JES job log.

Example: protocol sips_timeout output recovery=SERVANT

server_region_request_cputimeused_limit
Specifies, in milliseconds, the amount of CPU time that an application request can consume.

This property helps prevent a single application request from monopolizing the available CPU time
because it allows you to limit the amount of CPU time that a single request can use. A CPU monitor is
invoked when a request is dispatched. If the request exceeds the specified amount of CPU time, the
controller considers the request unresponsive. The controller then issues message BBOO0327, to let
the requesting application know that the request was unresponsive.

The monitor, that monitors the amount of CPU time that a request is using, typically sends a signal to
the dispatched thread when the amount of CPU time used exceeds the specified amount. However,
there are situations when this signal cannot be delivered, and the request remains pending. For
example, if the thread goes native and invokes a PC routine, the signal remains pending until the PC
routine returns.

After the signal is delivered on the dispatch thread, the WLM enclave, that is associated with the
dispatched request, is quiesced. This situation lowers the dispatch priority of this request, and this
request should now only get CPU resources when the system is experiencing a light work load.

server_region_stalled_thread_threshold_percent
Specifies the percentage of threads that can become unresponsive before the controller terminates the
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servant. When the default value of 0 is specified, the controller terminates the servant as soon as the
controller determines that at least one thread has become unresponsive.

Default: 0

How to specify: To specify this property, in the administrative console, click Environment >
WebSphere variables, select the appropriate node or cell from the list of available nodes and cells,
and then click New. Add the server_region_stalled_thread_threshold_percent property in the Name
field, and specify a different value in the Value field.

Internal variable name (for debugging purposes): Locate
server_region_stalled_thread_threshold_percent in the was.env file or the JES job log.

Example: server_region_stalled thread threshold percent=5
Java virtual machine (JVM) Custom properties

The following 2 JVM properties can be set by clicking Application Servers -> <SERVER> -> Process
Definition -> Servant -> Java Virtual Machine -> Custom Properties.

com.ibm.ws390.interrupt.disabl1eBB0J01221
If this property is set to 1, then message BB0J01221 is suppressed.

Data Type: Boolean
Default: 0
Used by Daemon: No. Only applicable to servant regions.

com.ibm.ws390.interrupt.applyDumpActionPreInterrupt
Specifies the need to gather documentation prior to attempting to progress a dispatched request. If
this property is set to 1, documentation specified by stalled_thread_dump_action is gathered prior to
any activities to encourage the dispatched request to complete (for example, prior to driving interrupt()
on any InterruptObject). The stalled_thread_dump_action defines which documentation to gather when
the request is considered hung, and any attempts to complete it have failed.

Data Type: Boolean
Default: 0

Used by Daemon: No. Only applicable to servant regions.
Secure sockets layer configuration repertoires

depfeat: System SSL for z/OS has been deprecated in WebSphere Application Server Version 8.0. Start
to convert any security scripts, that are based on System SSL, to use JSSE security.

V3 Timeout
Specifies the length of time, in seconds, that a browser can reuse a System SSL Version 3 session ID
without renegotiating encryption keys with the server. The repertoires that you define for a server
require the same V3 timeout value.

Default: 100

How to specify: To specify this property, in the administrative console, click Security > SSL
application servers > New SSL repertoire

Internal variable name (for debugging purposes): The following SSL configuration repertoire
timeout variables are set internally when you define your SSL repertoires:

e com_ibm_HTTP_claim_ssl_sys_v3_timeout
+ com_ibm_DAEMON_claim_ssl_sys_v3_timeout

Locate these internal variables in the was.env file or the JES job log.
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TCP transport channel timeout properties

Inactivity timeout property
Specifies the amount of time, in seconds, that the TCP transport channel waits for a read or write
request to complete on a socket.

gotcha: The value specified for this property might be overridden by the wait times established for
channels that are higher than this channel in the timer hierarchy. For example, the wait time
established for an HTTP transport channel overrides the value specified for this property for
every operation except the initial read on a new socket.

Default: 0 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_ name > Web container transport chains > TCP
inbound channel.

HTTP transport channel timeout properties

ConnectionResponseTimeout
Specifies a maximum amount of time, in seconds, that the server waits for an application component
to respond to an HTTP request.

Set this property for each of the HTTP transport channel definitions on the server. You must set this
property for both SSL transport channels and non-SSL transport channels. If the response is not
received within the specified length of time, then the servant might fail with ABEND EC3 and
RSN=04130007. Setting this timer prevents client applications from waiting for a response from an
application component that might be in a deadlock, looping, or encountering some other processing
problem that causes the application component to stop processing requests.

Default: 300 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name, and then, under Web Container Settings, click
Custom properties.

Internal variable name (for debugging purposes): If you are debugging a problem in SSL-enabled
transport, then locate the internal variable name, protocol_https_timeout_output, in the was.env file or
the JES job log. If you are debugging a problem in a non-SSL transport channel, then locate the
internal variable name, protocol_http_timeout_output, in the was.env file or the JES job log.

Use the control_region_http_queue_timeout_percent and control_region_https_queue_timeout_percent
application server custom properties to designate a percentage of the value specified for the
ConnectionResponseTimeout property as the amount of time that a request can remain on the WLM
queue.

Persistent timeout property
Specifies the amount of time, in seconds, that the HTTP transport channel allows a socket to remain
idle between requests.

Default: 30 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Web container transport chains > HTTP
inbound channel.

Read timeout property
Specifies the amount of time, in seconds, that the HTTP transport channel waits for a read request to
complete on a socket after the first read request occurs. The read that is completing might be an
HTTP body, such as a POST, or part of the headers if the headers were not all read as part of the first
read request on the socket.

Default: 60 seconds
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How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Web container transport chains > HTTP
inbound channel.

Write timeout property
Specifies the amount of time, in seconds, that the HTTP transport channel waits on a socket for each
portion of response data to be transmitted. This timeout typically occurs in situations where responses
lag behind new requests. This situation can occur when a client has a low data rate or the network
interface card (NIC) for the server is saturated with 1/0.

Default: 60 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Web container transport chains > HTTP
inbound channel.

HTTP transport timeout variables

depfeat: HTTP transport support is deprecated.

ConnectionI0OTimeQut
Specifies a maximum amount of time, in seconds, that the J2EE server waits for the complete HTTP
request to arrive. Set this property for each of the HTTP transport definitions on the server. You must
set this property for both SSL transport and non-SSL transport. The J2EE server starts the timer after
the connection has been established, and cancels the connection if a complete request does not arrive
within the specified maximum time limit. Specifying a value of 0 disables the timeout function.

Default: 10 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Web container > Custom properties.

gotcha: This panel is only available if an HTTP transport is defined for your application server
environment. If an HTTP transport is not defined for your environment, then you can use the
wsadmin scripting tool to define 1. However, it is recommended that you use an HTTP
transport channel instead of an HTTP transport whenever possible.

ConnectionResponseTimeout
Specifies a maximum amount of time, in seconds, that the J2EE server waits for an application
component to respond to an HTTP request. Set this property for each of the HTTP transport definitions
on the server. You must set this property for both SSL transport and non-SSL transport. If the
response is not received within the specified length of time, then the servant might fail with ABEND
EC3 and RSN=04130007. Setting this timer prevents client applications from waiting for a response
from an application component that might be in a deadlock, looping, or encountering some other
processing problem that causes the application component to stop processing requests.

Default: 120 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Web container > Custom properties.

Internal variable name (for debugging purposes): If you are debugging a problem in SSL-enabled
transport, then locate the internal variable name, protocol_https_timeout_output, in the was.env file or
the JES job log. If you are debugging a problem in non-SSL transport, then locate the internal variable
name, protocol_http_timeout_output, in the was.env file or the JES job log.

Use the control_region_http_queue_timeout_percent and control_region_https_queue_timeout_percent
server custom properties to designate a percentage of the ConnectionResponseTimeout property as
the amount of time that a request can remain on the WLM queue.
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ConnectionKeepAliveTimeout

Specifies the time, in seconds, that the J2EE server waits for a subsequent request from an HTTP
client on a persistent connection. If another request is not received from the same client within this
time limit, then the connection is closed.

Default: 30 seconds

How to specify: To specify this property, in the administrative console, click Servers > Server Types
> WebSphere application servers > server_name > Web container > Custom properties.

Run-time environment: Best practices for maintaining the runtime
environment

Use these guidelines to make sure that WebSphere Application Server for z/OS is customized and
maintained correctly, to support your installation's application workload.

Checking these basic software and hardware requirements can help you avoid problems with the run-time
environment.

Check that you have the necessary prerequisite software up and running. Check that they have

the proper authorizations and that the definitions are correct.

Check for messages that signal potential problems. Look for warning and error messages in the

following sources:

— SYSLOG from other z/OS subsystems and products, such as TCP/IP (especially the DNS, if in use),
RACF, and so on

— WebSphere Application Server for z/OS error log

— SYSPRINT of the WebSphere Application Server for z/OS

— Component trace (CTRACE) output for the server

Check the ports used by WebSphere Application Server. The ports that are used by WebSphere

Application Server must not be reserved by any other z/OS component.

Ensure that z/OS has enough DASD space for SVC dumps. You might have to adjust the amount of

space, because it depends on the size of your applications, on the configured Java virtual machine

(JVM) heap size, and on the number of servant regions that might be included in one dump, and so on.

For an SVC dump of one controller and one servant, you can start with a minimum of 512, but might

have to increase the MAXSPACE to 1024 or higher, given the factors listed above.

Check your general environment. Does your system have enough memory? Insufficient memory

problems can show up as AUX shortages, abends, or exceptions from the WebSphere Application

Server for z/OS run-time. Sometimes the heap size for Language Environment (LE) and for the Java

virtual machine (JVM) needs to be increased. If you are using RRS and DB2, make sure your system

has enough space for archive data sets.

Make sure all prerequisite fixes have been installed; a quick check for a fix can save hours of

debugging.

For the most current information on fixes and service updates, see:

— The Preventive Service Planning (PSP) buckets for both WebSphere Application Server for z/OS and
JAVA subsets of the WebSphere Application Server for z/OS Upgrade. To obtain a copy of the most
current versions of these PSP buckets, you can either contact the IBM Support Center, use S/390°®
SoftwareXcel or link to |IBMLink|

- The|Support web page of the WebSphere Application Server for z/OS| website, which contains a
table of the latest authorized program analysis reports (APARS).

With the latest service information, check the following:

— Ensure that all prerequisite PTFs (fixes) have been applied to the system.

— Verify that all PTFs were actually present in the executables that were used at the time of error.
Often, SMP can indicate that a fix is present and installed on the system when, in reality, the
executables that were used at the time of error did not contain the fix.

System controls: Best practices for using system controls
Use this information as the best way to configure system controls.
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* You have the option of using a z/OS system logger log stream as the product error log. The
ras_log_logstreamName property identifies which log stream you want to use for the error log; it has no
default setting. If you do not use a log stream, however, messages that usually appear in the error log
are directed to server's job log.

* You have the option of directing trace output to SYSPRINT or buffers. The ras_trace_outputLocation
property controls the location of trace output. The default values for this property are SYSPRINT for
client applications, and buffers to all other processes. Although you can change the default for other
processes from buffers to SYSPRINT, performance is better when you use buffers.

* You can use the Resource Measurement Facility (RMF) to view status information that might indicate
potential problems. The product uses Workload Manager (WLM) services to report transaction
begin-to-end response times and execution delay times, which might indicate that changes are required
for timeout values or tuning controls.

Performance diagnosis information

The following report options are listed here for information. IBM Service may request that you run one or

more of these reports while assisting you with diagnosis. You do not need to collect this data unless it is

requested by IBM Service.

 |If you suspect that you are having throughput problems in a particular address space, for example by
looking at some other real-time performance data, IBM Service may need to see a dump of one or more
address spaces. This is done using the following parameters:

JOBNAME=(<jobname Tist>)
SDATA=(LSQA,PSA,SQA,SUM,SWA, TRT,WLM, CSA,RGN)

 If you suspect that the problem could be resulting from GRS latch or ENQ contention, check the RMF
Enqueue Activity Report and enter the console command:

D GRS,CONTENTION

during a time period in which the performance problem is observed.
SYS.BPX.A000.FSLIT.FILESYS.LSN represents HFS latches. Latch sets with a numeric suffix are file
latches, specifically SYS.BPX.A000.FSLIT.FILESYS.LSN.O1. If you detect file latch contention, the best
way to determine the exact HFS file causing the problem is with an SVC dump, also collected during a
time period in which contention occurred. You will need to dump one of the OMVS data spaces to get
the file information.

DUMP COMM=(description of problem)

Reply to dump WTO, where serverproc is the name of your WebSphere Server
address space(s)

JOBNAME= (OMVS,Serverproc) ,DSPNAME=('OMVS'.SYSZBPX1, 'OMVS'.SYSZBPX2),

SDATA=(CSA,GRSQ, LPA,NUC,PSA,RGN,SQA, TRT, SUM)

» Sometimes USS errors can cause performance problems. The USS Ctrace (SYSOMVS) MIN tracing
option always records OMVS errors. You can take an SVC dump of the OMVS address space (as
described in the previous bullet) and the data spaces and format the SYSOMVS CTRACE. Use IPCS
options 7.2.1, suboption D, component SYSOMVS and the TALLY option (default is FULL). Look for
trace events of errors in the TALLY report.

» To find delays in applications, collect application performance information
— SMF 120 records.

— Jinsight profile

Updating the CFRM policy

You must update the coupling facility resource management (CFRM) policy before using log streams that
are CF-resident, such as the WebSphere Application Server error log and RRS logs. If you have the
source for the current active CFRM policy, update the source and use the IXCMIAPU Administrative Data
utility to generate the new policy.
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About this task

If you do not have the source for the current active CFRM policy, rebuild the source from the active CFRM
policy.

Procedure
1. Find the active policy by issuing the command: D XCF,POL You will get output similar to this (partial
display):
D XCF,POL
IXC3641 10.57.49 DISPLAY XCF 061

TYPE: CFRM

POLNAME : POLCF1IN1
STARTED: 03/14/2003 11:32:22

LAST UPDATED: 03/14/2003 11:31:52

2. List the active CFRM Policy's structure definitions by using the Administrative Data utility:

//STEP1  EXEC PGM=IXCMIAPU
//STDOUT DD  STDERR=*
//SYSABEND DD  STDERR=%
//SYSIN DD =

DATA TYPE(CFRM) REPORT(YES)
/*

3. Extract the definitions for the ACTIVE policy only. Using the STDOUT from the above utility job, edit
the output with the following steps so it can be used to define a new policy in the next job:
a. Extract the definitions for the ACTIVE policy only.
b. Delete the heading lines.

c. Add the new structure definition using the BBOWCFRM member of the target CNTL dataset as a
model.
d. Copy it into a FB-LRECL(80) dataset to be used as SYSIN for the following job.
4. Use the Administrative Data utility to update the CFRM policy. The policy name can be the same as

the ACTIVE CFRM policy or a new name. If you use the active policy name, REPLACE(YES) must be
specified on the DEFINE control statement.

//STEP20  EXEC PGM=IXCMIAPU
//STDOUT DD  STDERR=+
//SYSABEND DD  STDERR=+
//SYSIN DD =

DATA TYPE(CFRM) REPORT(YES)

DEFINE POLICY NAME(POLCFIN1) REPLACE(YES)

CF NAME (CF1LPAR) DUMPSPACE(5000) PARTITION(OE) CPCID(00)
TYPE(009672) MFG(IBM) PLANT(02) SEQUENCE(000000051205)

CF NAME (CF2LPAR) DUMPSPACE(5000) PARTITION(OF) CPCID(00)
TYPE(009672) MFG(IBM) PLANT(02) SEQUENCE(000000051205)

STRUCTURE NAME(CTS130_DFHLOG) SIZE(24000) INITSIZE(12000)
REBUILDPERCENT(1) PREFLIST(CF1LPAR, CF2LPAR)

<== Insert your new structure definitions here
5. Activate the new policy by issuing the following MVS Command:
SETXCF START,POLICY,TYPE=CFRM,POLNAME=POLCF1IN1

What to do next

For more information about coupling facility structures and the IXCMIAPU utility, see the z/OS manual
IMVS Setting Up a Sysplex (SA22-7625).
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Error Dump and Cleanup interface

The Error Dump and Cleanup (BBORLEXT) interface exists to call WebSphere Application Server for z/OS
in a recovery environment to allow it to request a dump and to clean up its resources.

The interface will:

+ Save the function and DLL names of the failing zZOS component into the SDWA.

* Determine whether or not to issue an SDUMP, if relevant to the time-of-failure environment.
* Clean up z/OS internal structures and connections.

Program requirements: This interface must be called from within a WebSphere Application Server for
z/OS location service daemon, controller (region), or servant (region). There are no restrictions against in
which recovery environment, such as an ESTAE or FRR routine, the caller must reside.

General information

Interface BALR to BBORLEXT

Address of routine (ECVT+'234'x)+'20'x

Address mode AMODE 31, RMODE any

